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1 Preface 

Optimal Trace Enterprise is a requirements capture, documentation and modeling suite for 

teams of Business Analysts, Systems Analysts, Software Architects/Designers, QA Leads, QA 

Testers, and Project Managers. 

It provides an easy to deploy, intuitive interface for capturing, viewing, and managing 

customer requirements and a sophisticated collaboration mechanism that enables multiple 

analysts to work concurrently on one or more projects. 

 

1.1 Audience 

This document is suitable for those who are gathering requirements for software systems. 

These roles include: 

 

 Business analysts  

 System analysts 

 Project managers 

 Test/QA engineers 

 Software architects/designers 

 

1.2 References 

[1] Writing Effective Use Cases, Alistair Cockburn. 2001. 

[2] Unified Modeling Language (UML), http://www.uml.org/  

 

1.3 Conventions used in this document 

The conventions used in this document are: 

 

Notes are used to highlight certain aspects of functionality which may be of interest, for 

example: 

Note: This is a sample note. 

 

Tips are used to highlight aspects typically associated with process usage which may be of 

interest in certain usage scenarios, for example: 

Tip: This is a sample tip. 

 

http://www.uml.org/
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1.4 Contacting Optimal Trace Customer Support 

For all technical problems and support queries, please logon to frontline at 
http://frontline.compuware.com. Frontline contains the Optimal Trace forum as well as an FAQ 

area. Additionally, current release information and contact numbers are provided. 

At Compuware, we strive to make our products and documentation the best in the industry. 

An important part of this effort is the feedback we receive from our customers. For product 

issues, please be sure to have the following information accessible before calling 

Compuware‟s 24-hour Product Support Hotline: 

 The version of Optimal Trace you are using, which is displayed in the About dialog box 

of Optimal Trace. 

 The version of each operating system(s) in which each product component is installed. 

 The place in the Optimal Trace software where the problem occurred and the steps 

taken before the problem occurred. 

 The exact Optimal Trace error message, if any. 

 System error messages, if any. 

Please contact the appropriate Compuware office: 

Compuware North America 

Compuware Corporate Headquarters 

One Campus Martius 

Detroit, MI 48226-5099 

USA 

Telephone: (313) 227-7300 

Customer Support Hotline: (800) 538-7822 

Compuware United Kingdom 

Compuware Ltd. 

163 Bath Road 

Slough, Berkshire SL1 4AA 

United Kingdom 

Telephone: +44 1753 774 000 

Facsimile: +44 1753 774 200 

Compuware International Operations 

Compuware Corporate Headquarters 

One Campus Martius 

Detroit, MI 48226-5099 

USA 

Telephone: (313) 227-7300 

. 

 

http://frontline.compuware.com/
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2 Introduction to Optimal Trace Enterprise 

Optimal Trace Enterprise is a collaborative team oriented requirements capture and 

management tool. It allows structured requirements capture, establishing a system's scope. 

Optimal Trace is a tool with a rich GUI (Graphic User Interface) that facilitates all aspects of 

requirements capture from drafting initial notes at a customer site through generating final 

requirements documents. 

Optimal Trace Enterprise is designed for teams with the following roles Business Analysts, 

Systems Analysts, Project Managers, Test/QA engineers, Software Architects/Designers, 

providing: 

 

 A user-friendly work environment 

 An intuitive interface for capturing, viewing and managing customer requirements 

 A sophisticated project collaboration tool - multiple analysts can work concurrently 

 An ability to create projects from predefined or custom project templates 

 An ability to generate requirements in a document format that is both comprehensible to the 

customer and unambiguous to Analysts, Project Managers and Developers working on a project 

 A comprehensive report generation to HTML, commas-delimited and other formats 

 A managed, concurrent working environment that is virtually transparent 

 An access control for projects and project packages 

 An automatic test generator for QA 

 A baseline creation and management tool 

 An automatic e-mail notification tool on project changes 

 A comprehensive traceability tree with automatic detection of suspect links 

 A powerful query and filtering mechanism 

 A flexible document and text file import mechanism 

 

At the fundamental level, the Optimal Trace Enterprise requirements-gathering paradigm is 

focused on two core constructs, structured requirements and simple requirements. See Figure 

1 - An Optimal Trace demo project showing Structured (red) and Simple Requirements (blue).  

Structured requirements directly and comprehensibly capture detailed functional 

requirements. This provides unambiguous specifications driven by business need for all 

project stakeholders. A single structured requirement is a strand of functionality proposed for 

a system. A collection of structured requirements can express the entire functional behavior 

of a system. For example, when writing the specifications for an online ordering system, 

formulate an individual structured requirement to satisfy each goal for the set of expected 

users. Typical structured requirements might be Browse Orders, Create/Edit Orders, and 

Login to System. 
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Structured requirements borrow much from the world of use cases, agile, and iterative 

concepts while still allowing the capture of non-functional operational and other requirement 

types as simple requirements. 

Optimal Trace is also designed to capture less-structured or simple requirements. For 

example, it is critical to express the number of concurrent users for the structured 

requirement Browse Orders, i.e. must support 200 concurrent users. These non-

structured or non-functional requirements generally fall into two categories: 

Qualities: expressing aspects that the system must satisfy such as number of 

concurrent users, security etc. 

Constraints: expressing hard realities such as type of infrastructure the system must 

run on, coding language required, browser versions to be supported etc.  

These can be captured in Optimal Trace, either by associating them with individual structured 

requirements or by defining them system-wide as part of the overall project. Using 

refinement relationships allows for full traceability. 

As important as structured requirements are for defining functional needs, it would be a 

mistake to omit non-functional requirements such as scalability or throughput. Optimal Trace, 

by using refinement relationships for such requirements, allows complete traceability from 

functional to non-functional and vice versa. This traceability reduces the risk of incomplete 

requirement specifications. 

 

Figure 1 - An Optimal Trace demo project showing Structured (red) and Simple Requirements (blue) 
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Note: For users upgrading from Optimal Trace version 4.1 and before, a placeholder tab 

called non-functional is associated with every structured requirement. 

 

We recommend using simple requirements and requirements items in Optimal Trace 5.0 for 

storing non-functional requirements. This provides a highly flexible way to capture and 

manage your non-functional requirements as they appear in the tree. It also has much of the 

same capabilities and flexibility as structured requirements. 

 

The non-functional tab is created for projects migrating from 4.1 and before. We recommend 

using simple requirements for any new non-functional requirement. 

 

2.1 Optimal Trace Enterprise Project and Functionality Overview 

Each organized set of related requirements is contained in a Project. Each project is created 

from a project template. Project templates provide either a specific project structure or sets of 

custom properties. See section 6.5 Custom Properties for details. 

Each project can have project level links to related resources. Additionally, each project has 

access to memoranda in the form of project level notes. You can also define a glossary and a 

list of actors (people or things involved) for each project. 

Each project contains a default requirement package, which cannot be removed but can be 

renamed. It is possible to create subordinate packages. These packages can be named, 

renamed, tagged, given a unique description, copied, moved, and removed. 

The core business facing unit of Optimal Trace Enterprise is the requirement. Requirements 

exist within the context of a package. Two types of requirements can be created in a project, 

simple requirements and structured requirements.   

Simple requirements are specifications you would like the system to support. A simple 

requirement can optionally contain one or more items. An item is information that 

supplements the simple requirement. For example, an item may contain a data type name 

and definition. Items may contain links to related resources, and custom properties. Simple 

requirements also may contain links to related resources, custom properties, and notes. 

Each structured requirement can have links to related resources and its own set of notes, 

custom properties, and non-functional requirements associated with it. 

Note: In Optimal Trace 5.0, the non-functional tab is specifically for projects being migrated 

from Optimal Trace 4.1 and older. Users wishing to capture non-functional qualities and 

constraints should use simple requirements instead. 

The core unit of a structured requirement is the step, and a requirement can be comprised of 

none or many steps. Steps mimic the actions that you take to realize the goal or objective of 

a requirement. The series of steps, which realize the successful completion of the main 

function of the requirement, are collectively referred to as the Main Success Scenario. This 

could be your structured requirement‟s critical path. Any series of steps within the same 

requirement that provides an alternative path or solution to the main success scenario is 

collectively referred to as an Alternate Scenario. This is a contingency plan for when 

behavior may need to address exceptional situations. You may have any number of 

alternative scenarios in a requirement. 

Optimal Trace Enterprise allows you to branch from one step to another step either in the 

same scenario or another scenario. You can also branch from a step to an existing or new 

requirement, optionally creating the requirement in the branching process. 
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Optimal Trace Enterprise allows you to refine a step or an item to an existing or new 

requirement, creating it in the process. This effectively links high to low-level requirements. 

This can be especially useful when comparing as is/to be requirements that are linked to a 

given step at a higher level. 

Optimal Trace Enterprise allows you to link a requirement and all Optimal Trace elements to 

an existing requirement or other Optimal Trace artifacts either within or across projects. 

Optimal Trace Enterprise provides you with a document profiles facility containing 

requirements document templates. Additionally, you can create your own profiles and 

templates.  

Use document profiles to tailor Optimal Trace generated documents to your branding needs.  

Additionally, use the document profiles output to accept certain elements of the project. 

Optimal Trace Enterprise allows you to perform the following additional functions: 

 

 Move a requirement or sets of 

requirements to another package or 

project and move a package or sets of 

packages to another package or project. 

 View project version history. 

 Copy and paste actors, glossary items, 

requirements, and steps within and across 

projects. 

 Publish requirements to the web. 

 Search and filter within and across 

projects. 

 Visually merge projects. 

 Use customized and Windows shortcut 

keys. 

 Merge two versions of the same project. 

 Work collaboratively on a single set of 

requirements, always aware of the latest 

changes made by your colleagues. 

 Merge a document into a project. 

 Work offline at a customer site and merge 

changes safely into the master 

requirements document when you return 

to the office. 

 Integrate with external test and design 

tools. 

 Use local and remote projects.  Add non-Optimal Trace elements into the 

document. 

 Upload your local projects to the central 

repository. 

 Reverse a document back into a project. 

 Version projects or apply baselines to 

projects. 

 Perform full round-trip engineering of 

Microsoft Word documents. 

 Generate test cases from business 

requirements. 

 Security enable projects. 

 Spell check a project or part of a project.  Import the contents of a text file or a 

Microsoft Word document into a project. 

 

 



 

 

13  Optimal Trace Enterprise User‟s Guide 
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3 Starting Optimal Trace Enterprise 

Click Start>Programs>Compuware>Optimal Trace Enterprise (version)>Optimal 

Trace Enterprise.  

Note: If you did not use the default locations when you installed the software, navigate to the 

directory where the software is installed and click Optimal Trace Enterprise.exe in the 

Optimal Trace Enterprise subfolder. 
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4 Optimal Trace Screen Layout 

When you start Optimal Trace™ Enterprise, the screen shown in Figure 2 below appears. 

However, if this is your first time starting Optimal Trace Enterprise, you will be prompted for a 

license key. For licensing and upgrading instructions, see Section 20 Licensing and Upgrading 

Optimal Trace™ Enterprise. 

 

 

Figure 2 - Initial Optimal Trace Enterprise screen 

 

When editing a project, a screen similar to the one shown in Figure 3 below appears. The 

following figure demonstrates general project components that exist in Optimal Trace. 
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Figure 3 - Optimal Trace Enterprise General Layout 

 

Optimal Trace is comprised of the following sections: 

 

 Menu Bar – contains menus, submenus, and options that can be used when running 

Optimal Trace Enterprise. Click the options and sub-options as required. For many of 

the options in the submenus you will see icons, text, and shortcut keys. For example, 

to create a new requirement under Requirements in the Menu, you will see:   

o Icon –  

o Text – New Requirement   

When the Requirements menu is extended, hold the <Alt> key down and 

press the <C> key. This functionality is available on other options, too. 

o Shortcut key – Ctrl+Shift+C 

See Appendix , for a list of Optimal Trace Enterprise shortcut key combinations. 

 

 Tool bar - contains a list of frequently used items that can be used when running 

Optimal Trace Enterprise. 
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 Tree View - contains a list of currently opened projects or project templates and their 

respective contents. A project contained in the tree is comprised of actors, glossary 

entries, packages collections, and structured requirements. Each entry in the tree is 

referred to as a node. For detailed descriptions of each entity contained within an 

Optimal Trace project see section 6 Optimal Trace Projects. 

 Thumbnail View – contains a miniature of the requirement map view or flow diagram 

view. These are described in more detail in Section 6.12  A Note on the Requirements 

Map and Flow Diagram View. 

 Query View - contains the list of queries and offers an ability to perform simple 

searches. Additionally, provides the ability to create, edit, and run queries. 

 Traceability View - contains the traceability Tree. This shows relationships between 

Optimal Trace projects and elements as well as flagging suspect links and 

relationships. 

 Details View - contains details associated with the specific node selected in the tree 

view. For example, projects or requirements. 

 Right Pane View - contains specific detail relevant to the node selected in the tree 

view. In instances where requirements or packages are selected, this area displays a 

map of related nodes (either the requirement map or flow diagram) and text 

associated with requirements. 

Tip 1: Click the edge of a column to adjust the width.  Optimal Trace retains the width for all 

requirements in the package. There are two possible scenarios for column width retention: 

 Example 1, open Requirement 1 in Package 1 and adjust the column widths.  Open 

Requirement 2 in Package 2, and return to Requirement 1 in Package 2.  Optimal 

Trace kept the changed width. 

 Example 2, open Requirement 1 in Package 1 and adjust the column widths.  Open 

Requirement 2 in Package 1, the widths set for Requirement 1 have been retained. 
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5 Project Menu 

Use the Project menu to create, open, close, save, save as, upload, and download your 

projects. Additionally, the Project menu allows you open project templates, save projects as 

templates, and apply templates. You can create project baselines and be notified of changes 

to specific project elements. You can also save images of certain views of your project and 

you can export your project contents to structured text-based (CSV) outputs. The Project 

menu also allows you to import project data from a Word document or a text file into your 

project.  If you are logged in you can change your password from the Project menu. 

Within Optimal Trace Enterprise, everything associated with a particular set of requirements is 

contained within a project. 

Each project consists of collections of packages, simple requirements, structured 

requirements, actors, glossaries, and a number of additional entities such as notes and links. 

All Optimal Trace projects are created initially from project templates. Using these in 

conjunction with custom properties allows you to provide sets of pre-configured properties 

that can be used for all your projects. Corporate standards can be encouraged and sets of 

useful information introduced from project inception across the enterprise. 

 

Note: Besides containing sets of custom properties, project templates can contain specific 

pre-built project elements such as glossary items, packages, simple and structured 

Requirements, etc. 

 

You may want to consider creating templates of common flows that tend to recur across your 

projects. For example, login is a common repetitive flow. 

 

5.1 Creating a New Project 

Use this option to set up a new project. This is the first step in gathering requirements with 

Optimal Trace Enterprise.  

Project names can not contain symbols such as comma (,), forward slash (/), backward slash 

(\), ampersand (&), and etc. 

To create a project: 

 

1. From the Menu, click on Project. The screen shown in Figure 4 appears. 
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Figure 4 - Clicking the Project Menu 

2. Click New Project. The screen shown in Figure 5 appears. 

 

 

Figure 5 - Selecting a Project type and choosing a template 
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5.1.1 About Local and Remote Projects 

Indicate whether you want to create a local or remote project. To create remote projects, you 

need to configure Optimal Trace Enterprise to communicate with an Optimal Trace Enterprise 

server host. See section 18.1 Configuring Optimal Trace™ Enterprise to work through a 

Optimal Trace™ Server for more information. 

A local project is stored on your computer‟s hard drive. Only one user at a time can edit the 

local project. Local projects are stored as XML formatted text files. A remote project is stored 

in the repository (an Optimal Trace Enterprise server) and can be viewed and edited by 

multiple users concurrently. 

Create a local project if: 

 

 You do not wish to use any collaboration facilities within the project 

 You want to quickly get up and running on the very early stages of a project and you 

are the only person modifying it 

 You are working offsite or away from your office and have no access to your repository 

server 

 

Create a remote project if: 

 

 You want to use collaboration facilities within the project 

 You have access to your repository server 

 You want to secure the project using access control 

 

Note: It is quite common for Optimal Trace users to initially create a local Optimal 

Trace project and at a later point upload the project to the server. 

For example, if working to capture the business information in a JAD (Joint Application 

Development) workshop, initially capture the requirements directly into a local Optimal 

Trace project. Using a projector to show the graphical flows and textual detail with the 

business stakeholders facilitates stakeholder agreement. When you have returned 

onsite or when you are connected with the server, upload the captured information 

and make it your baseline. 

 

5.1.2 About Project Templates 

When creating a new project, specify a project template. Optimal Trace ships with the 

following project templates: 
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Template Description 

Empty This is an empty template meaning it does not have any predefined custom 
properties or project structure. For more on Custom Properties, see section 

6.5 Custom Properties. This is the default when running Optimal Trace for 

the first time. 

Feature Driven 

Development 
Use this template as one approach when relating product/project 

features to detailed requirements. 

This template structures a project into two packages. The first 

package is Features with the tag FR denoting Feature Requests or 

Feature Requirements. The second Detailed Requirements with tag SR 

denoting Software Requirements. 

Capture your specific features in the features package as Simple 

Requirements and the related detailed functional flows as structured 

requirements in the second package. Use refinements to connect 

features to detailed requirements. 
Standard 

Software 
Development 

Use this template when defining requirements for typical software projects. 

This template contains the following custom properties: 

Project: project scope, business case, project team, project schedule and 
risk/mitigation 

Requirement: delivery increment (bound and one of increment 1, 2, or 3), 
business priority (bound and one of High, Medium, or Low), and tech risk 
(bound and one of High, Medium, or Low) 

Business Process 
Template 

Use this template when defining higher level business processes. This 
template contains the following custom properties: 

Project: project scope, business stakeholders 

Requirement: business priority (Bound and one of high, medium, or low) and 
business level (Bound and one of high, medium, or low), time, resources 

Requirement Step: time, inputs (Bound and empty), outputs (Bound and 

empty)  

Note: The inputs and outputs are bound there will likely be a set of 
predefined items. For example,  PO, invoice, etc. 

QA Template Use this template when defining test requirements. Typically these 
requirements will link or trace back to business requirements. 

See section 6.3 Project/Requirement Links for more details on links. 

This template contains the following custom properties: 

Project: scope, out of scope, QA team, test schedule, test hardware, test 
software 

Requirement: tester 

Requirement Step: expected result, result 

 

Note: You may want to change the default project template when creating new projects. 

Adjust the project template settings under Options>General Options menu. See section 

13.1.4 Default Directories Settings for more details. 
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5.2 Opening Projects 

Use this option to open an existing project. 

To open a project: 

1. Choose Project>Open Project. 

2. Check the Open a remote project in the repository for remote projects or Open a 

local Project for offline (file based) projects. 

3. Select the project you wish to open.  

To facilitate project selection, the dialog box displays the project name, project 

creator, project created on date, and project last modified date. You can sort these 

columns or hover over the project to view a description. 

4. Click Open. 

 

Optimal Trace Enterprise allows multiple remote projects, local projects, or a mixture of both 

project types to load at any one time. If you open multiple projects, you can copy, cut, and 

paste artifacts such as requirements and actors between the various projects. See Section 9.1 

Copy/Paste Options (within and across Projects), for details. 

After creating a Project, configure the details associated with the project, and specify 

properties, links, notes, and non-functional requirements. See Section: 6 Optimal Trace 

Projects for details. It is also possible to customize some project settings. See Section 6.6 

Project Settings. 

Optimal Trace projects can be configured as security enabled meaning that permissions are 

applied to the project. Security enabled projects appear in the list of projects with a key icon 

 next to them. 

If attempting to open a security enabled project, the system prompts you to login. See Figure 

6 - Logging on to a secure project. 

 

 

Figure 6 - Logging on to a secure project 

 

Enter your user name and password in the fields provided. 
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Note: User IDs and passwords are case sensitive. Ensure that you are using the correct case 

if you are having difficulty when logging in. 

 

Note: When new users are created in Optimal Trace, they are assigned the default password 

of password. Contact your Optimal Trace Administrator for more details. Refer to the 

Optimal Trace Server Admin help for more information on users. 

 

5.2.1 Working with remote Projects 

Once created, a new remote project behaves exactly like a local project. The difference is that 

when you save changes, the changes are written to the repository rather that to a local disk. 

 

5.2.2 Deleting Remote Projects 

From time to time you may want to delete remote projects. 

Remote Projects cannot be removed by deleting a file from the hard disk or network drive. 

Whereas, deleting locally stored Optimal Trace Professional, another version of Optimal Trace, 

and offline projects will completely deleted the project. In Optimal Trace Enterprise, remove 

the project from the Optimal Trace repository in order to remove the project. 

 

Prior to deleting a project consider: 

 taking the project offline as a precautionary measure in case you wish to recover that 

project at a later time. See section 5.12 Downloading Repository Project to local 

Project for details. 

 making a backup copy in the repository. You can use Save As…. See section 5.7 

Saving Projects As  for more details. 

To delete a remote project: 

1. Choose Project>Open Project. 

2. Check Open a remote project in the repository. 

3. Select the project to delete. 

4. Click Delete. You will be prompted to confirm the deletion. 

 

 

Figure 7 - Prompt for Project Deletion 

 

Attempting to delete a project that is being accessed by another user will fail. 
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Figure 8 - Project Deletion not possible message 

 

 

Projects that are security enabled can be configured to prevent project deletion. When 

configuring the project, uncheck can delete. When this permission is unchecked and a user 

attempts to delete the project, a message appears.  

We recommend that when security enabling projects, you minimally uncheck the setting a 

project level as a default. This will prevent accidental project deletion. 

Refer to the Optimal Trace Server Admin help for more information on setting project 

permissions 

5.3 Closing Projects 

Use this option to close your local or remote project. It will no longer appear in the tree view, 

but the project will remain in the repository or file folder. 

To close a project: 

1. Choose Project>Close Project. Prior to closing, if Optimal Trace™ Enterprise detects 

that you do have unsaved changes, it will prompt you to save before proceeding. 

2. Click either Yes to close. 

 

5.4 About Baselines 

Project baselines are archived snapshots of a project. Every Baseline is associated with the 

originating project. 

Baselines are typically created when you are at a meaningful point in the project lifecycle. 

Subsequent changes in the project can be reviewed and monitored by using baselines. 

Examples of key milestones where project baselines might be created are: 

 After completing the first or subsequent iteration of requirements with a customer 

 Before and after a review session with technical stakeholders 

 Before and after a group review session with the QA Team 

 After entry into the build phase 

 After final project delivery 

 For maintenance of delivered systems where there is alteration of behavior 

The baseline feature supports review sessions and allows focus on changes that have 

occurred since the last or any other baseline. 

When creating a baseline, specify a baseline name and description. This enables tracking of 

specific baseline events. 
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Projects baselines can be created, can be compared, can be merged, can be deleted and can 

acquire permissions.  

If permissions are set, project baselines can be opened, edited, and manipulated in the same 

way as normal projects. 

 

Note: All repository projects are baselined with a tag called Latest. This allows the current or 

latest project to be compared with any previous baseline. 

 

 

Figure 9 - The Baseline Menu Options 

 

5.4.1 Creating Baselines 

To create a baseline: 

1. Open a project. Since baselines are associated with repository based projects, ensure that 

you have a project open 

2. Choose Project>Baselines>Create Baselines. The Create Baseline dialog box appears. 

See Figure 10 - Creating a New Baseline. 
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Figure 10 - Creating a New Baseline 

 

3. Type a name and description in the appropriate fields. 

4. Click Create. You have created a baseline that is associated with this project and can be 

opened. 

 

Tip: If you need to baseline for a session where you will be working offline, there are two 

approaches you can take. 

You can first create the baseline when online, and then take the project offline using 

Download. When merging changes into the repository, you can compare the before and after 

state using Compare Baselines... option.  

Alternatively, you can take the project offline, make any offline changes without having 

created an initial baseline. Before merging, create a Pre-merge labeled baseline. This allows 

you to compare all changes before and after the merge. 

For more on downloading and merging projects, see section: 5.12 Downloading Repository 

Project to local Project and section 5.13 Upload local Project to Repository Option. 

 

5.4.2 Opening Baselines 

Baselines can be opened for review or editing assuming appropriate permissions are set. 

To open a baseline: 

1. Choose Project>Baselines>Open Baseline… The current list of baselines appears. For 

each Baseline, the system presents the date the baseline was created along with the 

person who created it. If no baselines have been created to date, the list is empty. 

2. Chose a baseline and click Open. 

After the baseline is open, it can be used in exactly the same way as any project. 
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5.4.3 Deleting Baselines 

Baselines can be deleted. If you do not want baselines to be deleted, set appropriate 

permissions on the given baseline.  

To delete a baseline: 

1. Choose Project>Baselines>Open Baselines. 

2. Select the baseline to delete. 

3. Click Delete.  

 

Note: Baselines can have permissions associated with them. Consider applying permissions 

for the same reason you would want to set permissions on a project. For example, set 

permissions to prevent the baseline from being deleted or modified. See the Optimal Trace 

Administrator help document for full details on setting project and baseline permissions. 

 

5.4.4 Comparing Baselines 

Individual baselines can be compared to access the changes from one baseline to another.  

To compare baselines: 

1. Choose Project>Baselines>Compare Baselines.... The Compare Baselines dialog box 

appears. 

  

Figure 11 - Entering Baselines to Compare 

2. Select the baselines to be compared. 

3. Click OK.  The Baseline Comparison screen appears. See Figure 12 - Compare Baselines 

Screen.  

 

The screen consists of three panes. The Compare screen takes two different baselines of the 

same Project labeled From and To and displays the differences between them in the third 

pane. Specifically the following differences can occur between baselines: 

 Objects can reside in the From baseline but not in the To baseline 

 Objects can reside in the To baseline but not in the From baseline 

 Objects can be common to both the From and the To baseline but can have different 

attributes 
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Any objects that exist in both the From and the To Projects that have different attributes 

trigger a visual conflict.  For example, two Actors called user, one with the description the 

user and the other with the description the generic user. 

The Compare screen in Figure 12 - Compare Baselines Screen shows all differences 

graphically so that you can review them on a one-by-one basis or collectively. When the 

Compare screen initially appears, it displays the corresponding detail of conflicts for every in 

the third pane. 

 

Figure 12 - Compare Baselines Screen 

In order to move up or down between differences, use the Up ( ) and Down ( ) arrows. 

Selecting an entry in the third pane selects the relevant entry in either the From or To 

baseline and vice versa. 

When differences occur in the Compare Baselines screen, there can be a number of reasons. 

The following table lists the icons and their definitions. Additionally, it provides a description 

of Difference States when a specific button is enabled. 

Icons can appear in the From and To baselines in the normal tree view, without any 

adornments such as pluses or circles. In this instance, this signifies that an object of this type 
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was found in each baseline and these were found to be identical; hence there is no difference 

between the two baselines. 

 

 

Icon 

Adornment 

Action Description 

 Added The selected element was added to the baseline. 

 Removed  The selected element was removed from the baseline. 

 or  Different sub-

element(s) or a 

property difference 

There are two scenarios when this icon appears: 

The first scenario is that the change occurred when a 
sub-element was added or removed. For instance 
adding a new link to a requirement. 

The second scenario is that the changes are at the 

property level. For example A name or description 
changed in a package. In this scenario, Optimal Trace 
displays the exact text of the change in the appropriate 
column. Additionally, the property that changed is 
reflected in the Action column. 

 or  Associated element 

has changed 

Another element that is associated with this element has 
changed. For example a step element is associated with 
an actor element. 

 or  Positional change The position of the selected element changed. Positional 

changes happen when elements are added or removed 
to an area where there are more elements after the 

specific element. For example, if step 4 were removed 
from of a total of 6 steps, a step positional change 
results. Positional changes also occur if an element is 
moved up or down. 

 

It is possible to save the results in the third pane to a text file as well as generating a HTML 

view of the results. 

 

To view as HTML: 

1. Click View HTML... 

2. Click Open. 

The differences in the third pane display as a single HTML file. 

Tip: The HTML report can easily be mailed to colleagues for review. This allows you to mail a 

concise view of the differences. To access the HTML file, go to your Optimal Trace installation 

directory and find the file called BaseLineCompareOutput.html. The default installation 

directory is <Optimal Trace Install Root>\projects\reports. 

To save the differences to a text file: 

1. Choose Compare > Save as... 

2. Type a file name. 

3. Click Save. 



 

 

30  Optimal Trace Enterprise User‟s Guide 

 

5.4.5 Merging Two Baselines 

You can merge baselines resulting in an altered To Baseline. Possible reasons to merge 

baselines are: 

 

 there was information held in a previous baseline that may have been subsequently 

altered or deleted but has become relevant again. For example functional flows.  In 

this context the specific flows might be merged forward. Merge into the latest. 

 you want to adjust a previous baseline without having to re-baseline. Although this is a 

possible scenario under certain circumstances, it is best not to merge back to previous 

baselines. 

 

To merge baselines: 

1. Choose Project>Baselines>Merge Baselines… 

2. Select a From and a To Baseline.  

3. Click OK. The Baseline Merge dialog box appears.  

 

5.5 About Notifications 

Optimal Trace Enterprise provides email notification of changes applied to any part of a given 

project. If changes are made, an e-mail is issued automatically from the Optimal Trace 

Server. 

Note: Projects must be secure before registering for notifications. For more about making 

projects secure, see the Optimal Trace Administrator online help.  

 

5.5.1 Registering for Notification 

Register for change notifications on the following project elements: 

 Project Level: change to project attributes or constituent elements such as notes, 

etc. 

 Glossary: change to any glossary entry, addition of glossary entries, or removal of 

glossary entries.  

 Actor List: change to any actor entry, addition of actors, or removal of actors 

 Package: change to the package attributes, addition of entries, or removal of entries. 

 Structured Requirement: change to any level of the requirement. 

 Simple Requirement: change to any level of the requirement. 

 

To register for notifications: 

1. Select the element in the tree. If you select a package you can also have the option of 

registering for all the package sub-elements. 

2. Choose Project>Notifications>Register for Notification. You can alternatively right-

click in the tree to access the shortcut menu. 

3. Click Register. After clicking register, a message appears confirming the registration. 



 

 

31  Optimal Trace Enterprise User‟s Guide 

 

Note: If registering for a package and if the package contains sub-packages and 

requirements, Optimal Trace prompts for a confirmation to register for these elements. 

 

Note: If the server side SMTP mail settings have not been configured, a message appears. 

Contact your Optimal Trace administrator to have these set correctly. See the Optimal Trace 

Server help file for more information on configuring SMTP mail settings. 

 

5.5.2 Viewing and Unsubscribing from Notifications 

It is possible to view the list of element(s) that have been configured for notifications. 

Additionally, it is possible to unsubscribe from notifications on any elements. 

To view or unsubscribe from notifications: 

1. Choose Project>NotificationsView/Unsubscribe Notifications. The screen displays 

the current subscribed project elements. 

2. Uncheck one or more elements to unsubscribe from mail notifications on that element. 

 

5.6 Saving Projects 

Use this option to save a project. 

 

Caution! The undo and redo memory is cleared after a save. So, once a Project is saved you 

cannot undo or redo any actions you made before saving. Any new actions since saving can 

be undone or redone. 

To save a project: 

1. Choose Project>Save Project. The Save dialog box appears. 

2. Type a name for the project in the Name field. 

3. Click Save. 

 

5.7 Saving Projects As  

Use this option to save a project with a different name. If a project is repository-based, 

Optimal Trace prompts you to enter only the name of the project.  

Note: Use the save as option to archive repository projects. This creates a complete copy of 

the project in the repository. 

If the project is a local project (i.e. file based project) Optimal Trace prompts you to enter the 

file name of the project. 

Caution! The undo and redo memory is cleared after a save. So, once a Project is saved you 

cannot undo or redo any actions you made before saving. Any new actions since saving can 

be undone or redone. 

To use the Save As option: 

1. Choose Project>Save Project As. The Save As dialog box appears. 

2. Change the file name in the Name field. 

3. Click Save. 
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5.8 Saving Projects as Templates 

Create new templates either from existing projects or existing templates. 

Using this option saves the currently loaded and selected project or template as a new 

template. Optimal Trace prompts for the template name and description. 

Any custom properties and structural elements are saved forming the new template. The 

template is saved to the location specified in the Tool Settings. See section 13.1.4 Default 

Directories Settings for details. The next time a new project is created, the template appears 

as a template selection. 

 

5.9 Applying Templates to Projects 

Templates can be applied to existing projects or to other templates. 

Applying a template to a project layers the custom properties and structural elements of the 

template on top of the destination project. 

Consider applying templates if you have initially created the project from one template and at 

a later point you wish to layer custom properties and/or structural elements from a different 

template onto the same project. 

Note: When applying a template, the custom properties in the destination project and any 

associated data is preserved if custom properties having the same name are encountered in 

both the template and the destination project. Additionally a message regarding the 

duplication appears. 

 

 

Figure 13 - List of Available Templates to Apply 
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To view details on of a project template, click … button next to the template on the Apply 

Project Template dialog box.  The Project Template Details dialog box summarized the 

custom properties currently defined for the selected template. You can also open the specific 

template and navigate to its full set of data and custom properties. See section 5.10 Option 

for more information. 

 

 

Figure 14 - Template Summary Screen 

 

5.10 Opening Project Template 

Use this option to open an existing template to view or modify. A list of available templates 

appears. To view details for each template, click the … to the right of the template. 

After opening a template, the template indicator icon  appears adjacent to the template 

name within the Tree.  

 

Since templates are specialized projects, all project level editing, reporting, etc. capabilities 

can be applied to project templates. Existing templates can be saved with another name. 

Create as many specialized templates as necessary. 

5.11 Changing Project Password 

If logged into a secure project, you can change your password.  

 

To change the password: 

Choose Project>Chang Password. The Set Password dialog box appears as shown in Figure 15 

- Setting a Password. 
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Figure 15 - Setting a Password 

 

Enter a new password in the appropriate fields and click OK. 

5.12 Downloading Repository Project to local Project 

Downloading a complete copy of your project from the repository allows you to work 

disconnected from the repository. This is useful if working on site with your customer or at 

home where you do not have network access. 

Note: Optimal Trace tracks that a project was downloaded from a repository project. When 

returning the project to the server by uploading it, Optimal Trace will automatically launch the 

project merge screen.  

To download a project: 

1. Choose Project>Download Repository Project to local Project. The Save Project as dialog 

box appears. 

2. Optionally change the file name. 

3. Click Save. 

 

After the download completes: 

 

 The project path displayed in the tree view points to the local file. 

 The project behaves as a local project. 

 The Project Status indicator at the bottom right of the screen will read 'Project Status: 

Offline' 

 All subsequent Project changes are saved locally. 

 A connection to a Repository Server is not required and you may proceed to work 

'offline'. You may subsequently choose to go back online. See Note for details. 

 

Note: Offline and Master Projects. Taking Projects Offline does not prevent other users 

from simultaneously editing the master version on the Repository. By the time you are ready 

to put your changes back online and if other users have made conflicting changes to some of 

the same project elements in the intervening period then the Visual Merge Tool is invoked. 

This allows you to compare two versions of a Project and selectively accept or reject either 

the From or To version of every conflict; See section 18.4 Merging Projects for full details on 

Project Merging. 
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5.13 Upload local Project to Repository Option 

Use this option if you are either reconciling a previously downloaded offline project or if you 

want to transfer a local Project to the Repository to begin working collaboratively. 

 

 From the Menu bar, click on Project 

 Click on Upload local Project to Repository, and Optimal Trace™ Enterprise will attempt 

to upload the file.  

If the project was originally a Repository based project that was taken offline for local access 

then the Optimal Trace Enterprise Server will detect this and invoke the Project Visual Merge 

screen. See section 18.4 Merging Projects for full details on Project Merging. 

However, if this is the first time the project is being added to the Repository then the Project 

status will change from Offline to Online in the status bar and the Project will now be 

converted into a Repository project. 

5.14 Export Project Option 

Use this option when exporting a given project to any text or structured format. Optimal 

Trace ships with a number of 'Export Profiles'. Each export profile dictates the format of the 

CSV (Comma Separated Values) output file. 

 

Note: When an export is created, Optimal Trace can also automatically insert a project level 

link to the generated file. If you do not wish to automatically create this link uncheck the 'Add 

Project Link to Report (locks the project)'. 
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Figure 16 - Export Project Screen 

 

The following export profiles ship with Optimal Trace: 

 

Table 1 – List of Generate Export Profiles shipped with Optimal Trace™ Enterprise  

Export Profile Description 
Text Export 

Generates to directory: 
...\projects\exports 

Export to CSV (Comma-separated) Text File. Generates a report 
with all the Project details in CSV format. This report is especially 
good if you wish to output the content of Optimal Trace projects 
into text editing tools such as notepad or Excel spreadsheets. 
Since the output is delimited by commas, an excel worksheet can 

open the output for manipulation. 

Note: Microsoft Excel has been known to display numeric values 

in a .CSV file in an unexpected manner. If you are exporting to a 
.CSV file for use in MS Excel, and experience this issue, changing 
the cell formats in Excel will help you overcome it. 

MS Project Export 

Generates to directory: 
...\projects\exports 

Generates a report with all the Project details in CSV format 
(comma delimited text). Using Optimal Trace supplied Mapping 
Rules this file may then be opened in MS Project. 
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Text Actor Usage Export 

Generates to directory: 
...\projects\exports 

This report generates CSV based text files (comma delimited 

text) 

Generates an actor oriented text output with each actor and the 
steps it participates in. The intent of the report is to show what 
actors/resources interact with given steps within the structured 
requirements and which steps have no actor currently defined. 
This is very useful for gap analysis and redundant actor 
identification. 

An HTML version of this export is available under the 'Generation 
>> Generate Reports…' menu option. (see section 12.5 Option 
for more details) 

Text As Is – To Be Report 

Generates to directory: 
...\projects\exports 

This report generates CSV based text files (comma delimited 
text) 

Generates a text output with e.g. current details for 
administrators („As-Is‟ processes), and projected details for 
system developers („To-Be‟ processes). The Goal-levels 'As-Is' 
and 'To-Be' that ship with Optimal Trace are used as 
discriminators for this export. 

An HTML version of this export is available under the 'Generation 
>> Generate Reports…' menu option. (see section 12.5 Option 

for more details) 

QACenter Export 

Generates to directory: 
...\projects\exports 

This report generates output for use as part of the import into the 
QACenter product line from Compuware. See 
http://www.compuware.com for more on the integration 
capabilities into QACenter 

OptimalJ XMI (UML) 

Generates to directory: 
...\projects\exports 

This report generates an XMI text file suitable for import into 
OptimalJ from Compuware. See http://www.compuware.com for 
more on the integration capabilities into OptimalJ 

Export into HP Quality Center 

Generates to directory: 
...\projects\exports 

This report generates a CSV based text file suitable for importing 
into HP Quality Center. See the integration help files for more on 
the integration capabilities and also online at: 
http://www.compuware.com 

Enterprise Architect XMI (UML) 

Generates to directory: 
...\projects\exports 

This report generates an XMI text file suitable for import into 
Enterprise Architect from Sparx Systems. 

 

 

Note: Creating Custom Exports. Export Profiles reply on the velocity scripting engine and 

the Optimal Trace API. Velocity ships with Optimal Trace. See http://velocity.apache.org for 

more details on the Velocity scripting language. See also the Optimal-Trace-Exports-Reports-

and-API-Help.pdf help file for more on velocity in general and building exports using velocity 

script. 

Specific Export formats can also be created for your needs by the Compuware Optimal Trace 

Professional Services team. Contact Compuware for further details. 

 

http://www.compuware.com/
http://velocity.apache.org/
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5.15 Import Option 

Use this option to import project data either from a text file, or from an existing requirements 

document in Microsoft Word. 

5.15.1 Import Text File 

This option permits the import of data from a text file into the selected project.  This option is 

only available if one of the following project elements is selected in the tree: 

 Select the Project to import Simple Requirements or Structured Requirements 

into the root Requirements Package. 

 Select a Requirements Package to import Simple Requirements or Structured 

Requirements into it. 

 Select the Glossary to import Glossary Entries. 

 Select the Actor List to import Actors. 

 Select a Structured Requirement to import Steps into it. 

 Select a Simple Requirement to import Items into it. 

For convenience, the Import Text File option is also available in the (right-click) context menu 

for these project elements. 

Text files to import must have data arranged in fields or columns, with each field delimited by 

a special character such as a comma.  Microsoft Excel CSV (comma separated value) files are 

saved in this format, and so this feature is ideal for importing spreadsheet data.  Each row in 

the file is imported as a new project element. 

On choosing the Import Text File option, the following dialog appears: 

 

Import Into: indicates the project element which will be the location for the imported 

elements.  This is initialized with the selected item in the project tree.  Use the "..." button to 

the right to change the import location.  The selected import element will determine the kinds 

of element that can be imported according to the list above. 

Text File: specifies the text file to import.  Type in the full path, or choose the "..." button to 

summon a file chooser box to navigate to the file. 
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Delimiter: this drop-down allows you to choose the character which delimits the fields in the 

text file.  For Excel CSV, commas are used.  Other options are period (.), tab and space.  In 

the event that a different character is required, choose "Custom" and type the character in 

the text box to the right of the drop-down. 

First line is a header: some text files have a first header line that names the fields.  If this 

is the case, check this option, and when the import proceeds this first line will be ignored. 

Click the Next button to proceed to the next stage in the process (this is enabled when a 

valid file is selected) or click Cancel to abandon the process. 

After clicking Next, the mapping dialog appears. 

 

This dialog specifies how the fields found in the file should map to attributes of the project 

elements to be imported.  Collectively, this set of mappings is called a map. 

Map Name: once a map has been specified, it is possible to save it using this drop-down box.  

Simply choose "< New >" from the option list, and specify the name of the map in the box 

which pops up.  The name must be less than 20 characters in length, and shouldn't contain 

any punctuation characters.  After a map has been saved in this way, its name will appear in 

the drop down, and it can be automatically retrieved and applied in subsequent imports. 

It should be noted that maps specify a particular type of project element, it is not possible to 

apply a map that specifies a type which cannot be imported in to the chosen "Import Into" 

location, and an error popup will occur if you attempt to do so. 

Save: click this button to save changes to the currently applied map.  This is only enabled if 

the field mappings are changed after a map is applied. 

Delete: this button deletes the currently applied map.  The field mappings are not changed. 

Import As:  this drop-down specifies the type of project element that each row in the text 

file represents.  For most import locations, this drop-down is disabled as there is only one 

valid element type that can be imported.  For example, if you choose to import into the Actor 

List, then the Import As drop-down will be disabled and only Actors will be imported. 

Field Mapping: this table shows the fields found in the file and the element attributes that 

they map to.  If "First line is a header" was not checked in the import dialog, then the first 

column will name the fields "Field 1", "Field 2" etc.  If "First line is a header" was checked, 
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then the values of the first line will be read and listed in this column instead.  For each field 

you must choose an appropriate attribute to map to from the "Maps to" column.  Each cell in 

this column is a drop-down from which attributes of the "Import As" element type can be 

chosen.  A special "Not Mapped" option (in italics) allows you to specify that the data in this 

field should be ignored.  Other choices are either in bold or regular font.  Bold specifies that 

one field must be mapped to this attribute; regular font indicates that one field may be 

mapped to this attribute.  You cannot map more than one field to the same attribute. If you 

try to do this an error box will inform you. 

Import: this button is enabled when all of the required attributes are mapped (i.e. the bold 

options in the "Maps to" list).  It processes the import and displays a progress bar. 

Cancel: click this button to cancel the import and return to the main Optimal Trace window. 

Notes: 

 When importing steps, it is possible to map a field to a scenario name.  If that scenario 

does not exist in the requirement, it is silently created. 

 Likewise, for steps, the actor attribute may be mapped.  This will silently create actors 

if they do not exist already.  In the same way Structured Requirement goal levels may 

be silently created. 

 If the element type being imported can have custom properties, they will appear in the 

drop-down "Maps to" option list.  If a mapping for a custom property is specified, and 

the map is saved and applied later to a subsequent import for which the custom 

property is invalid, the custom property mapping is ignored.  Custom property bound 

values will be silently created as they are encountered in the file. 

 The Field Mapping table lists the fields found in the file.  This is determined by the first 

line in the text file only.  Make sure the first line contains the correct number of fields. 

 As lines are processed, only the first line's number of fields will be used.  If there are 

more fields on a line than found on the first line, the extra fields are ignored.  If there 

are fewer fields than found on the first line, the missing values are assumed to be 

blank. 

 If a field on a specific line found or determined to be blank maps to a bold attribute 

(e.g. Actor Name) then the value will default to "Unknown". 

 If an element to be imported has the same name as an existing element, then a copy 

is created, the existing element is not overwritten.  For example, if an actor "System" 

is imported, then actor "Copy of System" is created. 

 While importing, a progress dialog appears with a Cancel button.  Pressing cancel 

stops further imports, any imports already processed will remain.  To undo imports, 

either us the undo facility, or do not save the project. 

5.15.2 Import Word Document 

Use this option to import project data from a Microsoft Word document.  This is useful if you 

would like to extract data from an existing requirements document developed outside of 

Optimal Trace.  Because such documents can have a wide variety of formats, Optimal Trace 

does not mandate any particular document style.  Instead, Optimal Trace includes a tool by 

which you can annotate or markup a document indicating which parts should be associated 

with which project elements.  The import process is thus quite interactive, and typically it is 

achieved in a few passes following the following steps: 

1. Open the document through Optimal Trace 
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2. Mark up document regions as project elements using the Doc Import Markup 

tool 

3. Import the document and merge the marked elements with the open project 

4. Go back to step 2 to fix up any errors or omissions 

5.15.2.1 Opening the document to import 

The Import Word Document option is only available if an existing project or project element is 

selected in the tree.  On choosing the option, a standard file chooser dialog appears 

prompting for the document that should be imported. 

 

Navigate to the document to import and click the 'Import' button. 

5.15.2.2 Mark up the document 

After choosing the document, Microsoft Word is launched, and the document is loaded up.  A 

special window called the Optimal Trace Markup tool appears floating over the document.  

This wizard-like tool is a Word add-in that is used to add the markup annotations to the 

document.  These are special Microsoft Word comments that Optimal Trace recognizes when 

the document is subsequently read by the merge process.  Comments must be added by 

using the markup tool. If they were added in error, or need to be altered they can be 

removed using the tool, or by deleting them directly in Word. 

To mark a project element, comments must be added to the document to mark: 

 The element start 

 The element end 
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 Each element attribute 

When the document and tool first appear the first step is to specify the type of project 

element to be marked up using The element-chooser dialog.  Next the boundaries of the 

element are marked using The start/end dialog, and finally the attributes are marked using 

The attributes dialog.  Finally, for advanced use, The find similar dialog is available to guess 

the locations of other elements or attributes in other parts of the document based on one that 

has already been marked up. 

5.15.2.2.1 The element-chooser dialog 

 

 

Quick Help Button: click this button to display a floating Help screen, which contains quick 

instructions for whatever dialog is currently onscreen. 

Select the Element Type to Mark: this drop-down shows all the different project elements 

that can be marked up in the document.  Choose the one you want to mark. 

Mark New: click this button to advance to The start/end dialog to define the boundaries of a 

new element. 

Merge Button: click this button to launch the merge process and import the currently 

marked up elements into Optimal Trace.  Word and the markup tool remain active and you 

can return to them after the merge is done. 

Import Complete Button: click this button to launch the merge process for the last time to 

import the marked up elements into Optimal Trace.  You will be prompted to save your 

changes if you wish. Then Word and the markup tool will be shutdown. 

Edit menu: 

Edit Element at Cursor: this option forwards to The start/end dialog with the editing 

context set to the element that is closest to the cursor. 

Delete menu: 

Delete Selected Markup: this option is a convenience feature to remove all Optimal 

Trace markup comments in the text selected in Word. 

Delete Element at Cursor: choose this option to remove the markup comments for 

the element closest to the cursor, including the start and end comments, and any 

attribute comments. 
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5.15.2.2.2 The start/end dialog 

 

This dialog allows you to mark or move the starting and ending points of an element to be 

imported.  To use this dialog, move the insertion point in Word to the point that marks the 

start of the element and click the Mark Start button.  A start comment will be added to the 

document, and the starting text will appear in the area between the Mark Start and Mark End 

buttons in the tool. 

To mark the end of the element, move the Word insertion point to the ending point of the 

element in the document, and click the Mark End button.  The tool will create an Optimal 

Trace end comment at this point in the document as illustrated below: 

 

From the start/end dialog, the following other windows buttons and controls are available: 

Find Similar Button: this button is enabled when both the start and the end of an element 

are marked and forwards to The find similar dialog by which elements similar to the one just 

marked are inferred in the rest of the document.   

Next: click this button to mark attributes in the element that has been marked up using the 

attributes dialog. 

Back: click this button to return to The element-chooser dialog.  Any start or end comments 

that have been marked up already will remain marked up. 

Merge Button: click this button to launch the merge process and import the currently 

marked up elements into Optimal Trace.  Word and the markup tool remain active and you 

can return to them after the merge is done. 

Import Complete Button: click this button to launch the merge process for the last time to 

import the marked up elements into Optimal Trace.  Word and the markup tool will shut 

down. 

Edit menu: 

Edit Element at Cursor: this option will reinitialize The start/end dialog with the 

editing context set to the element that is closest to the cursor. 
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Delete menu: 

Delete Selected Markup: this option is a convenience feature to remove all Optimal 

Trace markup comments in the text selected in Word. 

Delete Element at Cursor: choose this option to remove the markup comments for 

the element closest to the cursor, including the start and end comments, and any 

attribute comments. 

 

Note: You can also edit or delete marked-up elements, by right clicking on the 

comment, and choose edit or delete from the menu. 

 

5.15.2.2.3 The attributes dialog 

 
 

After marking the start and end points of an element, the element is set to be the editing 

context.  This means that when Next is pressed, the attributes dialog which appears allows 

you mark the attributes of that element.  To mark an attribute, first select the attribute to 

mark from the drop down menu on the dialog then drag-select the area of text in the 

document that represents the value of the attribute.  Finally, click the Mark button on the 

tool.  A comment will appear in the document marking the attribute, as illustrated below.  

This should be repeated for all attributes. Comments added to the document by the import 

tool are color coded by element, for example in the picture below all comments relating to the 

'Word1' glossary entry have the same color. 

 

 

It should be noted that attributes need not necessarily be marked within the start and end 

points of their associated element. However it is recommended as a best practice (and to 

avoid confusing yourself in a large document) that the start and end points are placed so that 

they encompass all the attributes of the element. 
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It should also be noted that the user is permitted to mark the same attribute twice.  This is to 

facilitate cases where the attribute is dispersed across different locations in the document.  

Upon import, multiple mark-ups of the same attribute are concatenated into one single value. 

The following other buttons and controls are available from the attributes dialog: 

Find Similar Button: this button is enabled after an attribute is marked and forwards to The 

find similar dialog by which similar attributes of other elements are inferred in the document.   

Done: this button indicates you are done marking up the element, and returns to The 

element-chooser dialog. 

Back: click this button to return to The start/end dialog.  All document comments will remain 

as marked. 

Merge Button: click this button to launch the merge process and import the currently 

marked up elements into Optimal Trace.  Word and the markup tool remain active and you 

can return to them after the merge is done. 

Import Complete Button: click this button to launch the merge process for the last time to 

import the marked up elements into Optimal Trace.  Word and the markup tool will be 

shutdown. 

Edit menu: 

Edit Element at Cursor: this option will return to The start/end dialog with the 

editing context set to the element that is closest to the cursor. 

Delete menu: 

Delete Selected Markup: this option is a convenience feature to remove all Optimal 

Trace markup comments in the text selected in Word. 

Delete Element at Cursor: choose this option to remove the markup comments for 

the element closest to the cursor, including the start and end comments, and any 

attribute comments. 

 

5.15.2.2.4 The find similar dialog 

 

 
 

Since documents to be imported can be large and complex, it can take a long time to mark 

them up by hand.  For this reason, the markup tool offers the Find Similar dialog which can 

rapidly scan a document to find other candidate regions of the document that match the 
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format or style of an existing marked up area.  This can dramatically increase the 

effectiveness of the document import process. 

It is not necessary to use the Find Similar dialog.  Everything can always be marked-up and 

tagged one-by-one, using the other dialogs.  It is also more complex to learn and use. But in 

such cases as documents containing large tables, it can save many hours of work.  

There are two different ways that the Find Similar process can be invoked: 

 To find the boundaries of similar elements, click the Find Similar icon on The start/end 

dialog. 

 To find attributes of similar elements, click the Find Similar icon on The attributes 

dialog. 

In both cases, the dialog can only be summoned after an element or an element attribute is 

marked up.  This is called the source element or the source attribute, and is the template 

which is searched for in other parts of the document. 

There are a number of methods that the Markup tool uses to infer or guess matching regions 

of the document.  Depending on the source, some methods may not apply.  For instance, the 

"Table Row Selected" applies only if the source is a complete table row.  If this is true, then 

every subsequent table row is guessed as a match. 

For example, the picture below shows the selected source element is a glossary item which 

covers a complete row in a table: 

 

 

Here it is clear that the other rows in the table are also glossary entries.  On clicking the Find 

Similar "magic wand" button, the dialog appears and, indeed, it instantly guesses that the 

other three rows are also glossary entries: 
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Here the other three rows are outlined with temporary mark-up comments in another colour.  

The information area in the Mark-up tool indicates that three similar areas were found. 

At this point, one of the following options can be selected: 

Remove Incorrect Temporary Candidates: if any temporary Candidate comments are 

incorrect, they can be removed at this point by either using the 'Delete' menu or by right-

clicking on them and choosing Delete. 

Sometimes, for example, not every Row in a table is a Glossary Item. 

 

Mark Them: this accepts each of the candidate regions and converts them into full marked 

up elements.  The Mark-up tool returns to the previous dialog, either The start/end dialog or 

the The attributes dialog, depending on whether the source was an element or an attribute, 

respectively. 
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Try Again: this button discards the currently active candidate regions, and tries to match the 

source again using the next different method, if available.   The "(1 of 2)" text indicates how 

many search methods are applicable to the current source area. 

The other buttons and controls available on the Find Similar dialog are: 

Back: click this button to return to the previous dialog, either The start/end dialog or the The 

attributes dialog, depending on whether the source was an element or an attribute, 

respectively.  Any marked temporary comments will be removed. 

Merge Button: click this button to launch the merge process and import the currently 

marked up elements into Optimal Trace.  Word and the markup tool remain active and you 

can return to them after the merge is done. 

Import Complete Button: click this button to launch the merge process for the last time to 

import the marked up elements into Optimal Trace.  Word and the markup tool will be 

shutdown. 

Edit menu: 

Edit Element at Cursor: this option will return to The start/end dialog with the 

editing context set to the element that is closest to the cursor. 

Delete menu: 

Delete Selected Markup: this option is a convenience feature to remove all Optimal 

Trace markup comments in the text selected in Word. 

Delete Element at Cursor: choose this option to remove the markup comments for 

the element closest to the cursor, including the start and end comments, and any 

attribute comments. 

The Optimal Trace Mark-up tool uses several different methods to guess similar areas to the 

source element or attribute elsewhere in the document.  These candidate areas are always 

found in the document beneath this source area.  Depending on the style and formatting of 

the source, some methods may be applicable and some may not.   

The following is a list of the different methods, when they are applicable, and what they 

search for. 

Method name Applicable when the source 
area matches: 

What it will match: 

Row Selected in Table An entire table row All rows in the same table below the source 

Table Cell Selected A single table cell All cells in the same column in the same table below 
the source 

Entire Section Selected An entire section, including 
the heading 

All peer sections below the source section.  For 
example, if the source is section 2.2, then this 
method will match sections 2.3, 2.4, 2.5 etc., but will 
stop when section 3 is encountered. 

Heading Selected A heading, but no other text 
from that section. 

All peer section headings, as above. 

Heading Omitted An entire section, except the 
heading 

All peer section contents, as for Entire Section 
Selected, but excluding the headings. 

Nth Paragraph Selected The nth paragraph within a 

section 

The nth paragraph of each peer section below the 

source.  For example, if the fifth paragraph of section 
5.1.2 is selected, then this method will match the fifth 
paragraph of sections 5.1.3, 5.1.4, etc. until section 
5.2 is encountered. 

Bulleted Item Selected A bulleted item in a list All subsequent bulleted items in the same list. 

Number List Item Selected A numbered item in a list All subsequent numbered items in the same list. 

Lines With Same Font A paragraph or part of a 
paragraph. 

All areas in the current section with the same font. 
Font is matched on font Name, Size, Bold, and Italic. 
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Collectively, these methods should cope with a wide variety of document formats and styles.  

The more logical a document structure, and the simpler the layout, the more effective they 

will be.  In the event that documents are overly complex or poorly organized, they will be less 

successful, and there may be no alternative other than manual mark-up.  Future versions of 

Optimal Trace will add further methods and tune these existing ones to make them more 

accurate and effective. 

 

5.15.2.2.5 Doc Import Tips 

There are a number of techniques and tips which can prove useful when dealing with 

particular import situations.    

 

Tip: Marking up Project attributes 

If you need to mark up project attributes such as Project Name, Description etc, you 

should mark up a project element and then mark up the attributes, for example: 

1. Select the entire document, using Ctrl-A 

2. Create an element of type 'Project' 

3. Hit Start and End to mark up the start and end of the document as the start and 

end of the project.  

4. Click 'Next' and proceed to mark up the project name, description etc. 

 

Tip: Find Similar Areas Usage 

The recommended approach to use when marking up similar areas is to match the 

Start/Ends first, then move on to matching each Attribute.  It is usually much simpler 

and clearer as to what is going on.  If you mark just one Start/End, and then move to 

the next screen and Find Similar 10 different Names, then you may get confusing 

results on import. The tool will attempt to find an owner Element for all of the 10 

Names, but here is only one Start/End Element that it can use. 

Hence the simpler & recommended approach is: 

1. First mark the start and end of the element you wish to mark up. 

2. Click the 'Find Similar Areas' button and mark up the areas that match the start and 

end of the selected element. 

3. Now in the element marked up in step 1, mark up an attribute. 

4. Hit 'Find Similar Areas' again to mark up similar text in the document for that 

attribute. 

5. Repeat steps 3 and 4 for any other attributes you wish to mark up. 

Once you have completed these steps you will have successfully marked up several 

elements of the same type, and their attributes. 

 

Tip: Convert Text to Table and then use Find Similar 

If you are having trouble using 'Find Similar Areas' to  mark up similar areas of text, 

try converting the text to a table by going to the Table menu in Word and selecting 
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'Convert' and then 'Text To Table'. Then use Find Similar Areas to match up the areas 

of the table. 

 

Tip: Find Similar Areas and Headings 

Find Similar Areas can be used to automatically mark up headings at a similar level. 

However this will only work correctly if all headings in the document use an 

appropriate MS Word style. For example, top level headings should have a 'Heading 1' 

style etc.   

Frequently, Word users change the font and formatting to create 'roll-your-own' 

Headings.   So instead of using proper a Heading 1 style, users apply a large font and 

turn on Bold.   Then the Find-Similar 'search for Headings' will fail. 

The solution is to hold down Ctrl and select all the bits you want to match, and then 

apply a proper Heading Style to all of them.    (Use the Styles dropdown in the Word 

menu bar, or click Format->Styles and Formatting to display the Styles pane). 

Once all these areas have a proper Heading style, find similar will detect this and 

match them. 

Note that Find Similar areas will only search within the current chapter in the 

document. For example if you mark up all of Section 5.1 in a document, and use find 

similar areas, it will highlight sections 5.2, 5.3, etc., however it will not highlight 

sections 6, 6.1 etc. 

If there are no Headings in the document, you can simply add some.  It helps the Find 

Similar methods by giving them some structure to work with.  A large document with 

no headings will take the search methods a lot of time to work through. You can delete 

the Headings afterwards if you wish. 

 

Tip: Using 'LinesWithSameFont' to match otherwise unmatchable areas. 

Suppose you wish to match a number of sentences scattered throughout a large table.  

The sentences are not consistently organized or positioned, and hence none of the Find 

Similar search methods work. 

A very useful technique is to hold down CTRL, select the source area, and then multi-

select all these other areas you wish it to find.   Then go to the Font dropdown in the 

Word menu bar and select an unusual font, one that is not is use elsewhere in the doc.    

Now click Back, if you are on the Find Similar window.  Then click the magic wand 

button again.  This time, the 'LinesWithSameFont' method should successfully find all 

the target areas. 

 

Tip: Save your document often 

It can be very useful to save copies of the document throughout your mark-up section, 

e.g. "My Doc.doc", "My Doc2.doc", and “My Doc3.doc". This can be useful if you wish 

to import a certain section into many projects. For example you may have marked up 

a section of a document to import to the glossary, if you save the document, for 

example "My Doc - Glossary.doc", you can import these markup elements into the 

glossary section of many projects. 
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Tip: How to mark up a table column 

If a user selects a column in a table and attempts to mark it up, only the final cell in 

the table will be marked-up. Note this is due to a restriction in MS Word.  There is a 

workaround as can be seen in the following example. To mark up the contents of a 

column as a requirement description: 

1. Mark the entire table as a requirement, i.e. mark 'Requirement Start' at the start of 

the table, and 'Requirement End' at the end of the table. 

2. Click on 'Next>' and mark the top most cell in the target column as 'Requirement 

Description'. 

3. Click on the 'Find Similar' button. It should highlight every cell below the top one. 

4. Click on the 'Mark' button to mark all these highlighted cells.  

Here, we are exploiting the fact that multiple appearances of the same Attribute get 

concatenated upon import. This is to allow dispersed chunks of text to be all imported 

into "Project Description", for instance.  The text in all the marked-up cells will be 

concatenated into the requirement description when the document is imported.  

 

Tip: Sort and Split up mixed Tables 

If a table contains both Requirements and Sub-Requirements (i.e. Items) interspersed 

with each other on different rows, then Find Similar won't differentiate the two types.  

The trick here is to sort the table, by whatever column is appropriate, so that all the 

Requirements are together and all the Items are together. Then, split the table into 

two.  The Word menu item to do this is Table->Split Table.  One new table will contain 

only Requirements and the other will contain only Items. Next, Find-Similar the 2 

tables and mark up all their Rows and Cells, as Requirements, Items, and the 

respective attributes for each of them.  Finally, combine the two tables back into one, 

and sort by a column that will recover the original ordering.   (If there is no such 

column, it is possible to add an extra dummy column containing the numbers 1...row 

count, before sorting & splitting the table). 

 

This tip can generalize to any table containing mixed types. 

 

 

 

5.15.2.3 Merging from the Mark-up tool 

As described, all of the dialogs on the Mark-up tool provide two buttons to view the results of 

the marking up process in Optimal Trace. 

 

 Merge Show interim result in Optimal Trace 

 Import Complete Show result in Optimal Trace, and quit the import process. 
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In both cases, the marked up elements are not imported directly into Optimal Trace, instead, 

a merge screen appears allowing you to preview the contents of the import before accepting 

it. 

 

If you merge the same elements more than once, Optimal Trace does not create duplicate 

elements, instead, it will remember the originally imported element, and apply any changes to 

it.  The merge process is described in more detail here: 14.5 Merge Two Projects Option. 

 

5.15.2.4 Word security settings for Document Import 

 

 The Optimal Trace document Import tool requires that the Word Macro Security level is 

set to a maximum of 'High' for Word 2007, Word 2003, and Word 2000. This can be 

set in the Macro Security settings screen. For example, in Word 2003, this screen is 

accessed via the 'Tools-> Options' screen. For Word 2000 you also need to have the 

'Trust all installed add-ins and templates' option selected on the 'Trusted Publishers' 

tab. Additionally when installing Word 2007, select Basic for Applications (VBA) in the 

Office Shared Features category. 

 

The Doc Import tool has been digitally signed.  Upon launching, Word may ask whether it 

should trust the software.   It will present details of the digital certificate, which is issued in 

the name of 'Compuware Corporation', and indicate that the signature is OK. You can safely 

click "always trust content from this publisher". 

 

 

5.16 Save Image Option 

Use this option to save an image file for what currently appears in the Requirement map and 

Flow views; see 6.12  A Note on the Requirements Map and Flow Diagram View, for details. 

To save an image for a specific flow, select that flow and the saved image will correspond to 

the currently displayed flow. 

 

 Click on the Requirement or Package you want to save an image of 

 From the Menu bar, click on Project 

 Click on Save Image and a save screen will appear 

 

The save file type will typically default to „.jpg‟ for JPEG file. You may alternatively choose to 

save in a number of other common formats including BMP, TIF etc. 

Images can be saved as either the entire image or else for larger images you may want to 

split the image across pages, creating different image files. To set this option see the 'Options 

>> General Options…' menu item. (See section 13.1.1 Tool Settingsfor more details on image 

settings) 

You may save this image wherever you want. Later, you can click on the image file in 

Windows Explorer and the image will appear on your screen, perhaps as in the example 

shown in Figure 17 below. 
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Figure 17 – Viewing a Saved Image in a 3rd party image viewing package 

 

5.17 Exit Option 

Use this option to exit Optimal Trace™ Enterprise.  

 

 From the Menu bar, click on Project 

 Click on Exit, and Optimal Trace™ Enterprise will close. 

 

Note: If changes have been made since opening any project(s) or if you have any unsaved 

changes, the system will prompt you to save any outstanding changes prior to shutting down.  
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6 Optimal Trace Projects 

The Optimal Trace™ Enterprise screen is split into six different views, namely the Tree View, 

the Thumbnail View, the Query View, The Traceability View, the Details View and the Right 

Pane View; see the sections below for details. 

 

The Tree View contains the list of currently opened Projects and their respective contents.  

Each Optimal Trace Project consists of: 

 Actors 

 Glossary entries 

 Requirement Packages & sub-packages 

 Structured Requirements comprising scenarios and steps 

 Simple Requirements comprising items 

Each entry in the tree is referred to as a Node. The Project elements shown in the Tree View 

is further described in the following sections. 

 

6.1 Project Properties 

When a Project is first opened, its properties are displayed in the Right Pane View. Some of 

these are Editable and they include: 

 

 Project Name - the name of the Project 

 Owner - this defaults to the login name however it can be changed  

 Description - a description of the Project 

 

Non-editable properties include: 

 

 Project Creation Date - the date and time that this Project was initially created 

 Location of Project - the file location on your hard disk or on a network drive 

 Baseline of Project - the current Project Baseline. See Section 5.4 About Baselines, 

for details on Projects and Baselines. 

 

6.2 Project Non-functional Requirements 

 

 

Special Note: In Optimal Trace 5.0, Non-Functional Requirements are deprecated. Users 

wishing to capture Non-Functional type requirements should use Simple Requirements instead 

for these purposes. See section 6.13 Simple Requirements Overview for more information on 

using Simple Requirements for capturing non-functional requirements. 
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 Z 

 

In Optimal Trace, non-functional requirements can apply either at the project or discrete 

structured requirement level. The latter means that the quality or constraint applies just to 

that structured requirement, the former means that the non-functional is project wide. See 

section: 6.10 Structured Requirements Overview for more on Structured Requirements. 

Non-functional requirements fall into two categories, qualities and constraints: 

 Qualities – qualities specify criteria for which the Project or Structured Requirement 

must guarantee. The Withdraw cash Requirement might have the quality that the 

machine is available 24x7 with acceptable downtime or that 95% of time receipts must 

be capable of being issued.  

 Constraints - examples of constraints might be that the Requirement must interact 

with a specific protocol for data interchange, e.g. EDI (financials), EMI (Telco billing) or 

newer standards such as ebXML etc. 

Non-functional requirements must be unique by Description as qualities typically fall into 

categories that can be repeated. Each Non-functional requirement comprises: 

 

 Category - a piece of text specifying the type of Non-functional requirement 

 Non-functional requirement - a description of the actual Non-functional 

requirement 

 Priority – a text field for you to place prioritization information. 

 

 To access these, click on the Non-functional requirements tab. Just as subject must 

uniquely identify Notes, Non-functional requirements must be uniquely identified by 

description. Non-functional requirements can be broken down further into two 

categories: qualities and constraints. Qualities specify criteria such as level of uptime, 

e.g. 7x24, level of security or United States security export restrictions or number of 

concurrent users etc. Constraints dictate requirements such as the system having a 

company’s branding on all screens or integrating with an existing ERP system. 

 

Note: Non-functional Requirements can have one or more associated Custom Properties 

defined. To see or modify the current set of custom properties click on the  button. (See 

section 6.5 Custom Properties for more on custom properties in general) 

 

6.3 Project/Requirement Links 

In Optimal Trace, Links can be created at a number of levels: 

 Project 

 Structured Requirement 

 Simple Requirement 

 Simple Requirement Items 

Links are used to associate two types of entities at these levels. 
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Firstly any file or URL references/artifacts such as documents, graphics, URLs1, Visio files, 

excel spreadsheets etc. can be associated with the project or specific requirements using a 

link. 

Secondly, Trace Links can be created to set-up Traceability relationships from one Optimal 

Trace project element to another either within the current project or to an element in a 

different local (file) or repository based project. 

 

6.3.1 File & URL (web) based Links 

File based Links are intended as a convenient mechanism for associating miscellaneous 

information pertinent to a given requirement or the project as a whole. 

For example, you may wish to store a Link to domain-specific information such as a 

healthcare standard document, a government web site Link, or a sample screen shot etc. 

 

 Click on the Links tab to access Links associated with the current Project or selected 

Requirement. OR 

 For Simple Requirement Items, click the  button to the right of the selected item. 

 To create a new Link click on the  button and a new blank Link is created. 

 To edit the Link location you can either edit the location field directly into the text field 

or click on this Link button  and a file chooser will appear. Navigate to the specific 

area and select the appropriate file then click on the Open button. 

The Link information is then updated in Project‟s Links area. 

 

Figure 18 - Project Level Links in Optimal Trace™ Enterprise 

 

Note: Unresolved Links. Each Link has a name and description however if a linked file 

cannot be resolved or found at the address specified then that link is displayed in red. 

 

                                           
1 Uniform Resource Locator, this is a reference to a website and is typically of the form „www.xyz.com‟ 
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Tip: User Interface Storyboards. Optimal Trace is very suitable for supporting Storyboards 

and generating attendant documentation. You can associate storyboards with specific 

Structured Requirements. When you generate documents, the screenshots are then 

embedded in the generated document providing an excellent basis for communicating to 

stakeholders especially on the Business side. Note that Links attached to Items are not 

expanded in the generated documentation. 

 

Note: Links can also be associated with Simple Requirement Items. Unlike 

Project/Requirement Links, Simple Requirement Links cannot be expanded in generated 

documents. 

 

6.3.2 Traceability Links 

The second category of Links that can be created are Trace Links, these are Links to Optimal 

Trace project elements. These allow any requirement or project element to be referenced as a 

link associated either with the project or else with a given requirement. 

The process of creating a link is similar to establishing a file-based link.  

 Click on the Links tab to access Links associated with the current Project, and the 

screen shown Figure 18 above will appear. See Table 2 below, for details. 

 Create a new Link by clicking on the  button. 

 The Link Location now needs to reference a given Optimal Trace element. A screen 

appears allowing you to specify the given element that is being linked to (See Figure 

19 - Adding an Optimal Trace Element Trace Link). 

 Select the element you want to link to and hit 'Apply'. You can also automatically 

create reverse links by checking the box. 
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Figure 19 - Adding an Optimal Trace Element Trace Link 

 

Note: As an alternative way of creating Trace links, you can also create Trace Links between 

elements by copying URIs. 

In this case, the reference is created by copying the element reference via the 'Copy as Link 

(URI)' popup menu. (See section 9.3 Copy as Link (URI) for more detail on how to copy link 

references) 

Once the reference has been copied to the clipboard, then that reference is entered (by 

pasting it into the field) into the Location field of the link. 

 

Table 2 - Links in Optimal Trace™ Enterprise 

Item Description 

Link Name The name that you wish to call this Link, each Link name must be 

unique. 

Link Location This is the actual file name, URL or Optimal Trace 'Traced to' Project 

Element for this Link 

Graphical Icon This is a visual cue indicating the type of element that is stored on the 

links. 
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6.4 Project/Requirement Notes 

In Optimal Trace, Notes can be created at the project or discrete requirement level 

(structured and simple). The latter means that the note is associated with the selected 

requirement, the former means that the note is relevant to the entire project. 

Each Project or Requirement can have an arbitrary number of Notes associated with it.  

 

 To access these, click on the Notes tab, and the screen shown Figure 20 below will 

appear. See Table 3 below, for details. 

 

 

Figure 20 - Project Notes tab screen 

 

Table 3 - Project Notes tab screen 

Item Description 

Subject A piece of text specifying the type of Note. Each Note must have a unique 
Subject. 

Note A description of the Note itself. 

 

 

6.5 Custom Properties 

Optimal Trace projects can be created with custom properties defined for all different types of 

elements, e.g. Project, Package, Structured Requirement, Simple Requirement etc. 

 

This means that Optimal Trace projects can be customized to hold data specific to the needs 

of different roles or objectives. For example project managers might require Requirement 

level custom properties of Business Priority, Increment etc., while technical architects and QA 
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stakeholders might want to see properties such as: Technical Risk, Functional Tests Defined 

etc. associated with Simple Requirement Items. 

 

Custom Properties can be set as either freeform or 'bound', the latter meaning you can select 

from one of a list of predefined values. 

 

Custom properties can be created for all major project element types covering: 

 
Project 

Glossary Entries 
Actors 
Packages 
Structured Requirements 
Structured Requirement Scenario Steps 
Non-functional Requirements 
Simple Requirements 
Simple Requirement Items 

 

In Optimal Trace, Custom Property definitions are accessible from: 

 

 the context that the Custom Property is related to, typically via a  button located in 

a toolbar adjacent to the relevant element or  

 from a centralized 'Settings' tab at package or project level. 

 

Custom Properties can be specific to a given package, meaning that the structure of the 

custom properties is particular to requirements contained in that package. See the next 

section 6.5.1 Custom Properties and Sharing for more on this. 

 

So, to outline how all of this works let's consider Project level custom properties. These 

appear as in Figure 21 - Project Level Custom Properties below in a specific project level tab. 

In this case a number are defined at project level including 'Business Case' etc. 

 

 

Figure 21 - Project Level Custom Properties 
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Clicking on the '…' button brings up a 'Custom Properties' screen as shown in Figure 22 - 

Project Level Custom Property Settings 

 

 

 

Figure 22 - Project Level Custom Property Settings 

 

You can now add, remove or modify existing Custom Properties from this screen. Defining 

Custom Properties for all element types in Optimal Trace works in exactly the same way using 

this screen. 

 

 To add new custom properties click on the  button. This will insert a new custom 

property. When working in a repository based project the result of adding a custom 

property is that all instances of that element in the project (Requirement etc.) acquire 

a lock. See Section 6.5.2 Modifying Custom Properties and Locking Implications below 

for locking implications. 

 To remove an existing custom property, select the custom property by clicking on the 

grey square to the left of the entry and click on the  button. This will remove the 

custom property. When working in a repository based project, the result of removing a 

custom property is that all instances of that element in the project (Requirement etc.) 

acquire a lock. See Section 6.5.2  Modifying Custom Properties and Locking 

Implications below for locking implications. 

 

To define a Custom Property as Bound, click on the checkbox to the right of the property. A 

"…" button appears in the rightmost cell of the table for this custom property, and if you click 

on this a screen similar to Figure 23 - Sample Bound Values below appears. You will then be 

able to add or remove given bound items by clicking the  and  buttons respectively. 
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Figure 23 - Sample Bound Values 

 

A sample set of Custom Properties at Item Level appears in Figure 24 - Custom Properties 

showing at Item Level indicated by the red boundary 

 

 

Figure 24 - Custom Properties showing at Item Level indicated by the red boundary 
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6.5.1 Custom Properties and Sharing 

Optimal Trace provides a very flexible mechanism for customizing projects at all levels. This is 

possible using Custom Properties defined either at project wide level or specific to given 

packages of requirements. 

You may customize the definition of the set of custom properties at package level or a given 

package may share its parent package/project's Custom Property set. Sharing of Custom 

Property definitions can be done by checking the 'Share Custom Properties with...' checkbox 

in the settings tab of a given package. 

 

 

Figure 25 - Package settings  

 

In order to do this, you select the package, click on the 'Settings' tab. On this tab there is a 

'Share Custom Properties with' checkbox, which is checked by default (except in the case of 

the root package in new projects). If you uncheck this checkbox, the package will no longer 

use the set of Custom Properties defined by the parent, rather it will have its own set of 

independent Custom Properties that will apply to all elements within that Package and 

possibly all child Packages. 

For example you may have a package entitled 'Out of Scope' which contains requirements 

that are out of scope for the current release. Uncheck the „Share Custom Properties with‟ 

check box. You can add a Structured Requirement level Custom Property called 'Planned for 

Release' to this package by clicking on the 'Structured Requirement Custom Properties' 
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button, and adding the Custom Property as before. Now only Structured Requirements 

created in the 'Out of Scope' Package will have this Custom Property. 

If you decide at a later time that you want the 'Out of Scope' Package to share the same 

Custom Properties as the rest of the Project, you can re-check the 'Share Custom Properties' 

checkbox. Any Custom Properties defined in the 'Out of Scope' Package that are not defined 

as Custom Properties in the rest of the Project will be removed. In the example above, re-

checking the 'Share Custom Properties' check box will mean that the 'Planned for Release' 

attribute is removed for all Structured Requirements in the 'Out of Scope' Package. 

 

Note: To previous users of Optimal Trace. By default, when you defined a set of custom 

properties in previous releases, those custom properties applied to all elements of that type 

created within that project. 

For example, if you created a custom property called 'Technical Risk' for Structured 

Requirements, every Structured Requirement in the project will have an attribute called 

'Technical Risk'. In most cases, this will satisfy the needs of your project, as typically you 

would tend to capture the same information for all Requirements in your project. 

However there may be times when you would like to have a different set of Custom Properties 

for a part of your project. For example you may have a package entitled 'Out of Scope' which 

contains requirements that are out of scope for the current release. In Optimal Trace you can 

for example now define a Custom Property called 'Planned for Release' that will apply to 

Requirements contained in the 'Out of Scope' package only. 

 

6.5.2 Modifying Custom Properties and Locking Implications 

When working online any modifications to Custom Properties result in all dependent elements 

acquiring a lock. (See section 18.2 Concurrency and locking for more on Locking and multi-

user usage). 

Consequently you will see a lock icon appear next to any such elements. For projects this 

appears as . Each element in the Tree is adorned with the green lock icon. 

For Packages, Requirements and any elements that can have Custom Properties defined, 

since modifying a specific element will affect the underlying structure of all instances of that 

element, you must have exclusive access to those elements prior to any modification. 

As an example, if you attempt to modify the Custom Property of a 'Requirement' and another 

user is currently editing any requirements in that project that use that Custom Property, then 

you will be unable to perform the modification and will receive a message as shown in Figure 

26 - Message indicating an element is locked below. 

 

 

Figure 26 - Message indicating an element is locked 
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6.6 Project Settings 

The settings for a Project are used to apply default values for Requirements created in the 

Project. 

For Project Templates the settings specify values that will be applied to projects created from 

those templates. 

To access the project settings, click on the Settings tab and the screen shown in Figure 27 - 

Project Setttings Screen appears. 

 

 

Figure 27 - Project Setttings Screen 

 

There are three sets of settings available for projects and Project Templates. 

 Goal Level 

 Numbering Policy 

 Custom Properties 

 

6.6.1 Goal Levels Settings 

To access the Default Goal Level setting click on the  button adjacent to the 'Default Goal Level' text, 

and the screen shown in Figure 28 below will appear. See Table 4 below, for details. 
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You can specify settings for the Default Goal Level; this is the goal level that will be set 

whenever new Requirements are created. Goal Levels are used to specify the level of 

abstractness or concreteness of a Requirement; refer to Alistair Cockburn [1]. Optimal 

Trace™ Enterprise ships with ready-to-use goal-levels, see Table 12 on page 134 for a list of 

these default Requirement Goal Levels. 

 

 To edit an existing goal level for a Project, select its Name and/or Description and 

change it. If an edited level is already in use by another Requirement, the 

corresponding Goal Level text will be altered accordingly. 

 To add your own new goal levels click on click on the  button. 

 To remove a Goal Level, click on the  button. 

  

 

Figure 28 – Project Specific Goal Levels screen 

 

Table 4 - Project Specific Goal Levels screen 

Item Description 

Default Click the option to set as the default Project Specific Goal Level. 

Name Name of the Project Specific Goal Level. 

Description Description of the Project Specific Goal Level. 

 

 

6.6.2 Numbering Policy Settings 

 

Optimal Trace projects can be set to have one of three types of numbering policies as outlined 

in Table 5 - Numbering Policies. Numbering Policies affect the handling of requirement 

numbering in a given project. 
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Table 5 - Numbering Policies 

Number Policy Description 

Package/Tag 
Based 

The Package/Tag policy means that when a new package is encountered 

with a different package Tag then the numbering starts at 1. (see 

section 6.9.2 Tags for more on Package Tags) 

Note: This is the default policy in Optimal Trace Project Templates 

Project Based The Project Based policy means that all Requirements are numbered 

uniquely across the project and specifically across packages. 

Package Based The Package Based policy means that Requirement numbering is reset to 1 

when a new Package is encountered. 

 

 

6.6.3 Custom Property Settings 

Optimal Trace projects can be created with custom properties defined at all element levels. 

 

Custom properties can be created for: 

 
Project 
Glossary Entries 
Actors 
Packages 
Requirements 
Requirement Scenario Steps 

Non-functional Requirements 
Simple Requirements 
Simple Requirement Items 

 

 

Clicking on the '…' button adjacent to each project element brings up a screen as shown in 

Figure 22 - Project Level Custom Property Settings 

 

See section 6.5 Custom Properties for more on custom properties in general. 

 

6.7 Defining Glossary Items 

It is important to define Glossary Items during a requirements gathering exercise as they 

provide the common definitions as understood by domain experts.  

 

 To define Glossary entries, under the Project click on the Glossary icon . A list of 

Glossary entries appears in the Right Pane View.  

 You can add or remove entries by clicking the buttons in the Tool bar. 

 Clicking  allows you to add an entry.  

 To remove an entry, highlight the Glossary item by clicking the button to the left of the 

entry (shaded grey square) and then click on the  button. 
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Figure 29 - The Glossary from the sample 'ATM' project. 

 

Each entry consists of a name (unique within a Project) and description. It is also possible to 

edit entries by clicking on the text and adjusting accordingly. 

Note: Glossary Entries can have one or more associated Custom Properties defined. To see 

or modify the current set of custom properties click on the  button. (See section 6.5 

Custom Properties for more on custom properties in general) 

 

6.8 Defining Actors 

Actors are entities that interact with a system. 

 

 To define a new Actor, under the Project click on the Actor List icon . A list of Actors 

appears in the Right Pane View. Optimal Trace™ Enterprise ships with one default 

Actor, the system.  

 You can add or remove Actors by clicking the buttons in the Tool bar. Click on the add 

actor button to add an Actor.  

 To remove an Actor you must highlight the Actor by clicking the button to the left of 

the entry and then click on the delete actor button. If you try to delete an Actor, which 

is associated with a Step in a Requirement, then Optimal Trace™ Enterprise will 

confirm whether you really want to delete the Actor. If you click on the Yes button, 

then all of the associated Steps will be disassociated from the deleted Actor. 

 

Each Actor consists of a name (unique within a Project) and a description. 
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 You may edit Actors by clicking on the text of their names and descriptions, and 

adjusting them accordingly. 

 

 

Figure 30 - The list of Actors in the project 

 

Note: Actors can have one or more associated Custom Properties defined. To see or modify 

the current set of custom properties click on the  button. (See section 6.5 Custom 

Properties for more on custom properties in general) 

 

6.9 Packages Overview 

Packages provide a way of grouping related sets of Requirements. These can be edited by 

clicking on the Package Node in the Tree View and modifying them in the details area to the 

bottom left of Optimal Trace™ Enterprise. There is no restriction on the number of nested 

Packages that can exist. Packages are useful when segmenting a Project into logical units. 

They can also be used to specify incremental delivery units for a system. 

Every Project always has at least one Package, namely the default Package labeled 

„Requirements‟ if created from the empty project template. This root package housing all 

other Packages & Requirements cannot be deleted. 

Packages are a mechanism to group related requirements. Packages can contain more 

packages. Requirements can be either structured, meaning they are comprised of scenarios 

and steps or non-structured meaning they are either a quality or constraint type statement. 

For explicit instruction on creating, deleting and manipulating Packages, see Sections starting 

at: 11.5 New Package Option. 

 

6.9.1 Package Details 

Each Package has the following: 

 Name - the name of the Requirement, e.g. „Withdraw Cash‟ 

 Package Tag - a tag for all requirements within the package 

 Description - a fuller description of the objectives of the Requirement 
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You edit the package details by adjusting the specific values in the Figure 31 - Package 

Details screen. 

 

Figure 31 - Package Details 

 

6.9.2 Package Tags 

 

Package level requirements can have their own specific 'Tag'. This means that each package 

can be dedicated to a specific 'Type' of structured requirement indicated by the tag. For 

example, you might choose to store all your Business Process flows in one package with tag 

'BP', while a sibling package might store the corresponding detailed Software Requirements 

with tag 'SR'. Alternatively Product Managers might choose to place all Product Feature 

Requests in one package with tag 'FR', and detailed Requirements in a second package with 

tag 'DR'. 

 

6.9.3 Package Custom Properties 

Custom properties can be defined for Packages. 

 

This means that each Package can be set up to hold data associated with the package. 

 

Custom Properties can be set as either freeform or 'bound', the latter meaning you can select 

from one of a list of predefined values. Package Level Custom Properties behave in exactly 

the same way as Project Level Custom Properties. 

 

See section 6.5 Custom Properties for a full description of how to add, remove and modify 

Custom Properties. 
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6.9.4 Package Settings 

The Package Settings area allows you to configure whether this Package shares Custom 

Property definitions with its Parent package (or Project if it‟s the root package), or if it has its 

own set of Custom Property definitions. 

 

See section 6.5.1 Custom Properties and  for more information on Custom Properties and 

sharing properties. 

 

6.10 Structured Requirements Overview 

Structured requirements outline objectives or goals (and their detailed scenarios & steps) 

whereas non-functional requirements cover system qualities and constraints. 

A Structured Requirement provides a mechanism for capturing functional requirements for a 

system in a comprehensible and communicable way. A single Structured Requirement is a 

strand of functionality that a system will ultimately deliver; a collection of Requirements can 

express the entire functional behavior of a system. Consider, for example, writing the 

specifications for an Online Ordering System. 

You would formulate an individual Requirement to satisfy each goal for the system needs to 

provide for each user (an „Actor‟).  Typical Goals & Requirements might be „Create an Order‟, 

„Run Reports‟ and „View Shipped Orders‟. Taken together, a set of such Requirements 

constitutes an entire functional specification of the Order System. 

For explicit instruction on creating, deleting and manipulating Structured Requirements, see 

Section: 11 Requirements Menu. 

 

Note: Structured Requirements are an excellent way to support Agile, Use Case driven or 

Business Process projects. 

From an Agile perspective you can think of a structured requirement as a formalized 'Story' of 

how the system will provide value to the personas or users. From a use case perspective, a 

structured requirement can be considered the detail of the use case. From a Business Process 

perspective a Structured Requirement can be thought of as a documented business process.  

 

6.10.1 Structured Requirement Properties 

Each Structured Requirement has a number of properties that help clarify its purpose and 

nature. These are: 

 Name - the name of the Structured Requirement, e.g. „Order Goods‟ 

 Description - a fuller description of the objectives of the Requirement 

 Pre-condition - something that must have happened prior to someone being able to 

start this Requirement. For example, in order to Withdraw Funds, the customer (Actor) 

must have an ATM card to place in the machine. 

 Post-condition - something that is true on successful completion of the Requirement. 

For example when withdrawing funds the success criterion is that the funds are 

actually withdrawn and in possession of the customer and the customer‟s bank account 

is debited. 
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 Actors - these are automatically built as a result of specifying Actors with Steps in the 

scenario. See Section 11.14 Steps Menu, for details. 

 Priority - the importance of the Requirement - this value typically reflects two factors, 

one the importance of the Requirement from a customer perspective and two the 

technical or logistical risk associated with this Requirement 

 Goal-level - the level of abstractness of the Requirement. See Section 6.6.1 Goal 

Levels Settings, for details about goal levels. 

 Trigger - how the Requirement is started or invoked. For example for Withdraw Cash 

this might be that the customer is low on cash and wants to buy some goods. Triggers 

are useful if the Actor is a non-human and represents another system. A batch feed 

signal is a good example of a more common trigger. 

 Minimum Guarantee - the Requirement will guarantee to complete some 

functionality and this should be specified here. 

 

6.10.2 Structured Requirement Custom Properties 

Custom properties can be defined for Structured Requirements. 

 

This means that each Structured Requirement can be set up to hold associated data. 

 

Custom Properties can be set as either freeform or 'bound', the latter meaning you can select 

from one of a list of predefined values. Requirement Level Custom Properties behave in 

exactly the same way as Project Level Custom Properties. 

 

See section 6.5 Custom Properties for a full description of how to add, remove and modify 

Custom Properties. 

 

 

6.10.3 Non-functional Requirements 

 

Note: In Optimal Trace 5.0, Non-Functional Requirements are deprecated. Users wishing to 

capture Non-Functional type requirements should use Simple Requirements instead. See 

section 6.13 Simple Requirements Overview for more information. 

 

Each Requirement can have an arbitrary number of Non-functional requirements associated 

with it. To access these, click on the Non-functional tab. 

Requirement related Non-functional requirements behave in exactly the same way as Project 

Non-functional requirements. See Section 6.2 Project Non-functional Requirements for a full 

description. 

 

6.10.4 Links 

Links can be associated with Requirements as well as with Projects. These provide ability to 

associate documents, graphics, URLs2 etc. with the Requirement. Click on the Links tab to 

access the Links associated with a Requirement. Links at the Requirement level work in 

                                           
2 Uniform Resource Locator, this is a reference to a website and is of the form „www.xyz.com‟ 
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exactly the same way as Project Links. See Section 6.3 Project/Requirement Links, for a full 

description. 

 

6.10.5 Notes 

Each Requirement can have an arbitrary number of Notes associated with it. To access these, 

click on the Notes tab. Requirement Notes are useful for storing miscellaneous 

issues/clarifications to do with any aspect of the Requirement. They work in exactly the same 

way as Project Notes. See Section 6.4 Project/Requirement Notes for a full description. 

 

6.11 Requirement Main Success Scenario and Alternate Scenarios 

A Structured Requirement consists of set of one or more scenarios each comprising a 

sequence of sub-requirements or actions (Steps). Every Structured Requirement contains a 

Main Success Scenario; the objective of this is to capture the Steps that will lead to successful 

completion of the Requirement. For example, the Main Success Scenario of a „Withdraw 

Funds‟ Requirement is that funds are successfully withdrawn. 

Structured Requirements may also include alternate paths or scenarios. Alternative scenarios 

may result in achieving the overall requirement or may mean that the Requirement is not 

successfully completed.  

Some examples of unsuccessful completion might be an ATM machine being low on cash (Alt. 

Scenario: Machine Low on Cash), or an account having insufficient balance (Alt. Scenario: 

Machine Low on Cash). In these cases, the objective of the Requirement could not be met.  

Sometimes, a Structured Requirement can complete successfully even if an Alternate scenario 

applies. For example, a machine may not have appropriate denominations to satisfy the 

requested amount (Alt. Scenario: Re-specify amount), but this will not prevent possible 

successful completion of the Requirement named „Withdraw Cash‟. 

For more detailed instructions on creating, deleting and manipulating Scenarios and Steps, 

see Section 11.17 Scenarios Menu and 11.14 Steps Menu respectively. 

6.12  A Note on the Requirements Map and Flow Diagram View 

The Requirement Map View shows the relationships between this Requirement and other 

Requirements, including Refinement and branch relationships. A Requirement map looks 

similar to Figure 32 below. 

The Flow Diagram outlines the specific flow within a structured Requirement. This is very 

useful for graphically outlining the scenarios, steps and distinct sequential business rules that 

trigger deviations in the flow. 
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Figure 32 - Requirement Map with Scenarios 
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Figure 33 - Requirement Flow Diagram with Scenarios 

 

6.13 Simple Requirements Overview 

Simple Requirements allow the capture of less complex Requirements, where the 

Requirements tend to have a list structure. Examples where Simple Requirements would be 

particularly suitable include: 

 Data oriented requirements where the need exists to specify format information in a 

tabular fashion. 

 Marketing and other 'flat' requirements types where a tabular structure is common. 

 Feature Lists for Product Managers that can be refined to more detailed structured 

requirements if necessary. 

 Standard non-functional requirements types such as scalability, redundancy etc. 
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6.13.1 Simple Requirement Properties 

Each Simple Requirement has a basic set of properties that help clarify its purpose. These 

are: 

 Name - the name of the Simple Requirement, e.g. „Order Goods‟ 

 Description - a fuller description of the objectives of the Requirement 

 

6.13.2 Simple Requirement Custom Properties 

Custom properties can be defined for Simple Requirements. 

 

This means that each Simple Requirement can be set up to hold associated data. 

 

Custom Properties can be set as either freeform or 'bound', the latter meaning you can select 

from one of a list of predefined values. Requirement Level Custom Properties behave in 

exactly the same way as Project Level Custom Properties. 

 

See section 6.5 Custom Properties for a full description of how to add, remove and modify 

Custom Properties. 

 

6.13.3 Links 

Links can be associated with Simple Requirements as well as with Projects. These provide 

ability to associate documents, graphics, URLs3 etc. with the Requirement. Click on the Links 

tab to access the Links associated with a Requirement. Links at the Requirement level work in 

exactly the same way as Project Links. See Section 6.3 Project/Requirement Links, for a full 

description. 

 

6.13.4 Notes 

Each Requirement can have an arbitrary number of Notes associated with it. To access these, 

click on the Notes tab. Requirement Notes are useful for storing miscellaneous 

issues/clarifications to do with any aspect of the Requirement. They work in exactly the same 

way as Project Notes. See Section 6.4 Project/Requirement Notes for a full description. 

 

6.14 Requirement Item List 

A Simple Requirement contains a list of zero or more Items. Items can be used to store any 

kind of information related to the Simple Requirement, for example data attributes, sets of 

required product features etc. 

For more detailed instructions on creating, deleting and manipulating Items, see Section 

11.15 Items Menu. 

 

                                           
3 Uniform Resource Locator, this is a reference to a website and is of the form „www.xyz.com‟ 
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7 Running Searches and Querying Projects 

Optimal Trace provides a comprehensive Querying capability.  

 

There are two core ways in which you can Query Projects. These are Simple and Advanced 

Query. 

Use the Simple Query to search for text within and across Projects.  

With advanced querying you can: 

 Create queries based on conditions with 'And' and 'Or' support in a Query Builder 

screen. You may want to display Requirements with High Technical Risk (query on a 

Requirement custom property called 'Tech Risk') or show all steps that need to be 

changed (querying on a custom property called 'Needs Change?') 

 Clicking any query result row auto-highlights the occurrence within the context of the 

loaded project for review. 

 Save Queries Locally 

 Share Queries with other Team members 

 View Query Results as Publishable Web Reports or Save the results to a text file 

To perform a query, click on the 'Query' tab or alternatively click on the  button in the Tool 

bar. This then brings up the query tab. 

 

7.1 Simple Query 

Use the Simple Query to search for text within and across Projects. The Search is performed 

on the currently selected project. 

Enter some text, e.g. „customer‟, to search for and then click on the 'Run' button. After a few 

moments, the search results appear. See Figure 34 - Running a Simple Query for 'Order' for 

an example of querying on the Search Text 'Order' and the attendant results. 

You can also click on the 'Clear' button. This results in the current result set being cleared 

from the Result List. 

The options available when running simple queries are outlined in Table 6 - Simple Query 

Options 

 

Table 6 - Simple Query Options 

Option Description 

Match Case This restricts the search to return only those results that match the case of 
the text typed into the search box. 

Match Exact This restricts the search to return only those results that match based on a 
complete match in the attribute, e.g. if the text that is being searched for is a 
partial match this would not be considered a match. 
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Search 

Repository 

Checking this option means that a full search is performed across the entire 

repository. 

Search All 
Loaded Projects 

Checking this option means that a full search is performed across any projects 
that are currently loaded. 
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Figure 34 - Running a Simple Query for 'Order' 

 

The Result columns and their meanings are outlined in Table 7 - The Query Result Columns 

 

Table 7 - The Query Result Columns 

Column Description 

Project The Project in which the found artifact lives (this is useful if you are searching 
across multiple Projects. 

Name The name of the element in the project where the match occurred. 

Attribute  The name of the attribute or property whose text matched the search 
criterion. 

Match The text that was matched is this is displayed, in red text. 
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Icon This icon denotes the type of matched element (e.g. Requirement, Actor, 

etc.). 

 

Clicking on a search result line highlights the matched Project element (Requirement etc.) in 

the context where it occurs. This provides an easy way to navigate straight to the results you 

are interested in. This facility is useful when reviewing a number of search results where you 

might want to update the Requirements for each result. In this context once a possible 

change is made, you can re-run the search and a revised set of results will appear. 

 

Note: Searching the Repository. It is quite possible that over a period of time, reusable 

elements can be identified in several different projects housed in the Optimal Trace Server 

repository. 

Typically there can be quite a degree of similarity between several projects in a given 

organization. There might for example be very similar login requirements etc. reflected as an 

'Authenticate' requirements. 

You may want to quickly 'bootstrap' new project initiates by reusing some previously defined 

requirements (either requirements or non-functional requirements). 

To facilitate this, Optimal Trace Enterprise allows searches across the entire repository and 

once project hits are encountered for a given search term, then you can load the project and 

copy/paste multiple elements from the found project(s). 

 

7.2 Advanced Query 

The Advanced Query capability allows you to build up more complex queries that filter 

elements in the project. 

Examples of the types of queries that you might create are: 

 Display all Requirements that are to be delivered in Increment 1 & 2 

 Show all Legal Non-functional requirements 

 Show Steps that that have no actors 

 

To enable Advanced Queries: 

 Click on the Query tab 

 Check the Advanced box 

 

You can create, edit, delete & share queries. 

 

7.2.1 Creating New Queries 

To create a new query click on 'New'. At this point the Query Builder screen appears. Every 

query is comprised of the Query Name and a collection of conditions that must be met. 

To add one or more conditions for the query: 

 Click on the Element List box 
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 Choose one of the elements. The list of elements is all queryable elements 

 Choose the attribute to be queried. The element chosen in the first step causes this list 

to be populated 

 Enter the condition to check. See Table 8 - Conditions for Advanced Queries for 

allowable conditions. 

 Specify the Value. For Custom Properties that are Bound the Value list box is 

populated with the values specified in the definition of the custom property. For the 

condition options 'isEmpty' and 'isNotEmpty' the Value field is disabled. 

 Click 'Add Condition' 

 

Once the condition is added you may also check the 'Match Case' or 'Match Exact' options. 

These behave in the same way as for simple queries and are described in Table 6 - Simple 

Query Options 

 

 

Figure 35 - Query Builder for Advanced Queries 

 

You can also build the query such that all the conditions are met ('And'), or only some of the 

conditions are met ('Or'). Leaving the 'Match All Conditions' box unchecked means 'Or' while 

checking it denotes 'And'. 

 

If conditions are added that make the query irresolvable then Optimal Trace will inform you 

with an appropriate message. Additionally, if you have a set of conditions and by checking 

'Match All Conditions' that query becomes irresolvable then you will be told with a specific 

reason for which condition makes the query invalid. 
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Table 8 - Conditions for Advanced Queries 

Condition Description 

Is The value must match the attribute in the element. 

IsNot The value must not match the attribute in the element. 

IsEmpty The attribute of the element must have no value. 

IsNotEmpty The attribute of the element must have some value. 

 

 

To remove a condition: 

 

 Select the Condition to be removed by clicking on it in the list of conditions 

 Click the 'Remove Condition' button. 

 

From the Query Builder screen you can also run the query directly. This allows you validate 

that expected results show for the query without having to dismiss the Query Screen 

completely. This is a convenience allowing you to make appropriate changes in the Query 

Screen. 

You can also Save or Delete the query by clicking the respective buttons. 

 

7.2.2 Editing Queries 

To edit a query: 

 

 In the Query tab, select the Query you want to edit from the list box. See Figure 36 - 

Selecting a Query for Editing or Deleting 

 click the 'Edit...' button 

 Add or Remove conditions as outlined in section 7.2.1 Creating New Queries 

 

 

Figure 36 - Selecting a Query for Editing or Deleting 
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7.2.3 Deleting Queries 

To delete a query: 

 

 In the Query tab, select the Query you want to delete from the list box. See Figure 36 

- Selecting a Query for Editing or Deleting 

 click the 'Edit...' button 

 Click the Delete button as shown in screen: Figure 35 - Query Builder for Advanced 

Queries 

 

7.2.4 Viewing the Query Results as an HTML Report 

You can View the results of the query in a Report format by clicking the 'View Results...' 

button. This creates a single page HTML file that shows the results. 

The Query Report is created as a file (HTML formatted) each time you click 'View Results...'. 

You can find this file located in the '<Optimal Trace Install Root>\projects\reports' sub-

directory. 

It has the format: <Query Name>_Output_Report_File.html. For example: 'High & Medium 

Priority Reqs_Output_Report_File.html'. 

A sample query report is shown in Figure 37 - Query Results as a HTML Report 

 

Tip: Sharing Query Results with Colleagues by e-mail. 

You can attach the <Query Name>_Output_Report_File.html file to a mail and send it to 

colleagues if you wish to highlight specific aspects of a project using a given query. 
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Figure 37 - Query Results as a HTML Report 

 

7.2.5 Saving the Query Results in a Text File 

You can save the results of the query into a CSV (Comma Separated Values) formatted Text 

file. Such Text files will open in MS Excel by default if you have this loaded on your system. 

To do this: 

 click the 'save Results...' button 

 Specify the name of the Text File. 
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8 Analyzing Traceability in Projects 

Optimal Trace Projects are comprised of Simple Requirements and Structured Requirements 

with scenarios, steps, items, branches and refinements.  You can access the automatically 

generated 'Traceability Tree' enabling tracing to all dependent elements either within or 

across packages/projects. 

Four types of Traceability relationships are allowed in Optimal Trace; Branches, Refinements, 

File Links & Optimal Trace Element Links. 

 

 Branches allow one step (sub-requirement) in a given project; branch either 

conditionally or unconditionally to a different step or Structured Requirement. For 

more on creating Branches see section: 11.13 Branches Menu 

 

 Refinements allow a given step, or item to be decomposed into a more detailed 

requirement either within the same package or across packages. For more on creating 

Refinements see section: 11.16 Refinements Menu 

 

 File Links mean that a given requirement can be linked to any number of associated 

file artifacts. For example, sample screenshots in the form of gif or jpg files, excel 

spreadsheets etc., Visio flows etc. can all be created as links. For more on creating File 

Links see section: 6.3.1 File & URL (web) based Links 

 

 Optimal Trace Element Links allow linking one element to another element either 

within/across a project(s). Examples of this kind of Link relationship include when Test 

Cases are linked back to associated Requirements: For more on creating Element Links 

see section: 6.3.2 Traceability Links 



 

 

86  Optimal Trace Enterprise User‟s Guide 

 

 

Figure 38 - Traceability Tree with suspect Links and Linked Screenshots 

 

Each Branch, Refinement & Link may have the following state which is visually indicated: 

 

Suspect Links Suspect Links are best understood with some examples. 

Example 1: if a Test has a Trace Link back to an original Requirement, then if someone makes 

a change to the requirement then the link from the test will be marked as suspect.  

Example 2: if a screenshot is linked to a given requirement and the screenshot is altered then 

the link is marked as suspect 

The next sections outline the options that are available in the Traceability Tree. 

 

Trace State Description 

Not Suspect This means that the branch, refinement or link is more recent than 

any part (any sub-component) of the element that is 'Linked To'. 

Suspect This means that the branch, refinement or link is less recent than any 

changes in any aspect of the element that is 'Linked To'. 

Unknown This means that the 'Linked To' element is currently not loaded and 

the element text is reflected as a light Grey. To load the element, 

double-click on it. 

Unresolved NOTE: Only applicable to file based links. This means that the 'Linked 

To' file is not found and is marked in red. 
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8.1 Refreshing the Trace Tree 

By clicking the  button you can refresh the contents of the Traceability Tree. This re-loads 

all currently loaded projects and gets the most up to date state of the elements from a 

Traceability perspective. 

 

8.2 Navigating the Trace Tree & Loading Projects 

Navigating to the Previous and Next Suspect Link(s) is done by clicking the and  buttons 

respectively. 

Where cross-project traces links exist you can automatically load the traced to element (& 

project if not already loaded) by double clicking the link in the Traceability Tree. 

 

If the 'Traced to' element is a file, Optimal Trace will resolve the link and invoke the 3rd party 

tool where possible. The underlying associations in Windows are used to resolve the 

appropriate tool to use and launch. 

 

8.3 Inspecting & Clearing Suspect Links 

As mentioned previously, Suspect Links mean that some change has occurred in the element 

being pointed to. Such changes may be relatively benign. In order to examine the nature of 

the changes made (making the link suspect), click on the  button. 

In this instance you are presented with a Changes screen. This displays the detail of all 

changes made either since the link was created or else since it was last cleared of its suspect 

status. 

An example changes screen is shown in Figure 39 - Viewing Changes for a suspect element 

As well as viewing the specific changes that make the element 'suspect' you can also save the 

list of changes as a Text file by clicking the 'Save as' button. 
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Figure 39 - Viewing Changes for a suspect element 

 

Once you have reviewed the changes you may clear either one or all suspect links. This is 

done by either clicking the  or the  button respectively. 

Once you clear the suspect status, the element is locked to avoid conflict & multiple people 

editing status at the same time. See 18.2 Concurrency and locking for more on Optimal Trace 

Locking. 

 

 

Note: Viewing Traceability for single elements. Select the element in the tree area and 

click on the  button. This brings up a Traceability Screen for the selected element. 

 

 

Note: Trace Tree performance for large projects. If a project has a large number of 

suspect links, displaying these in the Trace Tree can have a negative impact on performance. 

The default.properties file in the installation folder of Optimal Trace Enterprise contains a 
setting called 'maxDisplaySuspectLinks'. This is by default set to 5000. The trace tree will stop searching 
for suspect links once it has reached the number specified by this setting. Additionally it will ask the user if 
they wish to expand all these suspect links, as doing so may take a significant amount of time. 

 

 

 



 

 

89  Optimal Trace Enterprise User‟s Guide 

 

9 Edit Menu 

Use this menu for editing purposes. 

 

 From the Menu bar, click on Edit 

 Select any of the options described under the sections below. 

 

9.1 Copy/Paste Options (within and across Projects) 

Use these options to copy or paste elements within and across Projects. Specifically, you can 

copy and paste the following: 

 

 Actors 

 Glossary Items 

 Packages 

 Structured Requirements 

 Steps 

 Simple Requirements 

 Items 

 

For example, to copy Actors and Glossary items within the Actor or Glossary screen: 

 

 Select the specific Actor or Glossary item by clicking on the row button to the left of 

the item as in the sample screen in Figure 40 below. 

 

 

Figure 40 - The Glossary screen for copying 

 

Once you have highlighted the Actor or Glossary entry: 

 

 Click on the now enabled Copy button  to copy the item to the „clipboard‟. 

 Click on the Paste button  in the Tool bar and a new entry is placed in the table of 

entries. 

 



 

 

90  Optimal Trace Enterprise User‟s Guide 

 

Copying of Structured Requirements, Steps, Simple Requirements and Items is very similar to 

Actors and Glossary items.  

 

 Select the Requirement or Step/Item by selecting it in the Tree View of one of the 

other available views. 

 Click the Copy button and then paste into the appropriate destination. 

 

If you have multiple Projects loaded, you can also paste from one Project into another. This 

applies to all of the above „copyable‟ elements; see Section 9.1 Copy/Paste Options (within 

and across Projects), for details. 

 

9.2 Multiple Copy/Paste 

To copy multiple requirements, packages, steps or items you need to initially select multiple 

elements. 

Optimal Trace uses the standard MS Windows keys to support multiple select. There are two 

mechanisms for selection. To select a range of adjacent requirements or packages, select the 

beginning element in the tree and then while holding down the 'Shift' key select the ending 

requirements that you wish to copy. All requirements or packages in between the initially 

selected element and final element are marked for copy. Once the elements are selected then 

paste into the desired new location. 

Alternatively to copy non-sequential single elements use the CTRL key while selecting each 

desired element and paste as per normal. 

Requirements or packages can be copied within the current project or into another project. 

 

Note 1: Shortcut Keys 

As well as the copy and paste buttons mentioned in this section, you can also use the 

standard Windows copy and paste shortcut keys: 

 

 Copy - hold down Ctrl and hit C, or Hold down Ctrl and hit Ins (Insert) 

 Paste - hold down Ctrl and hit V, or Hold down Shift and hit Ins (Insert) 

 

Note 2: Copying with Custom Properties 

In general when copying from one project to another, or one package to another, if there are 

Custom Properties associated with the element to be copied then the custom properties are 

only copied over if they are also defined in the destination. All other standard attributes of the 

copied element are copied. 

The exception to this rule is when the object you are copying is a package. In this case, if 

there are custom properties defined on the package then the package is pasted keeping its 

custom property structure. In this case the Package Custom Property setting on the 

destination will have the 'Share' attribute unchecked. For more on Custom Properties and 

sharing see section 6.5 Custom Properties 
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Note 3: Multiple copy of Steps and Items 

Optimal Trace supports multiple copying of steps and items. In this instance however the 

steps or items to be copied must be contiguous and individual selection with CTRL + C is not 

supported. 

 

9.3 Copy as Link (URI) 

To establish Traceability Links within or across projects you ordinarily use the Add New Trace 

Link functionality. See section 6.10.4 Links for more on creating Trace Links. 

There is however an alternative way to copy unique links to Optimal Trace elements. This is 

through the 'Copy as Link' option. 

This creates the 'trace to' element reference id and copies it to the clipboard. This means that 

you now have a unique reference to the element. 

To copy the reference to the clipboard, right-click on the specific element in the Tree. This will 

bring up a popup menu as shown in Figure 41 - Copy as Link Option. Then click the 'Copy as 

Link (URI)' menu. 

 

 

Figure 41 - Copy as Link Option in the 'popup' menu 

 

Note: Invoking on Optimal Trace from any 3rd party environment is possible using copied 

references. For example if you embed the copied link reference as a link in a web page, then 

clicking that reference will resolve back to the specific element in Optimal Trace. Similarly, 

any 3rd party tool that supports Invocations can make references back to Optimal Trace up in 

the same fashion. 

To see an example of this, see the generated HTML pages from the Traceability Report. See 

section 12.5 Generate Reports Option for more detail on the Traceability Report. 

 

9.4 Search Option 

Hitting the Search button brings up the Query tab. See section: 7 Running Searches and 

Querying Projects for full details on running Simple and Advanced Queries. 

9.5 Undo/Redo Options 

Use these options to undo/redo any actions you make, before saving.  

 

 Click on Edit, then Undo/Redo, and Optimal Trace™ Enterprise will undo/redo your last 

action. 

 



 

 

92  Optimal Trace Enterprise User‟s Guide 

 

10 View Menu 

The View menu provides a set of capabilities to alter the graphical views displaying in Optimal 

Trace. 

Use this menu to view a Package‟s or Packages‟ Requirements in different views. 

 From the Menu bar, click on View 

 

10.1 Show/Hide Columns Option 

Use this option to select specific columns to be visible while editing the project. This allows 

you to focus on the specific columns that may be of interest at a given time during analysis. 

The following project elements may be made visible/invisible. 

 Non-functional Requirements 

 Steps 

 Items 

 Actors 

 Glossary 

 

 Select this option by clicking on the  button. 

 

The screen shown in Figure 42 - Show-hide Columns appears and clicking the checkbox 

adjacent to the specific column entry makes that entry visible or invisible. 

Note that the Step and Item tab will contain any Custom Property columns that apply to the 

part of the project that you have currently selected in the tree. 
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Figure 42 - Show-hide Columns 

 

10.2 Show Current Package Contents Option 

Use this option to view the most recently selected Package in your Project. 

 

10.3 Show Current and Sub-Package Contents Option 

Use this option to view the most recently selected Package, and the contents of all of its sub-

Packages, in your Project. 

 

10.4 Show Contents of all Packages Option 

Use this option to view the Requirements contained in all Packages, in your Project, 

regardless of which Package you have currently selected. 

 

10.5 Show Cross Package Branches and Refinements Option 

Use this option only when you have selected either one of the options described in Sections 

10.1 and 10.3 above. 

 

10.6 Expanding and Collapsing Requirements 

During a requirements session you may find that you are building Requirements with large 

numbers of scenarios and Steps, or a large number of Items. Optimal Trace™ Enterprise 

provides a facility for adjusting the way Requirements are displayed in the Requirement map. 

When you create Requirements, they are shown fully expanded in the Requirement Map by 

default. In other words, in the case of Structured Requirements they show all scenarios and 

all Steps, and in the case of Simple Requirements they show all Items. A sample set of 

Requirements looks like this: 
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Figure 43 - Sample set of fully expanded Requirements 

 

To collapse all Structured Requirements: 

 

 Right click on the Requirement Map and click Hide All of the Steps in Requirements. 

 

This will collapse the Requirements for a more manageable view. A collapsed view allows a 

more convenient way of traversing the set of Requirements and highlighting specific ones for 

which you can see the detailed scenarios etc. 
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To collapse all Simple Requirements: 

 

 Right click on the Requirement Map and click Hide All of the Items in Requirements. 

 

 

Note: You can also select a specific Requirement to expand by either double clicking on the 

Requirement title or else clicking on its  button. 
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Figure 44 - Sample set of fully collapsed Requirements 
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11 Requirements Menu 

This allows you create, edit delete Packages, Structured Requirements and associated 

Scenarios and Steps, and Simple Requirements and associated Items. Additionally you can 

move and reposition both Packages and Requirements and all associated convenience 

capabilities such as Renumbering etc. 

 

11.1 New Structured Requirement Option 

Use this option to define a new Structured Requirement. The first stage in defining a 

Requirement is to choose a Package in which to house the new Requirement. 

 

 Select a Package by clicking on its icon in the Project‟s Tree View .  

 

If you have not defined any Packages, select the default „Requirements‟ Package. 

 

Having selected a Package, you can create a Structured Requirement: 

 

 Click on the  button in the Tool bar. 

 

11.2 New Simple Requirement Option 

Use this option to define a new Simple Requirement. The first stage in defining a Requirement 

is to choose a Package in which to house the new Requirement. 

 

 Select a Package by clicking on its icon in the Project‟s Tree View .  

 

If you have not defined any Packages, select the default „Requirements‟ Package. 

 

Having selected a Package, you can create a Simple Requirement: 

 

 Click on the  button in the Tool bar. 

 

 

11.3 Delete Requirement Option 

Use this option to delete a Requirement. This will delete the Requirement currently selected, 

be it a Structured Requirement, or a Simple Requirement. 
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 Select the Requirement in the Tree View and click on the  button. 

 

If the Requirement has Steps or Items you will be prompted to confirm the deletion. See 

sections 11.14 Steps Menu, and 11.15 Items Menu for details about Steps and Items.  

 

11.4 Multiple Requirement Deletion 

To delete multiple requirements or packages you need to initially select the requirements 

and/or packages within the Tree. 

Optimal Trace uses the standard MS Windows keys to support multiple select. There are two 

mechanisms for selecting. To select a range of adjacent requirements or packages, select the 

beginning element in the tree and then while holding down the 'Shift' key select the ending 

requirements that you wish to copy. All requirements or packages in between the initially 

selected element and final element are marked for deletion. Once the elements are selected 

then hit the delete button. 

Alternatively to delete non-sequential single elements use the CTRL key while selecting each 

desired element and delete as per normal. 

11.5 New Package Option 

Use this option to create a Package. 

 

 Click on the  button in the Tool bar. 

 

11.6 Delete Package Option 

Use this option to delete a Package. 

 

 Select the Package in the Tree View and click on the  button. 

 

If the Package contains sub-Packages or Requirements you will be prompted to confirm the 

deletion. 

11.7 Multiple Package Deletion 

To delete multiple requirements or packages you need to initially select the requirements 

and/or packages within the Tree. 

Optimal Trace uses the standard MS Windows keys to support multiple select. There are two 

mechanisms for selecting. To select a range of adjacent requirements or packages, select the 

beginning element in the tree and then while holding down the 'Shift' key select the ending 

requirements that you wish to copy. All requirements or packages in between the initially 

selected element and final element are marked for deletion. Once the elements are selected 

then hit the delete button. 

Alternatively to delete non-sequential single elements use the CTRL key while selecting each 

desired element and delete as per normal. 
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11.8 Renumber Requirements Option 

Use this option to renumber your Requirements. During the course of the requirements 

gathering phase, it is important to maintain the consistency of each Requirement‟s number. 

In the course of your work, new Requirements are added and existing Requirements are 

deleted. 

Optimal Trace™ Enterprise will recycle deleted Requirement numbers, for example if you 

delete a requirement SR4 from a project containing the requirements SR1, SR2, SR3, SR4 

and SR5, the next requirement created will be created as SR4. 

Over time you may want to consolidate the numbering, perhaps prior to a Project being 

baselined. See Section 5.4 About Baselines for more on baselining projects. 

When renumbering is applied, all of the Requirements across all the Packages in the Project 

are numbered according to the current numbering policy. (See section 6.6.2 Numbering Policy 

Settings for more on Project Numbering Policies). If any Simple Requirements have been re-

numbered, their Items will also be renumbered to reflect the new Simple Requirement 

number. 

To apply renumbering to a Project: 

 

 Click on the  button. 

 

Since renumbering is an occasional activity and considering the implications of renumbering, 

Optimal Trace™ Enterprise prompts you for confirmation of this action. Once you confirm, the 

renumbering is applied to all Requirements. 

 

Note: Renumbering of scenarios is handled automatically within Optimal Trace™ Enterprise 

and no gaps are allowed to appear when deleting scenarios; see Section 11.17 Scenarios 

Menu for more details on scenarios. 

 

11.9 Move Requirement and Move Package Option 

Use this option to move Requirements and Packages elsewhere in the Project or to other 

Projects. There are two ways in which you can move Requirements and Packages: drag and 

drop or by clicking buttons on the Tool bar. 

 

 Drag and drop: 

o In the Tree View Click on the Requirement or Package that you want to move. 

o Drag the Requirement or Package to the new location by holding down the 

mouse button at which point the cursor will change to  (move Requirement) 

or  (move Package). When you are at „move-to‟ location in the tree, let go 

the mouse button and the Requirement or Package will be placed at that 

location. 
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 Using the Tool bar: 

o Click the Requirement or Package that you want to move.  

o On the Tool bar click on the  button (to move a Requirement) or the  button 

(to move a Package) whereupon the screen shown in Figure 45 below will 

appear. 

o Select the specific Package that you want to move the Requirement or Package 

to and click on the Apply button. 

 

Note: Moving and Custom Properties. When moving from one project/package to another 

where Custom Properties are associated with the element(s) to be moved, the custom 

property values are only moved if the Custom Properties are defined in the destination. 

The one exception to this rule is when the element being moved is a package. In this case 

when the package is moved, all the custom property values are moved, and the package 

becomes and orphan (un-shared) if it‟s custom property definitions are different than that of 

its new parent. 

 

11.10 Multiple Requirement or Package Moves 

To move multiple requirements or packages at the same time you need to initially select the 

requirements or packages within the Tree. 

Optimal Trace uses the standard MS Windows keys to support multiple select. There are two 

mechanisms for selecting. To select a range of adjacent requirements or packages, select the 

beginning element in the tree and then while holding down the 'Shift' key select the ending 

requirements that you wish to move. All requirements or packages in between the initially 

selected element and final element are marked for moving. Once the elements are selected 

then follow the normal procedures outlined above for moving either using the drag and drop 

technique or using the toolbar button option. 

Alternatively to move non-sequential single elements use the CTRL key while selecting each 

desired element and move as per normal.
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Figure 45 - The Move screen – to the right above, titled ‘Move Requirement To Another Package’ 

 

Note: Moving and Locking. When moving requirements you acquire an explicit lock on the 

package that contains the Requirement. This is because you will be changing the explicit 

structure of the Package on moving. See section 18.3 Optimal Trace Locking Rules for the full 

list of locking rules. 

 

11.11 Reposition Requirements… Menu 

When you add a new requirement into a package, that requirement is positioned at the end of 

the current list of requirements. It is possible that you may want to re-sequence or re-order 

the requirement over the lifecycle of the analysis phase or beyond. 

To reposition a given requirement, first select that requirement in the tree. Now click the  

button in the toolbar or click the 'Reposition Requirements…' menu option. You can now 

reposition the requirement within the package by using the up and down arrows. 
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Figure 46 - Repositioning a requirement in a package 

 

11.12 Reposition Packages… Menu 

When you add a new package as a sub-package, that package is positioned at the end of the 

current list of packages. It is possible that you may want to re-sequence or re-order the 

packages over the lifecycle of the analysis phase or beyond. 

To reposition a given package, first select that package in the tree. Now click the  button in 

the toolbar or click the 'Reposition Packages…' menu option. You can now reposition the 

package with respect to its sibling packages by using the up and down arrows. 

 

11.13 Branches Menu 

Use this menu to branch from Step to Step and from Step to a Structured Requirement. 

In addition to branches within a given Structured Requirement, Optimal Trace™ Enterprise 

allows branching between Structured Requirements. The mechanism to branch to another 

Structured Requirement is very similar to that used for branching to Steps: 

 

 Click on the Step that the branch originates from. 

 From the Menu bar, click on Requirements 

 Click on Branches 

 

Branches are denoted in Optimal Trace with a directed arrow. The Arrowhead indicates the 

Step or Structured Requirement that is being branched to. 
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11.13.1 Create a New Branch Option 

Use this option to: 

 Branch from a Step to an existing Step/Structured Requirement or  

 To branch from a step and implicitly create a new structured requirement while 

branching. 

In the case of 'Withdraw Cash' for example, a branch might occur when a customer requests 

a certain amount from the ATM and sufficient funds are not available. Another example is if 

an incorrect multiple of currency notes has been entered (typically only multiples of 20 are 

handled by many ATM machines). 

To create a branch: 

 

 Click on a Step (either in the Flow Diagram or the Requirements Map) that you want 

the branch to originate from. 

 Now click on the  button in the central vertical toolbar adjacent to either the Flow 

Diagram or Requirements Map and the screen in Figure 47 below will appear. 

 

 

Figure 47 – Create New Branch screen 

 

The Figure 47 – Create New Branch screen shows each of the scenarios within the Structured 

Requirement and highlights the particular Step where your branch will go to in order to 

complete the branching. 
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If you want to create a new Structured Requirement to branch to, click the 'New Requirement' 

button. This will result in the new Structured Requirement being created and selected as the 

branch destination.  

A condition that causes the branch to occur can also be specified if appropriate. 

A conditional branch is depicted by a diamond box connected to the Step that is branching, 

with the condition displayed adjacent to the connecting line. A conditional branch is indicated 

by clicking the 'Conditional Branch' checkbox.
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Figure 48 – Branching to a Step with condition 

 

If you do not branch with a condition then no diamond is shown, instead a line is drawn 

directly from the originating Step to the destination Step. 

 

11.13.2  Edit Branch Option 

In order to edit the details of a branch you first select the branch line in either the Flow 

Diagram or Requirements Map. Do this by clicking on the line at which point the line is colored 

red. See Figure 49 - Selecting a Branch for Editing for an example of a selected branch. You 

may either edit the branch details in the bottom left branch detail area or by clicking the 

'Requirements >> Branches >> Edit Branch…' menu option 
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Figure 49 - Selecting a Branch for Editing or Deleting 

 

11.13.3  Delete Branch Option 

Use this option to delete the selected branch. In order to delete a branch you must select the 

branch line either in the Flow Diagram or Requirements Map. See Figure 49 - Selecting a 

Branch for Editing for an example of a selected branch. 

 

11.14 Steps Menu 

Use this menu for manipulation of Steps (sub-requirements). Each scenario is composed of a 

number of Steps. Each individual Step is a single step of the action required to complete a 

Structured Requirement; together, fulfilling all of the Steps in a Structured Requirement 

results in the scenario being completed. Note the Steps menu is only visible when a 

Structured Requirement is selected in tree. 

 

 

 From the Menu bar, click on Requirements 

 Click on Steps 

 

Each Step has the following attributes: 

 

 The Actor that is starting or initiating the Step (e.g. „customer‟) 

 The Name of the Step (e.g. „insert ATM card‟) 
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 A detailed description of the Step. 

 

The Main Success Scenario of Withdraw Cash might contain Steps such as: insert ATM card, 

prompt for PIN, enter PIN, validate PIN, choose account type etc. 

The scenarios and Steps appear in the textual representation of Optimal Trace™ Enterprise, 

as shown in Figure 50 below. 

 

 

Figure 50 - Scenarios and Steps 

 

11.14.1  Step Custom Properties 

Custom properties can be defined for Steps. 

 

This means that each Step can be set up to hold associated data. 

 

Custom Properties can be set as either freeform or 'bound', the latter meaning you can select 

from one of a list of predefined values. Step Level Custom Properties behave in exactly the 

same way as Project Level Custom Properties. 

 

Clicking the  button in the toolbar to the right of the scenario brings up the Custom 

Property editor screen. 

 

See section 6.5.1 Implications for a full description of how to add, remove and modify Custom 

Properties. 

 

11.14.2 Add Step Option 

Use this option to add a new Step to a Requirement. To this, click the  button. 
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11.14.3  Delete Step Option 

Use this option to delete the selected Step from a Requirement. To this, click the  button. 

 

11.14.4  Move Step Up/Down Options 

Use this option to move the selected Step up or down one position at a time in a 

Requirement. Effectively you are re-ordering the steps in the given scenario. To move steps, 

click either the Up or Down Arrow buttons.  

Note: When you move the step, both the graphical area in the Flow Diagram and the Textual 

areas are kept in lockstep. 

 

11.15 Items Menu 

Use this menu for manipulation of Items. Each Simple Requirement is composed of a number 

of Items. Each individual Item can describe some piece of information that complements the 

Simple Requirement. Note the Items menu is only visible when a Simple Requirement is 

selected in tree. 

 

 From the Menu bar, click on Requirements 

 Click on Items 

 

Each Item has the following attributes: 

 

 The Name of the Item 

 A detailed description of the Item 

 

 

11.15.1 Item Custom Properties 

Custom properties can be defined for Items. 

 

This means that each Item can be set up to hold associated data. 

 

Custom Properties can be set as either freeform or 'bound', the latter meaning you can select 

from one of a list of predefined values. Item Level Custom Properties behave in exactly the 

same way as Project Level Custom Properties. 

 

Clicking the  button in the toolbar to the right of the item list brings up the Custom 

Property editor screen. 

 

See section 6.5.1 Implications for a full description of how to add, remove and modify Custom 

Properties. 
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11.15.2 Add Item Option 

Use this option to add a new Item to a Requirement. To this, click the  button. 

 

11.15.3  Delete Item Option 

Use this option to delete the selected Item from a Requirement. To this, click the  button. 

 

11.15.4  Move Item Up/Down Options 

Use this option to move the selected Item up or down one position at a time in a 

Requirement. Effectively you are re-ordering the items in the given item list. To move items, 

click either the Up or Down Arrow buttons.  

 

11.15.5 Renumber Items 

Use this option to renumber the Items in the item list sequentially. Moving items up/down can 

cause the item numbers to get out of sequence. Clicking on the  button will renumber the 

items. 

NOTE: Over a period of time, certain items may get removed. In this case when adding new 

items the new item number will be set to the maximum possible number available, allowing 

holes to develop in the numbering. This is deliberately done to preserve continuity of number 

especially when a broader team is receiving the requirements and used to associating a 

certain item number.  

 

11.16 Refinements Menu 

Use this menu for refinements purposes. Typically many initial Project requirements are high 

level, e.g. one-line descriptions of some key functionality. We encourage these types of 

requirements to be captured as 'Simple Requirements' as they provide an invaluable audit 

trail especially when the Project requirements are later altered or represented as detailed 

Structured Requirements associated through refinement. 

The „Refinement‟ concept in Optimal Trace™ Enterprise allows high-level requirements 

(perhaps Simple Requirements with one or two Items) to be detailed to a greater degree of 

precision while maintaining the original requirement with no change. 

When defining Refinements you can refine across Packages. It is common that Requirements 

at one 'level' might exist in a dedicated package with a given 'Tag' thereby marking these 

requirements as being at that level. The refined to requirements might exist in a second 

dedicated package with their own Tag. (See section 6.9.2 Package Tags for more on Package 

Tags.) For an example of a Project Template that uses this approach, see the 'Feature Driven 

Development' template in section 5.1.2 About Project Template 

 From the Menu bar, click on Requirements 

 Click on Refinements 
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The Refinement Links a Step or Item at one level to more detailed Requirements (Simple or 

Structured Requirements). Refinements are denoted by solid grey straight lines connecting 

the Step or Item to the refined Requirement. 

 

11.16.1  Create a new Refinement Option 

Use this option to: 

 refine from a Step or Item to an existing Requirement or  

 refine from a Step or Item and implicitly create a new requirement while refining. 

In the case of the Item 'Order' in the 'Order System' demo for example, a refinement 

relationship occurs between Order and Line Item, indicating that the Order contains the Line 

Item. Multiple Refinement Links can be created to a given Structured or Simple requirement. 

To create a refinement: 

 

 Click on a Step or an Item in the Requirements Map view. This will be the step/item 

that 'refines'. 

 Now click on the  button in the central vertical toolbar adjacent to Requirements 

Map and the screen in Figure 51 – Create New Refinement screen will appear. 

 

 

Figure 51 – Create New Refinement screen 

 

The Figure 51 – Create New Refinement screen shows each of the packages and requirements 

where you can refine to. 
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If you want to create a new Requirement to refine to, click the 'New Requirement' button. 

This will result in the new Requirement being created and selected as the refined to 

requirement. 

 

11.16.2  Delete Refinement Option 

Use this option to delete an existing Refinement. To do this, first select the refinement that 

you want to delete by clicking on it in the Requirement Map. Once selected, the refinement 

line changes to a red color. Now click the  button. 

When you click the delete refinement button you may also delete any refined to 

Requirements. 

 

 

Figure 52 - Prompt for deletion of refined Requirements 

 

11.16.3  Refine Requirement Option 

Use this option to create a new refinement to another Requirement when there is no sub-step 

or item already created on the 'refining' Requirement. This is a convenience option that: 

 creates a new step or item in 'refining' Requirement 

 creates the refinement relationship from that new step or item to the 'refined to' 

Requirement. 

 

11.17 Scenarios Menu 

Use this menu for scenario purposes. 

 

 From the Menu bar, click on Requirements 

 Click on Scenarios 

 

11.17.1  Create New Scenario Option 

Use this option to create an Alternative Scenario in a Structured Requirement. Alternative 

scenarios provide an optional series of Steps to the Structured Requirement‟s Main Success 

Scenario.  This is why they are referred to as an Alternative Scenarios. 

 

11.17.2  Delete Scenario Option 

Use this option to delete an Alternative Scenario. 
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11.18 Reposition Scenarios… Option 

When you add a new scenario into a Structured Requirement, that scenario is initially 

positioned at the end of the current list of scenarios. From time to time, you may want to re-

sequence or change the order of the alternative scenarios over the lifetime of the analysis 

phase. 

To reposition a given scenario, first select that scenario by clicking on the relevant scenario 

tab. Now click the  button in the toolbar or click the 'Reposition Scenarios…' menu option. 

You can now reposition the scenario within the requirements by using the up and down 

arrows. 

 

Figure 53 - Repositioning a scenario in a requirement 
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12 Generation Menu 

Use this menu for document generation purposes. 

 

 From the Menu bar, click on Generation 

 

During the requirements gathering phase of a Project, formal documentation is typically 

required for customer sign off. Several versions of a requirements document may be required 

prior to final sign off of a Project, and indeed an updated version may well be required after 

„final‟ sign off due to subsequent changes to requirements. 

Requirements documents are often the home of data that stems from multiple sources; so 

managing requirements documents can be a major challenge. Ideally, changes within the 

requirements document should be preserved as the document evolves. Using traditional 

techniques, this type of auditing is difficult to accomplish, particularly when it must be 

coordinated across a large team. 

Optimal Trace™ Enterprise facilitates generation of Microsoft Word documents, preserving 

non-Optimal Trace™ Enterprise data within these documents. Optimal Trace™ Enterprise also 

facilitates round tripping of changes made to Optimal Trace™ Enterprise data within these 

same word documents, back into the Project. 

 

12.1 Generate Requirements Document Option 

Use this option to generate requirements documents in Microsoft 2000, 2003 and 2007 

formats; see Sections 13.1.1 Tool Settings, and 14 Tools Menu, for details. 

To generate a Word document detailing requirements using Optimal Trace™ Enterprise: 

 

 Click on the  button, and the Document Generation screen will appear, see Figure 54 

below. See Table 17 below, for details. 

 

Note: When you generate MS Word 2000, and 2003 documents, you should set the following 

options in your copy of MS Word. 

 

 On the Tools menu, click Macro, and then click Security to open the Macro Security 

dialog box. 

 Select either Low or Medium security level. 

 On the Trusted Sources tab, click to turn on both the "Trust access to Visual Basic 

Project" and "Trust All Installed Add-Ins And Templates" checkboxes. 

 Click OK to apply the settings.  

 

When you generate MS Word 2007 documents you to configure MS Word 2007: 
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 Click on the Office Button, select 'Word Options', hit 'Save' and then set 'Save files in 

this format' to ' Word Macro-Enabled Document Format (.docm)'. 

 Click on the Office Button, select 'Word Options', select 'Trust Center', select 'Settings', 

select 'Trusted Locations' and add the '<OT APP Data>\docgen\vba' as a new trusted 

location. 

 Click on the Office Button, select 'Word Options', select 'Trust Center', select 'Settings', 

'Macro Settings', and select 'Disable all macros except digitally signed macros'. 

 Select the Office Button, select 'Word Options', select 'Trust Center', select 'Settings', 

select 'Developer Macro Settings' and tick 'trust access..' 

 

Note: Document Generation Issues. Microsoft has in the most recent versions of Word 

defaulted the trust and other security settings to high. If you have any difficulty generating 

document you can find a full checklist for diagnosing issues at: 

http://frontline.compuware.com/products/ci/ 

Optimal Trace has the ability to ignore custom property errors that arise during document 

generation. These errors occur when custom properties in the template and the project do not 

match. In previous releases, document generation stopped when it encountered 

inconsistencies in custom properties between the template and the project. In this release, 

users have the option to ignore the errors in order to proceed with the documentation 

generation process. Users can then view the errors and trace their location to the 

corresponding table. An empty token appears in the document where the error occurred. See 
13.1.1 Tool Settings for more information about ignoring custom property errors. 

http://frontline.compuware.com/products/ci/
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Figure 54 - Document Generation screen 

 

The Document Generation screen shows the available set of document profiles (collections of 

document templates used to format the generated document), and allows you to select the 

one you want to use for document generation. When you select a profile Optimal Trace™ 

Enterprise automatically suggests a file name, which is created by appending the profile name 

to the Project name. You can override this default suggestion by explicitly specifying a 

document name yourself. 

These other options are available when generating: 

 Automatically Generate Custom Properties. Check this box if you have a project 

that has Custom Properties and wish for them all to be added automatically. If the 

selected Document Profile has already been customized to have some Custom 

Properties included, then this option will only add the ones that are missing. See 

section 13.5 Outputting specific Custom Properties in Documents for more on 

customizing document profiles with Custom Properties. 

 Generate Partial Project. Check this box if you wish to generate a given package 

from the current project. If you check this box then a selection screen will appear 

when you generate allowing you to select the specific package. 
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 Expand File Links in Documents. Check this box if you wish to expand all file links 

in the generated document. For more on creating File Links see section: 6.3.1 File & 

URL (web) based Links. The types of files to be expanded are based on a list of file 

extensions as specified in the Optimal Trace Tool Options. See section: 13.1.1 Tool 

Settings for more on how to configure this. 

 Add Document Link to Project.  When a document is generated Optimal Trace can 

also automatically insert a project level link to the generated document. If you do not 

wish to automatically create this link uncheck the 'Add Document Link to Project (locks 

the project)' option. The impact of adding a project link is that the project element 

acquires a lock. See Section 18.3 Optimal Trace Locking Rules for more on locking 

rules. 

 Remove Hidden Text.  When a document is generated Optimal Trace inserts hidden 

text surrounding the document content. This is used by Optimal Trace to identify 

project elements within the document when the document is being updated from 

Optimal Trace or reversed into Optimal Trace. Additionally, on normal generation 

certain Word Macros are inserted into the generated document. These power the 

custom menus in documents used for reversing documents. Using this option will 

remove all this hidden tag/text information from the document. It will also not include 

the macros thus making the document free of any markup. This will reduce the 

document size. 

Note: Removing Hidden Text is recommended if you never intend on using reversal of 

documents or if your audience is high level and you are concerned about not being 

able to open the documents due to security settings etc. By removing the text reversal 

of documents is not possible 

 

 Click on the Generate button to produce the document. 

 

If you attempt to generate a document with a name that already exists, Optimal Trace 

informs you of this and gives you the option of either overwriting the old document or 

specifying a different name. 

You can cancel document generation by pressing the Cancel button on the progress screen. 

When the document is created, a File Link to the document is automatically inserted into the 

Project‟s Links area, assuming the above 'Add Document Link To Project' option was selected. 

See Section: 6.3.1 File & URL (web) based Links, for more details on Project Links. 

 

Note: A note on Forms Documents 

What are Microsoft Word Forms? 

These are Word documents where only certain areas are editable. In Optimal Trace's case, 

these editable areas will generally consist of data values originating from the Project. 

Why would I use them? 

To protect against accidental damage to the hidden XML tags in Optimal Trace generated 

documents. In particular, we would recommend these types of documents for non technical 

users who wish to edit Optimal Trace documents and then reverse these changes back in to 
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the Optimal Trace project. As long as they keep the document Protected (see the Optimal 

Trace menu), they can safely edit the data fields without fear of doing any damage. 

Are there any issues involved in using Word Forms? 

1. Navigation is different. Press TAB or Page Down to move from form field to form field. 

2. Clickable hyperlinks don't work, so clicking on an external link won't do anything. Neither 

will clicking on the Table of Contents, which can be annoying but is default Word behavior. 

However if the document is unprotected first, via the Optimal Trace menu, then links start 

working. 

3. Many of the common Word facilities, such as Search, won't work until the document is 

unprotected. 

4. Sometimes, when tabbing through the form fields in a documents, the focus & cursor seem 

to disappear. If tab is pressed a few more times, it comes back. The reason for this is that 

there are hidden form fields in some areas in the Optimal Trace document, for instance the 

Branches table is completely hidden but contains form fields.  If 'Toggle Hidden Text' is 

selected from the Optimal Trace menu, it is clear what is going on. 

All these points are as per Microsoft Word design and are beyond Optimal Trace control. 

What profiles in Optimal Trace generate Forms documents? 

Default Form, Default No Images Form, Overview, and Change History. 

 

12.1.1 Launching the document after generation 

When you generate the MS Word document you can automatically launch MS Word with the 

generated document open. To do this, just click the 'Open' button when generation is 

completed. This will start MS Word and you can view or edit the document in Word. 

12.2 Update Requirements Document Option 

Use this option to update a document you previously created, e.g. to reflect changes you may 

have made to the Project. A list of generated documents will appear, see Figure 55 below.  

Note: Partial Documents cannot be updated. 

Note 2: Custom Properties are „Read Only‟ in terms of Document Generation. This means 

that changes to Custom Properties (add, remove or edit) will not work for updating the 

document. Changes to existing Custom Property values will be updated. 

 Choose the document you wish to update and click on the Select button. 
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Figure 55 – List of documents generated 

 

Note: It is important that you update the correct document. If Optimal Trace™ Enterprise 

detects that the document you‟ve selected was not originally generated from this Project then 

it will inform you of this and prompt you to select a different document. 

 

If Optimal Trace™ Enterprise encounters a problem during the document update an error 

screen will appear, like the one shown in Figure 56 below. 
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Figure 56 - Update Document Error screen 

 

Optimal Trace will attempt to locate the error in the document when you click the '…' button. 

In most cases, the error is an easy manual fix. Note however, that fixing the error may 

require some knowledge of XML.  When you click the '…' button, all the hidden text in the 

document will be displayed.  Most of this hidden text consists of XML tags.   

12.3 Editing the Requirements Document 

From time to time you will want to modify an Optimal Trace™ Enterprise generated document 

outside of the Optimal Trace™ Enterprise environment. Optimal Trace™ Enterprise provides 

full support for such edits and provides a facility for round-tripping the changes back into a 

Project. See 12.4 Reverse Requirements Document Option, for details. 

 

Note: Partial Documents cannot be reversed. 

 

12.3.1 Using the Optimal Trace menu in Microsoft Word 

When Optimal Trace generated documents are opened in MS Word, a special menu is inserted 

into MS Word. Optimal Trace generated documents exist independently of an Optimal Trace 

deployment. As such they can be edited either onsite or at a remote location. This is useful 

when making changes in MS Word documents and then reabsorbing those changes back into 

an Optimal Trace project. 
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The following table outlines each menu option, its likely usage scenario and its 

purpose/description. 

 
Option Usage Description 

Toggle 
Hidden Tags 

Diagnosis & 
Repair 

This turns on and off the hidden text that Optimal Trace uses to support 
round-tripping and document updates. Use this option for diagnosis when 
a document ceases to be round-trippable or updateable. The likelihood is 

that a hidden XML tag has been inadvertently deleted. 

Protect 
Document 

Normal 
Editing 

Microsoft Forms based documents are ones where only specific fields are 
available to you for editing.  This has the welcome side effect of 
protecting all the hidden text, which otherwise could be accidentally 

modified. In such Forms documents, if you want to edit in other areas of 
the document, you will need to unprotect the document. This option then 

re-protects the document after such an editing session. 

Unprotect 
Document 

Normal 
Editing 

Microsoft Forms based documents are ones where only specific fields are 
available to you for editing. In such generated documents if you want to 
edit in other areas of the document, you will need to unprotect the 
document. This option allows you do that. 

Insert Unique 
ID 

Advanced 
Editing 

This option will automatically generate a unique Optimal Trace ID for 
advanced customization of documentation. Typically this option is used 
for generating new IDs when the user is manually adding e.g. a new 
Requirement. 

Create 

Reserved 
Text Area 

Advanced 

Editing 

This (rarely used) option creates a reserved area for you to 'wrap' certain 

non-Optimal Trace content which otherwise would interfere with the 
normal workings of the document.   An example would be a user wishing 
to add some text of their own, which contained reserved XML characters 

such as < or &.  Note that most 'normal' freeform text can be freely 
typed anywhere in documents without problems.  Also, binary content 
such pictures, Excel spreadsheets, etc. can be safely inserted in 

documents as-is without needing to use this option. 

Duplicate 
Current Row 

Normal 
Editing 

This allows you create new steps, glossary items, actors, links, notes, etc 
by copying an existing row in the table.  Use this to add new entities to 
the document, which can then be round-tripped back into Optimal Trace. 

Insert 

Custom 
Property 

Editing a 

Profile 
Disabled for generated documents. See section 13.5.1 Adding Custom 

Properties for details on usage. 

Delete 
Custom 
Property 

Editing a 
Profile 

Disabled for generated documents. See section 13.5.2 Delete Custom 

Properties for details on usage. 

Format 

Custom 
Property 
Tables 

Editing a 

Profile 
Disabled for generated documents. See section 13.5.3 Format Custom 

Property Tables for details on usage. 

Format 

Tables 

Editing a 

Profile 
Disabled for generated documents. See section 13.5.4 Format Table(s) 
for details on usage. 

 

 

12.3.1.1 Inserting/deleting new Steps in MS Word 

Inserting new steps in a scenario within Word can be done very simply. Select the row in the 

specific scenario that you wish to insert steps into. 
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Once you have the step highlighted, under the Optimal Trace menu option click ' Duplicate 

Current Row '. This has the effect of making a copy of the currently selected step and the name 

becomes 'copy of xyz step' where 'xyz step' is the selected step. 

Note: To delete steps, simply select the row you wish to delete and hit delete as you would 

with any normal word table. 

 

12.3.1.2 Inserting/deleting new Items in MS Word 

Inserting new items in a Simple Requirement within Word can be done very simply. Select the 

row in the specific item list that you wish to insert items into. 

Once you have the items highlighted, under the Optimal Trace menu option click ' Duplicate 

Current Row '. This has the effect of making a copy of the currently selected item and the 

name becomes 'copy of xyz item' where 'xyz item' is the selected item. 

Note: To delete items, simply select the row you wish to delete and hit delete as you would 

with any normal word table. 

 

12.3.1.3 Inserting/deleting new Glossary Items in MS Word 

Inserting new glossary items in Word can be done very simply. First select an existing 

glossary item that you want to use as the basis for the new item. 

Once you have the step highlighted, under the Optimal Trace menu option click ' Duplicate 

Current Row '. This has the effect of making a copy of the currently selected glossary item and 

the name becomes 'copy of xyz item' where 'xyz item' is the selected glossary item. Both the 

name and description are copied. 

Note: To delete glossary items, simply select the row you wish to delete and hit delete as you 

would with any normal word table. 

 

12.3.1.4 Inserting/deleting new Actors in MS Word 

Inserting new actors in Word can be done very simply. First select an existing actor. This will 

become the basis for the new item. 

Once you have the actor highlighted, under the Optimal Trace menu option click ' Duplicate 

Current Row '. This has the effect of making a copy of the currently selected actor and the 

name becomes 'copy of xyz item' where 'xyz item' is the selected actor. Both the name and 

description are copied. 

Note: To delete actors, simply select the row you wish to delete and hit delete as you would 

with any normal word table. 
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Figure 57 - Round-tripping with visual merge after inserting new Word elements 

 

12.3.2 How Optimal Trace™ Enterprise encodes Project data 

Just how Optimal Trace™ Enterprise encodes Project data, is described briefly in the text 

below. 

When Optimal Trace™ Enterprise generates a document it encloses each piece of generated 

text within opening and closing tags. These tags are hidden. For example: 

Project Creation Date: <Project_CreationDate>Monday, Oct 22, 

2003</Project_CreationDate> 

Optimal Trace™ Enterprise hides the enclosing tags, denoted by angle brackets and the title 

delimiters, leaving visible text, in this case, „Monday, Oct 22, 2003’. By clicking on the  

button (or the Toggle Hidden Text item in the Optimal Trace menu) you can toggle between 

the hidden and non-hidden state. So there are two distinct portions to each field generated by 

Optimal Trace™ Enterprise: 
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 The title of the field, this is generally freeform text and is not interpreted by Optimal 

Trace.  It is simply copied over as-is from the skeleton. 

 The value of the attribute from the Project, this is enclosed with: <name_of_field>  value 
</name_of_field> 

 

12.3.3 Modifying Existing Elements 

Optimal Trace™ Enterprise works with documents using hidden tags to wrap generated data 

and it is possible to change the values of the data within those tags.  

 

Note: When running a spell check in Microsoft Word you should not display any hidden text. 

Hidden text can be displayed/hidden by clicking on the Windows  button. 

 

You might for example find the following in the document: 

Allow a customer to use the services of an ATM 

If you use the spelling check within Microsoft Word the word „customer‟ will be flagged as 

incorrect. You would want to change this to the correct spelling resulting in: 

Allow a customer to use the services of an ATM 

As long as you do not adjust the enclosing tags, changes can be made to any elements within 

Word and subsequently saved for merging back into the Project; see Section 12.4 Reverse 

Requirements Document Option, for details on reversing Optimal Trace™ Enterprise 

generated documents back into Optimal Trace™ Enterprise. 

 

Note: About Ids 

When viewing hidden text, in generated word documents you will see many examples of 

entries similar to the following: 

<Requirement_Id>27205259710765</Requirement_Id> 

These are special numbers that Optimal Trace™ Enterprise uses to track individual elements. 

Under no circumstances should you modify these numbers, as doing so will cause failure in 

subsequent updates and reversing. 

 

12.4 Reverse Requirements Document Option 

Use this option to reverse a document back into your Project, e.g. after you have made 

changes to elements within the document. If you have unsaved changes in your Project, you 

will be prompted to save these changes before reversing. 

 

Note: It is important that you are reversing a document into a Project that originally 

generated that document. If Optimal Trace™ Enterprise detects that the document you‟ve 

selected was not originally generated from this Project then it will inform you of this and 

prompt you to select a different document. 



 

 

124  Optimal Trace Enterprise User‟s Guide 

 

Note 2: Custom Properties are „Read Only‟ in terms of Document Generation. This means 

that changes to Custom Properties (add, remove or edit) will not work for reversing the 

document. Changes to existing Custom Property values will be reversed. 

Note 3: It is not possible to reverse a document that has been generated with the 'Remove 

Hidden Text Option' 

 

 Once you have selected the document, click on the Reverse button.  

 

If Optimal Trace™ Enterprise detects problems with the changes made to the document, an 

error screen will appear (see Figure 58 below), describing the actual problem encountered 

and the specific element causing the problem. 
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Figure 58 - Sample Document Error screen 

 

 

 Click on the  button will open the actual document and attempt to find the 

erroneous element. 

 

If the document has no formatting errors, the Visual Merge screen will appear and from there 

you can reconcile differences between data in the Project and the reversed document. 

However if merging is not required, an explanatory screen will appear. 

If the Ignore DocGen Custom Property Errors option is selected in the General Options dialog 

box and an inconsistency is found between the custom properties in the document and the 

custom properties in the project, a warning message appears. Click Details to view more 

information regarding the warning. See Figure 59 - Sample Missing Custom Property List. 
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Figure 59 - Sample Missing Custom Property List 

 

See section 18.4 Merging Projects for full details on how to work within the Visual Merge 

screen. 

 

12.5 Generate Reports Option 

Use this option to publish a Project‟s details to the web by generating HTML pages. This allows 

your customers/developers to view, at will and from anywhere, your Project requirements on 

a progressive and incremental basis via your web site. This is especially useful in distributed 

development scenarios, where numerous and often geographically dispersed development 

teams, need to view the Project requirements. 

Optimal Trace™ Enterprise ships with some ready-to-use HTML reports, which are based on Report 

Profiles; see Table 10 below, for details. 

There are two ways to generate a report: through the Optimal Trace interface and through the Windows 
DOS Command Prompt. 

To generate a report from Optimal Trace: 

 

1. Choose Generation>Generate Reports. The Report Generation dialog box appears 

2. Select the profile to use for report generation. If you want, select a different directory 

to save your generated HTML file to. 

3. Click Generate. 

 

A Link is automatically inserted into the Project Links area; see Section 6.2, for details. 
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 Click the  button to access a specific directory. 

 

 

Figure 60 – Report Generation screen 

Table 9 – Report Generation screen 

Item Description 

Profiles Displays the name of the report profile. Profiles allow you to generate certain 
elements from your Project and to adjust the branding & content. 

Description Displays a description of the report profile. 

Directory Optimal Trace™ Enterprise automatically defaults to a directory under the 
Projects directory called HTML (i.e. defaults to „/reports/reportname-html‟). 

 

 

To generate a report from the Command Prompt: 

1. Ensure that the Optimal Trace Server is running. 

2. Open the Windows DOS Command Prompt. 

3. Type GenerateCommandLineReport.exe –p –pr –t –u –pwd, where –p is the 

project name, -pr is the profile name, –t is the target directory, -u is the user name, 

and –pwd is the user password. The command would appear as "Generate CommandLine 
Report.exe"  “project name” “Profile Name” “Location" “usename” “password”.  For example, 

to generate the Tree View Report, type "Generate CommandLine Report.exe " “myproject” 
“Tree View Report” “d:\projects\OptimalTrace\reports" “usename” “password”. 
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Tip: Use the command prompt feature to schedule report jobs from Microsoft Windows 

Scheduled Tasks. Click Start>Programs>Accessories>System Tools>Scheduled Tasks 

to access this tool. 

 

 

Table 10 – List of Generate able Reports shipped with Optimal Trace™ Enterprise  

Report Profile Description 
General Report 

Generates to directory: 
...\reports\default_HTML 

Generates a frames based requirements document in HTML 
format, complete with hyperlinks to all elements of the project. 

Tree View Report 

Generates to directory: 

…\reports\tree_view_HTML 

This report outputs your project with requirements and packages 

nested in a tree. The actors, glossary, notes, links, NFRs, and 

details are accessible through links on the left side of the report. 

Swimlane Report 

Generates to directory: 
...\reports\swimlanes_html 

This report outputs your project with each scenario displayed 

with actors/resources on the vertical axis and the steps 
correlating with actors on the horizontal. This report is extremely 
useful for identifying steps with no associated resource and 
resource oriented gap analysis. 

Requirement Template (AC) Report 

Generates to directory: ...\reports\Use-
Case-Cockburn-Style_HTML 

This report outputs any Optimal Trace project with style and 

terminology from Alistair Cockburn applied. It is also a very 
useful report to show a very compact HTML based view of the 
project. 

Actor Usage Report 

Generates to directory: 
...\reports\ResourceUsage_HTML 

Generates an actor oriented report with each actor and the steps 
it participates in. The intent of the report is to show what 
actors/resources interact with given steps within the 

requirements and which steps have no actor currently defined. 
This is very useful for gap analysis and redundant actor 
identification. 

As Is – To Be Report  

Generates to directory: ...\reports\As-Is-To-
Be-Report_HTML 

Generates a report in HTML format with e.g. current details for 
administrators („As-Is‟ processes), and projected details for 

system developers („To-Be‟ processes). The Goal-levels 'As-Is' 
and 'To-Be' that ship with Optimal Trace are used as 
discriminators for this report. 

Traceability 

Generates to directory: 
...\reports\TraceabilityReport_HTML 

Generates a report showing all Trace Relationships across the 
project. The Trace relationships include all refinement, branch 
and link references. When clicking a given reference the specific 

element is selected within the Optimal Trace environment. 

Complexity and Completeness Report 

Generates to directory: 
...\reports\Complexity 

This report runs through the current project and outlines a 

complexity metric (as well as other summary stats) at the 
project level by totting up a summary of number of steps, items 
etc. 

 
Additionally it looks at each package, number of alternative 
scenarios and analyzing lack of completeness by highlighting for 
example steps without actors, packages with no non-functional 
requirements etc. 
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Figure 61 - Complexity Report run on the demo project 'Order System - (Articles)' 

 

12.5.1 Launching the report after generation 

When you generate the report, you can automatically open the default viewer for that report 

type with the generated report open for viewing. To do this, just click the 'Open' button when 

generation is completed. This will launch the viewer and allow you view the report. 

Note: Most systems will default HTML reports to be viewed in IE or another installed Browser. 

Similarly if you have Excel installed, it is likely that the Text based reports will show in Excel. 
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13 Options Menu 

Use this menu for viewing and modifying tool options. 

 

 From the Menu bar, click on Options 

 Click on General Options, and the screen shown in Figure 62 below will appear. 

 

13.1 General Options 

Use this option to maintain your Project‟s tool, Requirement and Server settings, all of which 

are described in the sections below. 

 

13.1.1 Tool Settings 

Enter the tool settings as per Table 11 below. 

 

 Click on the Save button. 

 

 

Figure 62 – General Options – Tool Settings screen 
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Table 11 - Tool Settings 

Item Description 

Default Help 
Viewing Format 

This is a drop-down menu. To select an option from the list, simply click on it. 
The options are: 

 PDF 

 HTML 

Document 
Generator Word 
Version 

The version of Microsoft Word to use for document generation. See Section 12 

Generation Menu, for more details on document generation. This is a drop-

down menu. To select an option from the list, simply click on it. The options 

are: 

 Word 2007 

 Word 2003 

 Word 2000 

Document 

Generation 
Empty Token 

This allows you specify a value for empty fields when generating MS Word 

documents. The default token is '...' but this can be changed as required. 

Expanded File 
Types in 
Generated Docs 

This setting is used in document generation to allow file links to be embedded 
in generated documents. The default settings for this option are: 

- Graphic type files: jpg,jpeg,gif,bmp,png 

- Document type files: pdf,rtf 

- Excel Spreadsheets: xls 

- Text files: txt 

- Visio files: vsd 

If modifying this list ensure you separate the extension file types with a ',' 
(comma) 

Default Package 
Display Option 

This is a drop-down menu. To select an option from the list, simply click on it. 
The options are: 

 Show Current Package Contents 

 Show Current and Sub-Package Contents 

 Show Contents of All Packages 

Max Num 
Change History 

Events 

When tracking changes as part of Change History, Optimal Trace loads a 
certain number of Change Events for viewing. This setting specifies how many 

events are loaded at a given time. Increasing this setting increases the load 
time when viewing the Project or Element Change history as these are loaded 

on demand. See section 14.1 View All Change History Option for more on 

Viewing Change History 

Split Images 
across multiple 
pages/files 

This option is used to specify whether images (flow diagrams etc.) are 

split across pages for document generation or when saving images to 

files. Set this to specify single images or else split over pages. 

Flow Diagram 
Step Display 

This option is used to specify that steps should be drawn as either: 

'Fixed' or 'Size to Fit'. When the latter option is set then the step 

horizontal size is adjusted to accommodate all the text in the step 

name, the former truncates the steps to be fixed to a given size. 
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Flow Diagram 

Branch Display 
This option is used to specify that condition text in Flow Diagrams 

should be either: 'Fixed' or 'Size to Fit'. When the latter option is set 

then the condition horizontal size is adjusted to accommodate all the 

text in the step name, the former truncates the condition text to be 

fixed to a given size. 

Default Project 
Template 

This is the default template that will appear selected when created 

new projects in Optimal Trace. You will want to set this if you are 

using a given specific template for your projects.  

Ignore DocGen 
Custom Property 
Errors 

Use this option to suppress custom property errors that arise during 

document generation. If selected, the document will generate and 

display warning messages when there is an inconsistency between the 

document template and the project. Clicking Details allows you to 

view the custom property and the table in which the warning occurred. 

 

 If this option is not selected, document generation will not complete 

and an error message displays. This option is selected as the default. 

Additionally, if this option is not selected when reversing the 

requirements document into Optimal Trace, the user will receive the 

Custom Property errors and the reversal will not complete. 

 

13.1.2 Structured Requirement Settings 

Enter the Structured Requirement settings as per Table 12 below. 

 

 Click on the Save button. 
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Figure 63 - General Options – Structured Requirement Settings screen 
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Table 12 - Requirement Settings 

Item Description 

Default 
Structured 
Requirement 
Goal Level 

The default goal level for Structured Requirements. This default can be 
overridden on a Project level basis by setting the Project default goal level. 

See Section 6.6.1 Goal Levels Settings for more details. 

This is a drop-down menu. To select an option from the list, simply click on it. 

The options are: 

 Very High Summary 

 Summary 

 User Goal 

 Subfunction 

 Too Low 

 As Is 

 To Be 

 Manual  

 Automated 

Default 

Structured 
Requirement 
Priority 

The default Structured Requirement priority - each new Structured 

Requirement inherits this priority level. This is a drop-down menu. To select 
an option from the list, simply click on it. The options are: 

 Highest 

 High 

 Medium 

 Low 

 Lowest 

Default Non 
Functional Req. 
Priority 

The default Non-functional requirement priority - each Non-functional 
requirement has a default priority. See Section 6.2 Project Non-functional 
Requirements, for details. This is a drop-down menu. To select an option 

from the list, simply click on it. The options are: 

 P1 

 P2 

 P3 

 P4 

 P5 

 

 

13.1.3  Server Settings 

Enter your Server settings as per Table 13 below.  

 

 Click on the Save button. 
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Figure 64 - General Options – Server Settings screen 

 

 

 

Table 13 - Server Settings 

Item Description 

Host Name for 

Server 

Enter the host name for the Repository Server.  On a standard network this 

will be the machine name where Optimal Trace™ Enterprise Server is running. 
If your Repository Server is running on your local computer, you can type 
„localhost‟ in place of the computer‟s network name. Alternatively if you know 
the IP address of the server you can enter this. 

Remote Port for 

Server 

Enter the port number that the Repository Server is running on.  Ensure that 

this number matches the setting on the Optimal Trace Server. See the 
Optimal Trace Server help file for more details on setting this. By default both 
the server and client side settings are set to 5456. 

Polling Interval This is the time setting that controls how often the client queries the server 
for updates. You can adjust this upwards if you wish to have less frequent 
polling from client to server. 

 

If you want to test the connection to the server hit the 'Test Connection...' button. This will 

attempt a connection between the client and server using the settings specified. If there is 

any issue with the connection, a detailed result screen is shown. Copy and paste the contents 
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of this screen and send it to your Optimal Trace administrator or network administrator for 

further diagnosis. It is likely that the server may not be correctly configured on your network. 

13.1.4  Default Directories Settings 

This area allows you specify where your Document Profiles, Report Profiles etc. are stored. For 

Enterprise deployments it is useful to centralise storage of custom project and document 

templates on a centralised file server.  

Enter your Template Setting as per Table 14 - Project Template Settings 

 

 Click on the Save button. 

 

 

Figure 65 - General Options – Project Template Settings screen 

 

 

Table 14 - Project Template Settings 

Item Description 

Project 
Templates 
Directory 

This is the location where Project Templates are stored. This can be reset by 
clicking the '…' button. You may wish to store your project templates on a 
central server. You can also edit the setting directly in the text area. 

Generate 
Documents 
Directory 

This is the location where documents are generated to by default. This can be 
reset by clicking the '…' button. You can also edit the setting directly in the 
text area. 
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Generate 

Reports 
Directory 

This is the location where reports are generated to by default. This can be 

reset by clicking the '…' button. You can also edit the setting directly in the 
text area. 

Export Reports 
Directory 

This is the location where exports are generated to by default. This can be 
reset by clicking the '…' button. You can also edit the setting directly in the 
text area. 

Open / save 
Projects 
Directory 

This is the location where offline projects are opened from or saved to by 
default. This can be reset by clicking the '…' button. You can also edit the 
setting directly in the text area. 

Document 
Templates 

Directory 

This is the location where document templates are stored. This can be reset 
by clicking the '…' button. You can also edit the setting directly in the text 

area. 

Report 
Templates 
Directory 

This is the location where report templates are stored. This can be reset by 
clicking the '…' button. You can also edit the setting directly in the text area. 

 

13.1.5 Spell Check 

 

 

Figure 66 - General Options – Spell Check screen 

 

This area allows you to configure how the spell check operates in Optimal Trace. 
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Table 15 Spell Check Options 

Item Description 

Hide Spelling 
Errors 

This allows you to set whether or not spelling errors are automatically 
highlighted in Optimal Trace. 

Suggest from 
Main Dictionary 
Only 

This allows you to set whether or not the spell checker uses suggestions from 
the Main Dictionary only, or also uses suggestions from the Custom 
Dictionary. 

Ignore Words 
with UPPERCASE 

This dictates whether or not words in UPPERCASE are ignored during spell 
check. 

Ignore words 
with numbers 

Check this box if you would like the spell checker to ignore words that contain 
numeric characters. 

Ignore internet 
and file 
addresses 

Check this box if you would like internet and file addresses to be ignored 
during spell check. 

Main This allows you to specify the location of the main dictionary to use when 
checking spelling. 

Custom 
Dictionary 

This allows you to specify the location of the custom dictionary used 

when checking spelling. The custom dictionary contains any words 

added by users. 

 

13.1.5.1 Spell Check and Language Support 

Two dictionaries are installed with Optimal Trace, U.S. English and U.K. English. By default, 

Optimal Trace is configured to use the U.S. English dictionary. 

Dictionaries in other languages supported by the Aspell spelling system can be used with the 

spell check tool; however these have not been tested, and are not officially supported.  

 

To install a dictionary in a different language, follow these steps: 

 

1. Download and install the Aspell installation from (1) Download and install the full 

installation from http://ftp.gnu.org/gnu/aspell/w32/Aspell-0-50-3-3-Setup.exe 

2. Download and install the specific language dictionary from http://aspell.net/win32. For 

example for French language download and install from 

http://ftp.gnu.org/gnu/aspell/w32/Aspell-fr-0.50-3-3.exe 

3. Start a command prompt and type: 

"C:\Program Files\Aspell\bin\aspell" --master=fr_FR dump master > fr_fr.txt 

Where fr_FR represents the French dictionary (replace with desired dictionary). 

4. Configure the Optimal Trace main spelling dictionary to point to the file generated in 

step 3. 

(a) Copy the newly created fr_fr.txt file from “C:\Program Files\Aspell\bin” to   

“C:\Documents and Settings\<USERNAME>\Application Data\Compuware\Optimal 

Trace Enterprise\<installed version>\dictionary” and in the General Options Dialog in 

Spell Check tab choose fr_fr.txt as the Main Dictionary. 

 

(b) Or in the General Options Dialog in Spell Check tab choose “C:\Program 

Files\Aspell\bin\fr_fr.txt” as the Main Dictionary.  
 

 

http://ftp.gnu.org/gnu/aspell/w32/Aspell-0-50-3-3-Setup.exe
http://aspell.net/win32
http://ftp.gnu.org/gnu/aspell/w32/Aspell-fr-0.50-3-3.exe
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13.2 Document Settings 

Use the Document Settings screen shown in Figure 67 below, to maintain your Projects 

document profiles and any elements and templates associated with them. See the headings 

below, for details. 

 

 

Figure 67 - Document Settings 

 

Table 16 - Document Settings 

Item Description 

Document profiles pane 

Name Displays the names of your documents‟ profiles, e.g. Test Profile. To edit a 

document profile‟s name, click on its name in the text box to select it for 
editing. Then key in or edit the existing name.  

Description This is an optional longer description of your documents‟ profiles. To edit a 
document profile‟s description, click on its description in the text box to select 
it for editing. Then key in or edit the existing description. 

Document Elements pane 

Incl. You can check this Include box when a profile, other than the 'Default' profile 
is selected.  

Name Displays the names of the elements associated with your documents‟ profiles, 
e.g. Glossary. You cannot edit an element‟s name from here. 
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Advanced (Document Templates for: ‘Default’) pane 

File Displays the names of the templates associated with the document 

profile selected in the Profile pane, e.g. Style Template. You cannot edit a 

template‟s name from here. 

Location Displays the Windows path to the template shown in 'File'. To edit a path, click 
on its description in the text box to select it for editing. Then key in or edit the 

existing description. Alternatively use the  option. 

 Click on this icon, and a Windows Explorer screen will appear. Use it to move 
to the template you want to associate with your profile. 

 Click on the Word icon to edit the template. 

 

 

13.2.1 Document Profiles pane 

Use the Document Profiles pane shown in Figure 67 above, to maintain your Projects‟ 

document profiles and any elements and templates associated with them. 

 

Enter your document profile details as per Table 16 above. 

 

 

 To add a new document profile, click on the Add a new document profile  icon. 

 To delete a document profile, click on the Delete a document profile icon. 

 To validate a new document profile, click on the Validate a new profile document 

profile  icon. 

 To save the document profile, click on the Save button. 

 

 

Note: A profile is a collection of templates that specifies the branding aspects of the 

generated document and the exact set of data that will be output to the document. 

The Document Profiles pane allows you to generate any subset of data to your documents. 

There is no limit to the number of profiles you can construct, however Optimal Trace™ 

Enterprise ships with some ready-to-use document profiles, see for Table 17 below, for 

details. 

Occasionally, when you are generating documents you may need to change the format of a 

document that is generated. Some common situations where you might want to customize 

profiles are: 

 You want to place a customer‟s specific branding on a generated document. This might 

include the customer‟s logo, custom header and footer etc. 

 You want to generate only a subset of data in a given Project, for example just 

generate the Actors, Glossary entries and Requirement names to the document. This is 

most frequently used for overviews of the Project requirements. 
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13.2.2  Document Elements pane 

Click on the Document Elements tab on the screen shown in Figure 67, to access the 

Document Elements pane, which allows you to maintain your Projects document profiles‟ 

elements. 

 

Enter your document elements details as per Table 16 above.  

 

 Click on the Save button. 

 

13.2.3  Advanced (Document Templates) pane 

Use the Advanced tab on the screen shown in Figure 67 above, to access the Document 

Templates pane shown in Figure 68 below, which allows you to maintain your Projects 

document profiles‟ templates. 

 

Enter your document templates details as per Table 16. 

 

 Click on the Save button. 

 

When you have entered the name, and optionally the description of the profile then you may 

specify the templates that are to be used with the profile. 

 

Note: Each profile has a set of Microsoft Word templates. When profiles are created the full 

list of its available templates is copied into a folder, with the profile‟s name, which is itself 

contained in the profiles directory. To omit specific areas of the profile, uncheck the Includes 

box to the left of the template you want to omit. Optimal Trace™ Enterprise ships with some 

ready-to-use document templates; see Table 17, for details. 

Here are some of the typical reasons for modifying a document template: 

 

 To use a customer’s branding - within Word replace the logo in Project and adjust 

the header and footer in all other templates resulting in a customized set of documents 

for a given customer or company. 

 To limit certain data sections of data output - within the profile omit sections such 

as the list of Actors, Glossary, and diagrams by unchecking the Includes box. 

 To output summaries of data - within the relevant profiles omit specific data pieces 

wrapped in opening and closing angle brackets. 

 

Within each template there is a set of hidden tags. See Section 12.3 Editing the Requirements 

Document, for details about tags. Each of these tags specifies the data that will be generated 

from an Optimal Trace™ Enterprise Project. 

 

Note: Compuware offers services to build custom profiles for your specific needs. For more 
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details contact Compuware. 

 

 

Table 17 - List of Document Settings shipped with Optimal Trace™ Enterprise 

Document Profiles 

Template Meaning 

Default This generates a full requirements document with all elements of the Project 
represented along with all attributes. Basically outputs all Project data and is branded 
with an Optimal Trace logo. 

Default Form This generates a full requirements document with all elements of the Project 
represented along with all attributes, using Word forms. Basically outputs all Project 
data and is branded with an Optimal Trace logo.  To navigate through Word forms, 
press tab or page-down. For further information on forms, please refer to Microsoft 
help. 

Default No 

Images 

System profile without images. 

Default No 
Images Form 

System profile without images, using Word forms. 

Overview Requirement summary, using Forms. 

Change History Details of the changes made to a Project‟s documents/files. 

Test 

Specification 

This generates a test document, with the main scenario of each Requirement reflected 

as a discrete Test Case. This document is suitable for projects that have been created 

from the QA Project Profile. It is also used in conjunction with the Test Generation 
feature (see section 14.4 Test Generation) and is primarily used by the QA and test 
stakeholders. 

 
Document Elements 

Element Is Required Dependency Meaning 

Project Always  This is used to format the Project details 
and typically outputs top-level data such 
as the Project's name, owner, etc. 

Table Of 
Contents 

  Standard Word Table of Contents. If this 
element is included Optimal Trace 

automatically inserts the TOC on 
generation of the output document. 

Introduction   This item is used to format the Project's 
properties such as Description, or any 

Custom Properties it possesses. 

Glossary   This is used to format the Glossary items 

Actor List   This is used to format the Actors in the 
Project 

Requirement 
Map 

  This is used to format the Requirement 
Map diagram 
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Package   This is used to format the Package. 

Requirement Dependency exists Requires Package This is used to format the Structured 
Requirement and all of its properties 

Main Success 
Scenario 

Dependency exists Requires 
Requirement 

This is used to format the way the Main 
Success Scenario is output, specifying 
which parts of the Steps are displayed 

Alternative 

Scenario 

Dependency exists Requires 

Requirement 

This is used to format the way alternate 

scenarios are output, specifying which 
parts of the Steps are displayed 

Requirement 
Non-functional 
Requirements 

Dependency exists Requires 
Requirement 

This is used to format the way Non-
functional requirements are displayed for 
each Requirement 

Requirement 
Notes 

Dependency exists Requires 
Requirement 

This is used to format the way Notes are 
displayed for each Requirement 

Requirement 
Links 

Dependency exists Requires 
Requirement 

This is used to format the way Links are 
displayed for each Requirement 

Requirement 
Flow Diagram 

Dependency exists Requires 
Requirement 

This is used to format the flow diagram 
for each Requirement 

Simple 
Requirement 

Dependency exists Requires Package This is used to format the Simple 
Requirement and all its properties. 

Simple 
Requirement 
Item List 

Dependency exists Requires Simple 
Requirement 

This is used to format the way the Item 
List is output, specifying which parts of 
the items are displayed 

Simple 
Requirement 
Notes 

Dependency exists Requires Simple 
Requirement 

This is used to format the way Notes are 
displayed for each Simple Requirement 

Simple 
Requirement 
Links 

Dependency exists Requires Simple 
Requirement 

This is used to format the way Links are 
displayed for each Simple Requirement 

Project Non-

functional 
Requirements 

  This is used to format the way Non-

functional requirements are displayed for 
the Project 

Project Notes   This is used to format the way Notes are 
displayed for each Project 

Project Links   This is used to format the way Links are 

displayed for the Project 

Change History   This refers to the full history of the 
project. 

Table Of Figures   This is a standard Word Table Of 

Figures, for any images which exist in 
the document. 

Document Templates 

Style Template   This .dot file is the Word template upon 
which the generated documents are 
based.  It contains the front-page logo, 

styles, fonts, headers + footers, etc. 
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Skeleton   This .doc file is the Word document 

containing 'skeleton' versions of the 
Document Elements described above.  
These skeletons are copied into the 
output document and populated during 
the generation process. 

 

 

 

 

Figure 68 - Document Settings - Test Specification Profile (Advanced Area for changing Detailed Format) 

 

13.3 Changing the Document Logo  

From the Document Settings screen select the profile desired. Using the "Advanced" tab edit 

the Style Template. To change the logo, remove the Compuware logo and paste the desired 

logo in its place. Subsequent document generated using this profile will contain the new logo.  

 

13.4 Changing the Header and Footer 

To change the header and footer of the output document, edit the appropriate style template.  

Due to the fact that the default is to have a different header and footer on the first page it is 

necessary to hit the enter key a number of time to cause a second page. See Figure 69  

 Select the "View->header & Footer" menu item any changes made will be reflected in 

subsequent generated documents. 

 Now delete the carriage returns to revert to a one page style document 

 



 

 

145  Optimal Trace Enterprise User‟s Guide 

 

 

Figure 69 - Changing the Header and Footer 

 

13.5 Outputting specific Custom Properties in Documents 

Although Optimal Trace Generation allows the convenience of automatically outputting 

Custom Properties on document generation, it is likely that you will want to specify given 

Custom Properties to be output with given Templates. 

 Edit the Skeleton document by clicking on the  in the 'Advanced' tab of the selected 

Document Profile. 

 

You may at this time Add and Remove Custom Properties from the Profile. Additionally you 

may format tables. 

13.5.1  Adding Custom Properties 

In the skeleton document, position your cursor in the area associated with the element that 

will have custom properties output. The following can have custom properties defined: 

Project 
Glossary Entries 
Actors 
Packages 
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Structured Requirements 
Requirement Scenario Steps 
Simple Requirements 

Simple Requirement Items 
Non-functional Requirements 

 

Firstly position your cursor over the area that can accept custom properties. From a Word 

perspective, these areas always correlate with MS Word tables. A Word table exists for each 

of the Custom Property enabled elements. 

Once you have positioned your cursor in a relevant MS Word table, in the Optimal Trace 

menu, click on the 'Insert Custom Property' menu option. 

If your cursor is incorrectly positioned you will receive a message informing you of this. See 

Figure 70 - Cursor position bad for Custom Property entry 

By default, the new Custom Property will appear either to the right of (for a column), or below 

(for a row), the current cursor point. 

 

 

Figure 70 - Cursor position bad for Custom Property entry 

 

You now enter the name of the Custom Property in the text entry area. The name must be 

exactly as appears in the originating Optimal Trace project. Additionally please note that the 

name is case sensitive, hence you should ensure that the names match exactly. 

A screen appears prompting you to insert the name. See below Figure 71 - Inserting a 

Custom Property for an example of this. 

 

Note: Incorrect Custom Properties. If you specify an incorrect custom property, or are 

generating from a project that does not happen to have specified custom properties, then the 

Generation process will report an error.   All Custom Properties in the skeleton document 

must have a match in the project. For example if you specify a Custom Property called 'Risk' 

in the Structured Requirements Table, each Structured Requirement in the project should 

have a custom property called 'Risk'. 



 

 

147  Optimal Trace Enterprise User‟s Guide 

 

 

Figure 71 - Inserting a Custom Property for a Requirement 

 

13.5.2  Delete Custom Properties 

Firstly position your cursor over the specific custom property that you want to remove. From 

a Word perspective, these areas always correlate with MS Word tables. A Word table exists 

for each of the Custom Property enabled elements. 

Once you have positioned your cursor in the relevant MS Word table, select the Optimal Trace 

menu and click on the 'Delete Custom Property' menu option.   You will be asked to type in 

the name of the Custom Property you want removed.  Again this data is case sensitive. 

If your cursor is incorrectly positioned you will receive a message informing you of this. See 

Figure 70 - Cursor position bad for Custom Property entry 

 

13.5.3  Format Custom Property Tables 

This option will re-format any tables in the document which it detects Custom Properties. 

Typically, these tables will have varying width as columns are added and removed. Use this 

option therefore to make adjustments as necessary to the left indent and to the width of 

these tables. 

 

Note: A bug has been reported in MS Word where it has been observed that adding Custom 

Properties can cause the table's width to become infinite. In effect the table's % size is 
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becoming greater than 100% of the available space. The table will appear to stretch off the 

page to the right. This option provides the user with a convenient work-around for this bug. 

13.5.4  Format Table(s) 

This macro will re-format any tables selected by the user, or the table located at the cursor, 

whether or not these tables contain Custom Properties.   For instance to re-format any and all 

tables in the document, hit ctrl-A and then use this option. 
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14 Tools Menu 

Use this menu to access Optimal Trace™ Enterprise‟s tools. 

 

 From the Menu bar, click on Tools 

 

14.1 View All Change History Option 

Use this option to audit what changes were made and by whom. This allows you resolve 

confusion or issues when dealing with any edits that may have been made to a project 

element. 

You can view all changes made to a Project. Each change point is recorded along with the 

specific detail of the actual change before and after at the level of the element, Requirement, 

Actor, etc.  

See Section 5.4 About Baselines, for details on how to baseline projects. 

 

To view the changes: 

 

 Click on Tools 

 Click on View All Change History Option, and the screen shown in Figure 72 will 

appear. 

 

You can also save the change history to a CSV file. These files can then be opened in Excel so 

that you can perform more advanced filtering or sorting depending on your needs. Click on 

the 'Save as' button to do this. 

The number of changes displayed can be adjusted by setting the configurable option under 

'Options >> General Options…' See 13.1.1 Tool Settings for more details. 
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Figure 72 - View All Change History screen 

 

14.2 View Element History 

You can also review a specific element's change history. Select the element in the Tree area 

and click on the  button. This then brings up the specific changes made to the selected 

element. 

Similar to the Project History this list can be saved to a file and opened in Excel. 

 

14.3 View Traceability Tree Option 

Optimal Trace Projects are comprised of Structured and Simple Requirements with scenarios, 

steps, items, branches and refinements.  You can access the automatically generated 

'Traceability Tree' enabling tracing to all dependent elements either within or across 

packages/projects. 

 

Select the element in the tree area and click on the  button. 

 

When elements are selected in the tree Optimal Trace automatically selects the 'traced to' 

element in the background display showing the full package context for the traced to element. 

Optimal Trace Traceability relationships comprise: 

 

- branches,  

- refinements and  

- links to given Optimal Trace or non-Optimal Trace elements. 
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Where cross-project traces (links) exist you can automatically load the traced to element (& 

project) by selecting the link in the Traceability Tree and double clicking. 

Traces to external tools via links are also displayed. On clicking the Traced to element, if that 

element is loaded Optimal Trace will resolve the link and highlight the linked element in the 

background. 

 

The options available in the Traceability Tree are identical to the Traceability Tab and are 

outlined in full detail in section: 8.2 Navigating the Trace Tree & Loading Projects 

 

14.4 Generate Test Cases Option 

In typical organizations, software testing accounts for between 30% and 50% of development 

cost. 

The following capabilities are provided to support test generation in Optimal Trace Enterprise: 

 Generate Test Cases for each path through the Requirement (considering 

scenarios) 

 Generate Test Cases for each Simple Requirement. 

 Generate tests for Non-Functional Requirements at Project and Requirement Level 

 Generate Forward and Reverse Trace Links from Business to Test Requirements. 

 

Tests can be generated for the entire project, for individual packages or for discrete 

requirements. Selecting the specific element required in the tree prior to clicking the Generate 

option sets the context. 

 

Note: Test Types. To understand how Optimal Trace generates test plans, it is useful to 

outline the types of test artifacts that are generated. These are three test types; Project Level 

Non-Functional Test, Functional Test and Associated Non-Functional tests. 

Project Level Non-Functional Tests 

These tests result from iterating through the non-functional Requirements defined at the project level in 
the Optimal Trace originating project.  

Each non-functional requirement encountered generates one test case. 

Functional Tests 

These Tests result from traversing each path through a given Structured Requirement. One Test Case is 
generated for each distinct path encountered. 

Associated Non-functional Tests 

These Tests result from iterating through the non-functional Requirements associated with a given 
Structured Requirement. Each non-functional requirement encountered generates one test case. 

 

14.4.1  Generating Test Cases for the entire Project 

To generate test cases for the full project. 

 Select the project in the Tree view 
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 Click on the  button in the toolbar (or menu option), and the screen similar to that 

shown in Figure 73 appears. 

 

Figure 73 - Generating full Project Test Cases 

 

 

14.4.1.1 Project Level Non-functional Tests 

 

 Check the 'Generate test cases for project level non-functional requirements' box to 

generate tests for each Non-Functional Requirement defined on the project.  

 Once you check this you specify the location of where the tests will be created by 

clicking the '…' button adjacent to the 'Generate to' field in the area titled 'Project non-

functional requirements' 

 A screen appears (see Figure 74) prompting you to specify the location you wish the 

tests to be generated to. You should choose a package appropriate for the type of test 

to be generated 
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Figure 74 - Specifying the location for generated Test Cases 

 

You may also elect to create a New Project or open an existing project at this time. See 

sections 5.1 Creating a New Project and 5.2 Opening Projects for more on these options. 

 

14.4.1.2 Functional Tests 

 

Checking the 'Generate test cases for project packages' box means that you can generate 

tests for any requirements contained within the package hierarchy. If you choose this option 

the tests can be generated both for each structured requirement encountered along with any 

associated non-functional requirements, and for each simple requirement encountered. 

 

See section 14.4.2 for more detail on how Optimal Trace generates test cases for discrete 

requirements. 

 

For functional test generation you may check two additional options, these are: 

 

 'Generate Package per Requirement'. This allows you categorize the resultant 

Functional Test Cases grouped per originating Requirement. For cases where you have 

many alternative scenarios it is useful to check this option. 

 

 'Include Step/Item Description'. Checking this option means that on generation each 

Step or Item's description is carried over to the resultant Test Case. You may however 

want to use the Description to carry sample Test Data for instance in which case you 

should uncheck this setting. 
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14.4.1.3 Associated Non-functional Tests 

 

 Check the 'Generate non-functional requirement test case' box to generate tests for 

each Non-Functional Requirement associated with the structured requirement. 

 

Note: In Optimal Trace 5.0, Non-Functional Requirements are deprecated. Users 

wishing to capture Non-Functional type requirements should use Simple Requirements 

instead. See section 6.13 Simple Requirements Overview for more information. 

 

We recommend you uncheck this setting. 

 

 Once you check this you specify the location of where the test will be created by 

clicking the '…' button adjacent to the 'Generate to' field 

 A screen appears (see Figure 74) prompting you to specify the location you wish the 

tests to be generated to. You should choose a package appropriate for the type of test 

to be generated 

 

 

14.4.1.4 Trace Links from Requirements to Test and vice versa 

Generating Test Cases allows Trace Links to be created from the Business Requirements to 

Test Requirements (Test Cases) and vice versa. (See section 6.3.2 Traceability Links for more 

on creating Optimal Trace Element Trace Links.). 

 

Two options exist, 1. Create forward Trace Links to the generated Test Cases and 2. Create 

Reverse Trace Links from the generated Test Cases back to the originating Requirements. 

Check the 'Automatically create trace links to generated test cases' to auto-create forward 

links and check 'Automatically create reverse trace links from generated test requirements' to 

auto-create reverse links. 

 

14.4.1.5 Generation 

 

Once you hit 'Generate', a result screen is presented as in Figure 75 - Test Generation Results 

screen. You can observe from the results screen how: 

 

 Each structured requirement maps to one or more Functional Test Cases in the 

destination location 

 

 Each simple requirement is treated as a discrete test case in the destination location. 

Each Test Case generated becomes a Structured Requirement in the destination 

project. 
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Figure 75 - Test Generation Results screen 

 

 

 

14.4.2  How Optimal Trace interprets Tests from Structured Requirements 

 

The core of the Optimal Trace Test Generation capability revolves around generation of 

functional test paths. 

Note: Test Path Algorithm 

The algorithm for generating the functional test set is: 

A Test for the Main Scenario: The Test Requirement is populated with the collection of all 

steps from the main success flow. If the checkbox ' Include Step Description ' is set this also 

includes the description for each step. 

A Test for each Alternative Scenario: The Test Requirement is populated with the 

collection of all steps that comprise the Valid Path up to and including the final step of the 

scenario and also the remaining steps of the main scenario if the final step of the alt scenario 

rejoins the main scenario. 

A Test for each Simple Requirement: The Test Requirement is a Structured Requirement 

with each step correlating one for one with each simple requirement item. 
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14.4.3 Test Generation and Refinements 

If a refinement association exists between two requirements for which tests are been 

generated, a refinement association will be created between test cases that are generated 

from these requirements. This allows you to define relationships between requirements, and 

carry them forward to any test cases that are derived from those requirements. 

 

14.5 Merge Two Projects Option 

Merge can only be run for two versions of the same project. 

Use this option to merge Projects, when you are: 

 

 Merging two Projects together where you or different people have been updating 

different copies of the Project. For example if going from Offline back to Online. 

 Merging two Projects where two or more people might be working some distance apart 

from each other, e.g. Offshore Development Scenarios where locations are not 

connected by WAN and where two databases are being kept in synch. 

 

To invoke the merge tool for two Projects: 

 

 Click on Tools, then Merge Two Projects, and the screen shown Figure 76 will appear. 

 

 

Figure 76 - Specify Two Projects to Merge screen 

 

You can select both Projects to merge by clicking on the File button or the Repository button, 

depending on where the Project is stored. Once you have selected a Project, Optimal Trace™ 

Enterprise will validate that the Project is correctly formatted and place a green tick next to 

the Project‟s name, as in Figure 76. Once you have the two Projects specified: 

 

 Click on the OK button to begin the merge 
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 The Project Merge screen then appears. See section 18.4 Merging Projects for full 

details on Project Merging 

 

14.6 Spell Check 

The spell check option allows you to check the spelling in the current section of the project, or 

in the entire project. 

 

 

Figure 77 - Spell Check Dialog 

 

The spell check dialog will highlight any incorrectly spelt words, and will suggest an 

alternative spelling. On this dialog the user has the following options: 

 

 'Ignore Once' this tells the spell check tool to ignore this instance of this spelling. 

 'Ignore All' this tells the spell check tool to ignore all instances of this spelling in the 

project. 

 'Add to Dictionary' this adds the underlined word to the custom dictionary. Once the 

word has been added to the custom dictionary it will no longer be highlighted by the 

spell check tool.  

 'Change' will replace the current instance of the word with the selected word in the 

'Suggestions' list. 

 'Change All' will replace all instances of the word throughout the project with the 

selected word in the 'Suggestions' list. 

 'Options' will open the Spell Check options section of the General Options. 

 

Once the spell check tool has finished checking the current section in the project, it will, if the 

user wishes, continue checking the rest of the project. 
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15 Window Menu 

Use this menu to view which windows are already open and to open new windows. 

 

 From the Menu bar, click on Window 

 Click on New Window, and a new window will appear, where the list of currently open 

windows is displayed below the New Window menu item (Figure 78). 

 

 

Figure 78 - Opening New Windows 

 

Note: There are occasions where you might want to view different parts of the same Project 

or different Projects simultaneously. 

Optimal Trace™ Enterprise offers the ability to open multiple Optimal Trace™ Enterprise 

windows, which share the same Project data. This option is used for: 

 

 Viewing areas of one or more Projects through several windows, assured that any 

changes made to one window are reflected across all windows. 

 Copying and pasting from one area of a Project to another area of the same Project. 

 Copying and pasting from one Project to another Project. 
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16 Help Menu 

Use this menu to access the Help file and to view Optimal Trace™ Enterprise content, 

Warranty, and Disclaimer information. 

 

 From the Menu bar, click on Help, and the options described in the sections below will 

be made available. 

 

16.1 Optimal Trace Help File Option 

Use this option to access the Optimal Trace help documentation. 

Depending on the setting entered under 'Options >> General Options…', (see section 13.1.1 

Tool Settings for more) you will be presented with help either in PDF or HTML (web based) 

format. 

 

16.2 About Option 

Use this screen to learn about the Optimal Trace™ Enterprise application. This displays a 

screen with Optimal Trace™ Enterprise content, Warranty, and Disclaimer information. It may 

also refer to other products. 
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17 Optimal Trace Integrations into UML 

Optimal Trace™ Enterprise provides separate plug-in integrations into the leading UML design 

tools; Compuware's OptimalJ, IBM/Rational Rose, Borland Together and Enterprise Architect. 

This means that you can be sure that the requirements are reflected correctly within the 
target design tool. 

Detailed requirements specify what the system must do, whereas how the system will satisfy 

those requirements is typically reflected in a system design. In Object Oriented software 

development this design is typically captured in the UML (Unified Modeling Language) as use 
case diagrams, activity diagrams. It is important that the design matches the requirements. 

Traceability from requirements to design and code is facilitated using the UML design tool 
plug-ins. 

For full details about how Optimal Trace integrates see the relevant integration help files for 

OptimalJ, Borland Together or IBM/Rational Rose. 

 

17.1.1 How Optimal Trace™ Enterprise maps to UML 

This section is for people who understand UML, are familiar with tracing requirements into 

system design and have some experience of using design tools. 

It also presumes you are using one of the available UML design tools supported by Optimal 

Trace Enterprise. 

When exporting to UML Optimal Trace™ Enterprise maps elements; see Table 18, for details. 

 

Table 18 - UML Optimal Trace™ Enterprise elements mapping  

Icon Meaning UML equivalent Note(s) 

 Structured Requirement Use Case Optimal Trace Structured 

Requirements are semantically 
equivalent to the Use Case 
notion espoused in the UML 

 Simple Requirement Use Case Optimal Trace Simple 
Requirements are semantically 

equivalent to the Use Case 
notion espoused in the UML 

 Package Package  

 Glossary Item [Not mapped] No UML equivalent 

 Actor Actor  

 Step  No UML equivalent 

 Item  No UML equivalent 
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 Refinement Represented as a Requirement 

Generalization relationship. 

 Optimal Trace™ Enterprise 
Requirement with Step => 
UML Super Use Case 

 Optimal Trace™ Enterprise 
Refined to Requirement => 
UML Sub Use Case 

No UML equivalent for 

Refinement. Closest semantic 
equivalent is Requirement 
generalization 

 Conditional Branch to a 

Requirement 

Represented as an <<extend>> 

association between the 
participant Requirements. 

 Optimal Trace™ Enterprise 

Requirement with Step => 

UML Extended Use Case 

 Optimal Trace™ Enterprise 
Requirement that is 
branched to => UML 

Extending Use Case 

 

 Non-conditional Branch to 
a Requirement 

Represented as an 
<<include>> association 
between the participant 
Requirements. 

 Optimal Trace™ Enterprise 

Requirement with Step => 
UML Use Case that is 

including 

 Optimal Trace™ Enterprise 

Requirement that is 
branched to => UML 
Included Use Case 

 

 

For full details about how Optimal Trace integrates see the relevant integration help files. 
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18 Multi-User Support in Optimal Trace Enterprise 

Optimal Trace™ Enterprise allows several users to work on the same Project simultaneously. 

When other users edit or add Requirements, Actors or other Project artifacts, the changes will 

appear dynamically on your screen. 

The Optimal Trace Server software monitors all currently connected clients and ensures that 

all project changes saved to the repository are broadcast simultaneously to all users. 

When you are editing an artifact, Optimal Trace™ Enterprise ensures that nobody else can 

edit that artifact or the artifacts upon which it depends, by locking them. People are free 

however to edit any Project artifacts that are not directly affected by your edits. 

For more information, refer to the Optimal Trace Enterprise and Professional Installation and 

Configuration Guide. 

 

18.1 Configuring Optimal Trace™ Enterprise to work through a Optimal Trace™ 

Server 

If you want to create or edit a remote Project, you must tell Optimal Trace Enterprise where 

to find the Repository. 

 

 From the Menu bar, click on Options 

 General Options 

 Server Settings see Section 13.1.3  Server Settings for details. 

 

Note 1: A given client can be set to point at a different Server by adjusting the server setting 

in the Options screen.  

 

Note 2: If you do not already have a Repository Server on your network, you will need to 

install a copy of Optimal Trace™ Enterprise Server before you can use any of the Optimal 

Trace™ Enterprise collaboration facilities. See the Optimal Trace Enterprise Server user guide 

for full details on configuring a server. 

 

18.2 Concurrency and locking 

Typically, applications allow for only one user to edit a file at any point in time. For example, 

a Word document stored on a central Server is viewable by several users at once, but only 

one user will have the „lock‟ required to make changes to the Project. This „lock‟ facility 

prevents conflict due to multiple concurrent attempts to update the same Project. 

Optimal Trace™ Enterprise‟s locking mechanism, allows multiple users to access and edit a 

Project at the same time while ensuring that their changes do not conflict with each other. 

Every Project artifact (e.g. Requirements, Actors, etc) is monitored for edit attempts. In the 

event of an edit attempt, it and every other artifact that depends on it is locked for editing. All 
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users can see a locked artifact, but only the user with the lock can edit it. The lock is 

„released‟ when that user saves changes back to the Repository. Parts of a Project that are 

not directly affected by an edit attempt remain unlocked; any user can work on them. 

If you wish to work on a Project in collaboration with other users, everyone simply opens the 

Project; see Section 5.2 Opening Projects, for details. Initially, you will not be aware that 

other users are present. 

However, as soon as someone starts to edit a Requirement (for example, to add a new Step), 

a Padlock icon  will appear next to that Requirement in every other user‟s Tree View, 

symbolizing that the Requirement is locked (Figure 79). 

Tip: If you position the cursor over the specific locked element in the tree, a popup appears 

with the user name of the person that has acquired this lock. 

 

If you on the other hand start editing a requirement you will acquire a 'lock' on the element 

and an unlocked padlock icon   appears next to your requirement. 

 

 

Figure 79 - A Requirement locked for editing 
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You can still click on the Requirement and view it in the usual way, but its details will be 

grayed out and you will not be able to edit it. Once the user who is working on that 

Requirement finishes and saves his work, the locks will be removed, and the padlock icons 

will disappear from your screen. See the padlock opposite the Requirements number 'SR2', 

'Withdraw Cash', indicating that someone else is editing that particular Requirement and it is 

locked. 

18.3 Optimal Trace Locking Rules 

When multiple users are working within Optimal Trace a number of locking rules apply. This 

ensures that the integrity of the Optimal Trace Project is maintained and that there is no 

conflicting data. 

 

Action Effect 

Attempt to edit Project properties, links, notes 
and non-functional requirements 

Project 

Apply label to Project Project 

Attempt to edit an Actors name or definition Actor only 

Attempt to add an Actor to Actor List The Actor List 

Attempt to remove Actor from Actor List The Actor, Actor List and all Packages, Requirements 
in Packages and all child Requirement Packages and 
their children. 

Attempt to edit a Glossary Entry name or 
definition 

Glossary Entry only 

Attempt to add a Glossary Entry to Glossary The Glossary 

Attempt to remove Glossary Entry from Glossary Glossary Entry only 

Attempt to edit a Package name or description Requirement Package. This will allow users to edit the 
properties of all subordinate objects but not allow 
addition / removal 

Attempt to add a Package to a parent package Parent Requirement Package. This will allow users to 
edit the properties of all subordinate objects but not 
allow addition / removal. 

Attempt to remove a Package from a parent 
package 

Parent Requirement Package and all subordinate and 
reachable objects. This is because the sub 
requirements will be deleted by the package delete so 
we don’t want to allow users to edit any of them. 
Likewise with any objects reachable by the 
Requirements. 

Attempt to edit a Requirements properties, links, 
notes, NFRs, etc (excluding graph position) 

Requirement only 

Attempt to set a Steps actor Requirement only 

Attempt to create an Actor from Step Requirement and the Actor List 

Attempt to set a Requirements goal level Requirement only 

Attempt to create a Goal Level from Requirement Requirement and Project 

Attempt to remove a Requirement from a 
Package 

Parent Requirement Package, Requirement to be 
deleted and all reachable objects (via refinement / 
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Action Effect 

branch relationships) 

Attempt to add a Requirement to a Package Parent Requirement Package. This will allow users to 
edit the properties of all subordinate objects but not 
allow addition / removal. 

Attempt to add/modify Step/ Scenario on a 
Requirement 

Requirement only 

Attempt to add/modify Refinement/Branch on a 
Requirement 

Requirement and all reachable objects via the 
refinement / branch relationships. Also lock the 
refined/branched to Requirement and all reachable 
objects. 

Attempt to remove 
Step/Item/Refinement/Branch/Scenario, etc on a 
Requirement 

Requirement and all reachable objects. If a users 
deletes a scenario with refined from steps we need to 
lock the refined to Requirement and so on… 

Renumber all Requirements  Root Requirement Package and all subordinate 
objects 

Paste Destination (new parent) of the object being pasted 
and all objects associated with the object being 
pasted 

Copy No locking required (only on paste) 

Undo/Redo No extra locking required since any objects affected 
should already have been locked. 

Display goal levels dialog Lock the Project object 

Delete a goal level Lock root Requirement package and all children 
recursively 

Document generation Project only 

HTML generation Project only 

Reverse document Project and all reachable objects 

Merge Project and all reachable objects 

  

Create/Delete/Edit custom property, display 
Bound Value Dialog 

Lock custom property type list, all affected custom 
property holders and their parents. In the case of 
Step, Item, Requirement, and NFR: lock all 
Requirement packages/Requirements. 

 

 

18.4 Merging Projects with Optimal Trace Enterprise 

The merge tool takes two Projects, labeled From and To and combines them into one Project 

labeled the Result Version, which will then include: 

 

 Objects in the From Project but not in the To Project 

 Objects in the To Project but not in the From Project 

 Objects which are common to both the From and the To Project 
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If any objects which exist in both the From and the To Projects have different attributes, 

they will trigger a decision point (or merge conflict).  For example, two Actors called „user‟, 

one with the description „The user‟ and the other with the description „The generic user‟. 

In the instance where the two merging Projects have the same name, the object that was 

edited most recently (evaluated based on Project timestamps) is chosen. In the instance 

where the two merging Projects have different names (e.g. merging two different Projects 

together), the choice of object is left to the user to choose via the Merge Tool. 

There are additional rule that apply to every element of the project. These are outlined in 

detail in section  

 

 

Figure 80 - The Project Merge screen showing general layout 

 

The Merge Screen shown in Figure 80 shows all conflicts (differences) graphically so that you 

can decide how to resolve them on a one-to-one basis. When the Optimal Trace™ Enterprise 

Merge Screen initially shows, for every conflict detected, it accepts for inclusion in the Merged 

Project the most recently changed element. 

In order to move up or down between conflicts on the Project Merge screen you may use the 

Up ( ) and Down ( ) buttons. 
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Click on the  button to view the selected object's properties in the Result Project (with the 

exception of Packages) and the screen shown Figure 83 in will appear. 

When Conflicts occur in the Merge Screen there can be one of a number of reasons. The next 

table outlines the meaning of the Visual Cues (Icons) that appear and explains the Conflict 

States when a specific button is enabled. 

It should be noted that icons appear in the From and To projects as per the normal Tree View 

of the Optimal Trace™ Enterprise application, effectively without any adornments such as 

pluses or circles. In this instance, this signifies that an object of this type was found in each 

of the From and To and these were found to be identical, hence there is no change in the 

result Project. 

 

 

Button 

Enabled 

Element 

Adornment 

Meaning Description 

  "Add to Merged 

Project" 

This means that the selected Element is 

available for addition to the merged project. 
Upon clicking this button, the selected element 
is added to the Merged Project. 

  "Remove from 

Merged Project" 

This means that the selected Element is 
available for removal from the merged project. 

Upon clicking this button, the selected element 
is removed from the Merged Project. 

  or  "Switch Properties 

in Merged Project" 

This means that the selected Element has 

changes. These changes are at the 'property' 
level so for example in the case of a package 
this might be a name or description. Clicking 

this button brings up the list of detailed 
property differences. You can change which 
version of the properties are accepted into the 
Merged Project by hitting 1 or 2 once the 
detail screen shows. 

  or  ''Switch Associated 

Elements in 

Merged Project'' 

This means that another Element that is 

Associated with this Element has changed 
(e.g. a Step Element can be associated with 
an Actor Element). You can change which 
Element is Associated with this Element by 
hitting the 1 or 2 buttons once in the details 

screen. 

  or  ''Switch Associated 

Elements in 

Merged Project'' 

This means that the selected Element has a 
positional change. Positional Changes happen 
when elements are added or removed. If the 
number of elements is the same in the From 
and To project, clicking this button results in 
the other side's positions being adopted.  

Note: Position switching is only allowed if 
no new elements are added/removed and 
if the number of elements are the same 
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Figure 81 - Viewing a Property Conflict on this object's properties 
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Figure 82 - Resolve an Addition or Subtraction in the Glossary 

 

 

Figure 83 - Glossary Entry Properties 

Once all outstanding merge conflicts have been resolved you can save the resulting merged 

Project (i.e. Merged Project): 

 

 Click on the Save button on the Project Merge screen (Figure 80) and the two Projects 

with the result reflected as the 'Merged Project'. 
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18.5 Security and Access Control on Projects 

 

Optimal Trace Enterprise allows permissions to be set for Groups of Users and individual users 

on given projects or project packages. 

 

This ensures that project stakeholders are allowed access and editing capability on 

appropriate areas of the project. 

 

Some common usage scenarios where you might consider applying permissions are: 

 

 Allowing project stakeholders such as Business Analysts/Engineering etc. to have 

certain visibility levels into a project. 

 Allowing the 'QA team' to edit the Test Requirements project but have 'read-only' 

access to the Business Requirements. 

 Restricting Engineering teams to editing certain Packages or Groups of 

Requirements. 

 Locking down 'reference' projects for use throughout the organization.  

 Locking down the Glossary in a project. 

 Locking down archived (backups) versions of projects ensuring no changes can be 

applied. 

 Restricting 'Open' Access to sensitive projects. 

 

An example screen showing a partially editable project is shown below in Figure 84 - Partially 

Editable Project. 

Projects or portions of projects that are non-editable are visually indicated by grey text and 

accompanying icons. 

Full details on setting up Groups, Users and Permissions can be found in the Optimal Trace 

Administrator help file. 
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Figure 84 - Partially Editable Project 
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19 Troubleshooting 

When Optimal Trace™ Enterprise encounters problems a screen appears outlining the detail of 

the problem, e.g. see Figure 85. 

 

 

Figure 85 - Sample Optimal Trace™ Enterprise Error screen 

 

When a problem does occur Optimal Trace recommends that you save any open Projects and 

close Optimal Trace™ Enterprise: 

 

 Click on the OK button on the error screen 

  Click on the Save Project icon in the Tool bar.  

 

Optimal Trace™ Enterprise performs its own verification of the structure of underlying data 

when opening and saving of Projects, so for the majority of problems that occur, the integrity 

of your data will be guaranteed simply by saving any changes made to your Project. Simply 

start Optimal Trace™ Enterprise again, and open the Project, and normally you can be 

confidant that your application has recovered. 

A second file, „Optimal Trace Enterprise_log‟ is always maintained in the "C:\Documents and 

Settings\<userprofile>\Application Data\Compuware\<OptiomalTraceVersion>\" directory. 

This is a text file generated by Optimal Trace™ Enterprise and used to collect useful 

information and error conditions. 

In all instances where an error screen such as the one shown in Figure 85 appears, you 

should report the circumstances and description of the failure to Optimal Trace support. See 

Section 1.4 Contacting Optimal Trace Customer Support, for details. You should also include, 

if possible: 

 

 The Project .ctl file causing the problem. If the project is a repository project take the 

project offline. 

 The „Optimal Trace Enterprise_log‟ file. 

 

Note: If you are working with Optimal Trace Enterprise Server, ask your System 
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Administrator to check the Server logs and to send them also, to Optimal Trace support. 
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20 Licensing and Upgrading Optimal Trace™ Enterprise  

This section describes how you license and upgrade the Optimal Trace™ Enterprise 

application. 

 

20.1 Evaluating Optimal Trace Enterprise 

Optimal Trace can be evaluated for a specific period of time without a license key. When you 

first run Optimal Trace Enterprise you do not require a license therefore. 

The evaluation period is calculated from the time of first usage, in other words from the initial 

running of Optimal Trace 

Once this period of time elapses you must either purchase a full license or else apply for an 

extension key. See section 1.4 Contacting Optimal Trace Customer Support for more details 

on how to contact Compuware support. 

20.2 Licensing the application fully or using an extended evaluation license key 

Aside from the initial evaluation period as outlined in the previous section, Optimal Trace™ 

Enterprise requires a license to run. Optimal Trace ships with a License Administration utility 

called the LAU (License Administration Utility). For full details on how to license Optimal trace, 

please run the LAU and refer to the LAU help file under the 'Help >> Index...' menu option. 

20.3 Upgrading from a previous release 

If upgrading from Optimal Trace 4.1, you will need to install new licenses for Optimal Trace 

5.0 into the LAU in order to run Optimal Trace 5.0. See section 1.4 Contacting Optimal Trace 

Customer Support for details on how to contact Compuware support. 
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Appendix  A  ©Optimal Trace™ Enterprise Shortcut Keys 

This appendix contains Optimal Trace™ Enterprise Shortcut Keys details for your convenience. 

 

Table 19 - Optimal Trace™ Enterprise Shortcut Keys  

Option Shortcut Keys 

Insert a new Step/Item Alt+Shift+A 

Create a new Alternative Scenario Alt+Shift+C 

Delete a selected Refinement Alt+Shift+D 

Refine the selected Step to an existing Requirement Alt+Shift+E 

Delete an Alternative Scenario Alt+Shift+O 

Refine the selected Step to a new Requirement Alt+Shift+R 

Delete a Step Alt+Shift+S 

Refine the selected Requirement to a new Requirement Alt+Shift+U 

Create a new Package Ctrl+Alt+C 

Document Settings Ctrl+Alt+D 

Renumber all Requirements Ctrl+Alt+E 

Save an image in JPEG format Ctrl+Alt+I 

Delete a Package Ctrl+Alt+K 

General Options for the Tool Ctrl+Alt+O 

Copy Ctrl+C 

Exit Optimal Trace™ Enterprise Ctrl+E 

Search within a Project Ctrl+F 

Layout diagram Ctrl+K 

Merge two Projects Ctrl+M 

Create a new Project Ctrl+N 

Open an existing Project Ctrl+O 

Save a Project Ctrl+S 

Apply a Label to the Project Ctrl+Shift+A 

Branch the selected Step to new Requirement Ctrl+B 

Create a new Requirement Ctrl+Shift+C 

Create a new Simple Requirement Ctrl+Shift+R 

Delete a Requirement Ctrl+Shift+D 

View Change History Ctrl+Shift+V 

Paste Ctrl+V 
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Option Shortcut Keys 

Redo Ctrl+Y 

Undo Ctrl+Z 

Save Project As ALT+P+A 

Save Project As Template ALT+P+T 

Apply Template to Project ALT+P+P 

Open Project Template ALT+P+M 

View Element History ALT+T+I 
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Appendix  B  Glossary of Terms 

This appendix contains a Glossary of Optimal Trace™ Enterprise Terms as used in this 

document and their relationship to each other (Table 20 below). 

 

Table 20 – Glossary of Terms 

Item Sub-item Description 

Software  The software Packages provided by Compuware and third party 
suppliers. 

 Optimal 
Trace™ 
Enterprise 

The requirements capture and management tool for teams of 
Business Analysts, Systems Analysts and Project Managers. 

 Optimal 
Trace™ 
Enterprise 
Server 

Optimal Trace‟s Repository manager for Projects and qualified assets 
that manages communication between other tools and the 
Repository database on a Repository Server machine. 

Actor  An Actor is an entity that is outside the scope of a system but which 
interacts with the system. Actors may be either human beings 
(customers etc.) or other systems (data feeds etc.) 

Project  A set of requirements (i.e. collections of Requirements, Actors, 
Glossaries, Notes, Links, functional requirements, Non-functional 
requirements, etc.). 

 Local Project A Project that is stored locally (e.g. on your hard-disk); typically a 
single user installation. 

 Repository 
Project 

A Project that is stored in the Repository requiring a „live‟ connection 
to it. It may be may be in another country. Typically provides for 

multiple concurrent users with a common goal. 

 Offline Project A Repository Project, not requiring a „live‟ connection to the 
Repository. An offline Project can at a later point in time be 
reconciled with its Repository Project. 

Simple 

Requirement 

 Simple Requirements are unstructured requirements and at the 

highest level are essentially a name and description. Examples of 
Simple Requirements might be data oriented requirements where 
the need exists to specific format information in a tabular fashion or 
marketing and other 'flat' requirements types where a tabular 

structure is more suited. 

 Item An Item is essentially a name and a description. Items allow for a 
tabular set of information associated with a simple requirement.  

Structured 
Requirement 

 A Requirement is a descriptive narrative describing a specific 
functional objective of a system. It is comprised of one or more 
Scenarios, each comprising a sequence of actions (Steps). The 
purpose of a Requirement is to achieve an agreeable objective. 

Typically, Actors interact with Requirements. Requirements come in 
two forms: internal and external. Every Requirement contains only 
one Main Success Scenario (MSS). Requirements may also include 
multiple Alternate Scenarios  (AS). 
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Item Sub-item Description 

 External 
Requirement 

A Requirement that is triggered by an external Actor. 

 Internal 
Requirement 

A Requirement that is not triggered by an Actor and is invoked by 
either an „extends‟ or „includes‟ relationship. 

 Package A group of related sets of Requirements. Used to segment a Project 
into logical units. The mandatory minimum number of Packages per 
Project is one, namely the default Package labeled „Requirements‟; 
this Package, which houses all other Packages, cannot be deleted. 

Scenario  Any sequence of actions (Steps). Optimal Trace™ Enterprise allows 
for two types of scenario, i.e. Main Success Scenario (MSS), 

Alternative Scenario (AS). 

 Main Success 
Scenario 

This is the Main Flow of events within a Requirement leading to a 
successful outcome. Every Requirement has one and only one Main 
Success Scenario. The Main Success Scenario of a Project could be 
considered the „critical path‟ of a Project. 

 Alternative 
Scenario 

This is a different flow of events within a Requirement that may lead 
to a successful outcome of the Requirement. This may be invoked 
due to some fault or alternative provision in the Requirement. 

 Step An action within a scenario that achieves an effect. You may branch 
from any Step in a Requirement to another Step within the same 

Requirement, or to another Requirement, e.g. Branching (B) may be 
due to some check passing or failing. You may refine from any Step 
in a Requirement to another Requirement, e.g. Refining (R) links a 
Step at one level to a more detailed Requirement. 

 Concrete Step A concrete Step is a Step that does not have any refinements. 

 Refinement A refinement is a relationship between a Step and a Requirement, 
wherein the net-effect of the Step is exactly equivalent to the net-
effect of the Requirement. 

 Branch Branching allows for a Requirement to jump from one Step within 
the Requirement to another, generally due to some check passing or 
failing. In addition to branches within Requirements, Optimal Trace™ 

Enterprise allows branching between Requirements. 

Document 
Profile 

 A profile is a collection of Templates that specifies the branding 
aspects of the generated document and the exact set of data that 
will be output to the document. Optimal Trace™ Enterprise ships 
with some ready-to-use document profiles. See Table 17 above, for 
details. 

 Template Generate Project documents using preformatted templates, via the 
documents Profiles facility. 

Goal Level  Requirements can be classified as being of a certain goal-level thus 
clarifying to a large extent the audience of the Requirement. See 

„Default Requirement Goal Level‟ in Table 12 on page 134, for 
details. The concept of Goal-Levels is borrowed from the work of 
Alistair Cockburn [1]. 

Round-
tripping 

 If you have been working with copies of Optimal Trace™ Enterprise 
generated documents, away from the Project, you can re-incorporate 
any changes you have made into the Project copies. This is called 

„round-tripping in Optimal Trace™ Enterprise. 
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